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Using the
ServiceManagerEnhancedAdapter9.4
1 Adapter
This document describes how to implement an integration between ServiceManager and UCMDB by
using the ServiceManagerEnhancedAdapter9.41 adapter.

For information about using the ServiceManagerAdapter9.41 adapter, see the
ServiceManagerAdapter9.41 User Guide.
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Chapter 1: Introduction
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Who Should Read the SM-
UCMDB Integration Documentation
The documentation is intended for a system implementer or system administrator who will be
establishing andmaintaining a connection between the UCMDB and ServiceManager systems. The
documentation assumes that you have administrative access to both systems.

Purpose of the Integration
An integration between Universal CMDB (UCMDB) and ServiceManager enables you to share
information about the actual state of a configuration item (CI) between your UCMDB system and a
ServiceManager system. CIs commonly include IT services, hardware and software. Any organization
that wants to implement the best practices ConfigurationManagement and ChangeManagement ITIL
processes can use this integration to verify that CIs actually have the attribute values the organization
has agreed to support.

You can use this integration to automate the creation of ServiceManager change or incident records to
update or roll back CIs that have unexpected attribute values. ServiceManager allows you to
programmatically define what actions you want to take whenever a CI’s actual state does not match
the expected state as defined in the CI record.

The integration offers several different ways for users to view CI actual state information:

l By default, the integration automatically updates themanaged fields of ServiceManager CI records
as part of the regular UCMDB synchronization schedule. You can choose the option to configure
the integration to automatically create change or incident records instead.

l A ServiceManager user can view the current actual state of a CI by looking at the Actual State
section in the CI record. When you open the Actual State section, ServiceManager makes a web
services request to UCMDB and displays all CI attributes the request returns. ServiceManager
only makes the web service call when you open this section.

l A ServiceManager user can use theView in UCMDB option to log in to the UCMDB system and
view the current CI attributes from UCMDB. The ServiceManager user must have a valid UCMDB
user name and password to log in to the UCMDB system.
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Supported Use Cases
This section describes use cases that are supported by the UCMDB-SM integration. The supported
use cases provide the core business processes that are enabled by the UCMDB-SM integration.

The followingmain business use cases are supported by the UCMDB-SM integration:

l Planned Change: A change created in ServiceManager (SM) through the formal SM change
process.

l Unplanned Change: A change or incident that occurred in SM and does not conform to the formal
SM change process.

l Retrieving SM Incident, Change, and Problem record information: The ability to view SM Incident,
Change and Problem record information in UCMDB.

l Actual State: The ability for SM users to view the actual state of UCMDB CIs.

l View CIs in UCMDB: The ability for SM users to view SM CI information in UCMDB or in UCMDB
Browser.

l Primary CI History in UCMDB: The ability for SM users to view UCMDB change history of the
primary CI of a Problem record in SM for root cause investigation.

l Support of Automated ServiceModeling (ASM) in UCMDB Browser: The ability that enables the
integration to push consumer-provider relationships that are automatically discovered by ASM to
SM, and enables SM users to access the ASM functionality of UCMDB Browser.

l Centralized VI visualization and impact analysis: The ability for SM users to access, directly from
the SM user interface, the CI Visualization and Impact Analysis functionalities of UCMDB Browser.

All of the use cases provide important capabilities that enable the user to perform ITIL (IT Infrastructure
Library) processes. The ITIL processes refer to a set of best practices that define and outline how
organizations shouldmanage their IT.

Enabling ITIL Processes
By activating CI push from UCMDB to SM the user facilitates ITIL processes such as Incident,
Problem and ChangeManagement in SM.

SM utilizes the data pushed from UCMDB in the followingmodules:

l Incident Management: the Service Desk operator (SD Agent) selects the “Service” and the
“Affected CI” for the specific Incident record.
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l ProblemManagement: the SD agent selects the “Service” and the “Primary CI” for the specific
Problem record.

l ChangeManagement: the SD agent selects the “Service” and the “Affected CI(s)” for the specific
Change record.

In each of the previously mentioned ITIL processes, SM utilizes CI information for Service, Affected
CIs and Primary CIs that all originate in UCMDB.

Managing Planned Changes
The purpose of the “Planned Change” use case is to provide IT organizations a formal process by which
changes to the IT infrastructure are introduced after thorough review and analysis. This is performed
according to the “ChangeManagement” process defined in ITIL v3.

A “Planned Change” is initiated by the SM user through the formal “ChangeManagement” process
module in SM. This is followed by the actual change implementation.

The actual changes are discovered by a discovery tool such as DDMA, and then updated in UCMDB
and the relevant modifications are pushed to SM. Once the user has validated the change, the user
closes the relevant planned change in SM.

Managing Unplanned Changes
The purpose of the “Unplanned Change” use case is to provide IT organizations a formal process by
which all changes that occur to the IT infrastructure are both logged and conventionalized through the
organizations formal approval process.

An “Unplanned Change” is a change that is recognized by a Discovery tool such as DDMA. The
change is first updated and visible in UCMDB and then the data is pushed to SM. SM recognizes the
change and as a result an “Incident” or “Change” record is generated.

These Changes are seen also in the SM “Pending Changes” section in the Configuration Item form,
once approved they aremoved to the SM “Historic Changes” section.

Retrieving Service Manager Record Information
Retrieving record information from within UCMDB provides all Software applications users with access
to this information by using UCMDB's federation capabilities and supporting APIs. These applications
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include Asset Manager (AM), Operations Orchestration (OO), and so on.

SM record data is accessed from within UCMDB using UCMDB federation capabilities. SM record
data includes Incident, Problem and Change records as well as a key set of their attributes.

UCMDB enables users to create reports or views that combine the federated record data from SMwith
CI information from UCMDB.

Retrieving the Actual State of UCMDB CIs
By default, ServiceManager only stores and displays the expected or managed state of CIs. The
information ServiceManager displays in the ConfigurationManagement form is essentially the
definitive list of attributes that the CI should have. However, the actual state of the CI may differ from
the expected state.

The purpose of “Actual State” is to enable SM users insight into CIs’ current state as detected by
“Discovery Tools” and populated in UCMDB. This state provides up-to-date information that may vary
from the information displayed in SM both in content and in scope.

The “Actual State” of the CI is displayed in SM in order to enable the user to validate the current state of
the CI that resides in UCMDB or in another data repository.

SM users retrieve the Actual State of CIs from UCMDB or additional data sources by viewing the CI's
Actual State section in the SM Configuration Item form.

To view the actual state of the CI, youmust first create an integration to an Universal CMDB server.
The Universal CMDB server periodically discovers the actual state of CIs and records the actual state
in the ConfigurationManagement database. ServiceManager accesses the actual state information by
using aWeb services connection. ServiceManager sends the CI ID to the Universal CMDB server and
receives a full list of the attributes for that CI. ServiceManager displays the CI attributes in the Actual
State section of the ConfigurationManagement form.

If a ServiceManager CI does not have amatching CI in the Universal CMDB server, ServiceManager
does not display the Actual State section. For example, youmay track office furnishing CIs in Service
Manager that cannot be discovered and tracked in Universal CMDB.

To retrieve the actual state of a configuration item in ServiceManager, follow these steps:

1. Click Configuration Management > Resources > Search CIs.

2. Use search or advanced search to find one or more records.

3. Select the CI with the actual state that you want to see.

4. From the CI detail form, open theActual State section. ServiceManager displays the actual state
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of the CI, as well as its UCMDB Id value.

Note: TheActual State section is visible only if your system has an active integration to an
Universal CMDB server and the CI has amatching entry in the ConfigurationManagement
database. ServiceManager does not display theActual State section if there is nomatching
CI in the Universal CMDB server.

Accessing SM CI information in UCMDB
When integrated with UCMDB and UCMDB Browser, ServiceManager (SM) enables SM users to
view CI information in UCMDB or UCMDB Browser.

When integrated with UCMDB, ServiceManager displays aView in UCMDB button in a CI record that
also exists in UCMDB. If ServiceManager is also integrated with UCMDB Browser, aView in
UCMDB Browser button is displayed instead.

If you click either button, you are prompted to enter a UCMDB user name and password to open
UCMDB or UCMDB Browser in the context of the current CI.

How to View the Change History of the Primary CI

of a Problem Record
When integrated with UCMDB Browser, ServiceManager displays aPrimary CI History in UCMDB
section in a problem record whose primary CI is synchronized from UCMDB. You can view the CI
changes on that primary CI for root cause investigation.

For information about how to enable an integration with UCMDB Browser, see "How to Add UCMDB
andUCMDB Browser Connection Information" on page 65.

To view the primary CI change history, follow these steps:

1. Log in to ServiceManager.

2. Navigate toProblem Management, and perform a search to open a problem record whose
Primary CI is synchronized from UCMDB.

3. Click thePrimary CI History in UCMDB tab.
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Support of Automated Service Modeling (ASM)
Service Discovery in UCMDB Browser enables you to configure and run activities to discover your
business services and applications. The discovery process starts from aCI that represents the URL of
a specified service, and continues only with other CIs that can potentially be related to the service. This
functionality is also referred to as Automated ServiceModeling (ASM).

Note: ASM is supported only for UCMDB 10.20 or later.

Starting with ServiceManager version 9.41, the ServiceManager adapters support data push of
consumer-provider relationships that are discovered by ASM. The adapters provide an ASM TQL query
for push.

Note: Only consumer-provider relationships directly pointing from a Business Element CI to a
Running Software CI can be pushed. Consumer-provider relationships between a Business
Element CI and a Cluster CI cannot be pushed.

Additionally, ServiceManager can integrate with ASM so that SM users can access ASM in the
context of an affected service in SM. This ability enables SM users to see the tree structure of a
service CI and facilitates servicemodeling in SM.

Note: To enable ASM support, you still need tomanually tailor related forms in ServiceManager.
For more information, see theHow to Enable ASM Support topic.

Centralized CI Visualization and Impact Analysis
Once ServiceManager is integrated with UCMDB and UCMDB Browser, ServiceManager users can
access UCMDB Browser directly from within ServiceManager to visualize CI relationships and
simulate the impact in the context of an affected service or configuration item (CI) in ServiceManager.

If light-weight single sign-on (LW-SSO) is not enabled for the integration, ServiceManager users are
prompted with UCMDB Browser login page; however, the integration provides aUse a dedicated user
account option, which enables you to configure a dedicated UCMDB Browser user account so that
users bypass UCMDB Browser login page.

Additionally, UCMDB Browser CI visualization and impact graphs are displayed according to the user's
SM login language, which is English by default.

Important: To view UCMDB Browser CI visualization and impact graphs embedded in Service
Manager, users are recommended to use the latest Firefox or Chrome. This is because Internet
Explorer 11 consumes toomany resources and thereforemay cause performance issues.
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Tailor ServiceManager Hybrid
If you are running ServiceManager in hybrid mode (for example, you have upgraded to Service
Manager Hybrid from an earlier version), you need to tailor your system before users can access the
Run Impact Analysis functionality from the Changemodule (Change and Change Task).

Note: For the Interaction and Configurationmodules, no tailoring is required.

To do this, follow these steps:

1. Log in to ServiceManager as a system administrator.

2. Update the cm.view.display Display Screen.

a. Enter ds in the command line, and press Enter.

b. In the Screen ID field, enter cm.view.display. Click Search. The record opens.

c. Click Main > Initializations.

d. Append the following line to the end of the script:

$showimpactbutton=jscall("uCMDBBrowserUrl.showImpact")

e. Save the record.

3. Add theRun Impact Analysis display option to the cm.view.display view.

a. Enter do in the command line, and press Enter.

b. In theUnique ID field, enter change.view_run.impact. Click Search. The display option
record is displayed.

c. In theScreen ID field, change the value to cm.view.display.

d. In theUnique ID field, change the value to cm.view.display_run.impact.

e. In theGUI option field, change the value from 405 to a different value if GUI option 405 is
already used in your system.

f. Click Add to add the new record.

4. Add aRun Impact Analysis button to the Change and Change Task formats.

Perform the steps for both formats:

a. Enter fd in the command line, and press Enter.

b. In the Form field, enter the name of the format.

c. Add aRun Impact Analysis button next to theService field, and specify the following
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properties for the button:

l Visible: checked

l Visible Condition: [$showimpactbutton]=true

l Input: $affected.item

l Button ID: This should be same as theGUI option value of the display option that you
added previously. For example, 405.

l Image File: impact

l Enabled: checked

l Balloon Help: Run Impact Analysis.

5. Log off and log back in to ServiceManager to check that theRun Impact Analysis button is
working in the Change and Change Task formats.

CI Visualization
Only if anSMtoUCMDB integration instance is enabled in ServiceManager (Tailoring > Integration
Manager) and theShow UCMDB Browser CI Visualization widget option is enabled, Service
Manager uses the Get Related widget from UCMDB Browser to visualize CI relationships. This
enables users to use the sameCI visualization on both product sides. For more information about the
Get Related widget in UCMDB Browser, see UCMDB Browser Help Center (version 4.10 or later).

l For CIs that are not synchronized to UCMDB, for example, non-discoverable CIs, to show CI
visualization using the embeddedGet Related UCMDB Browser widget, it is recommended to
set up an appropriate TQL script in UCMDB and then synchronize this kind of CIs to UCMDB.

l If there is noSMtoUCMDB integration instance enabled or theShow UCMDB Browser CI
Visualization widget option is disabled in the integration instance, ServiceManager uses its
ownCI visualization.

ServiceManager users can access UCMDB Browser Get Related widget as described in the following
table.

Module How to access

Incident 1. Open an incident record.

2. Click the Smart Indicator icon for the following fields:
o Primary Affected Service
o Affected CI

3. On the Context Details form, click Visualize CI.
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Module How to access

Interaction 1. Open an interaction record.

2. Click the Smart Indicator icon for theAffected Service field.

3. On the Context Details form, click Visualize CI.

Configuration 1. Open a configuration item record.

2. Click theRelationship Graph tab, or click More > Visualize CI.

Change or Change
Task

1. Open a Change or Change Task record.

2. Click More > Visualize CI.

3. Select the affected service or an affected CI of the change record, and
then click Finish.

Impact Analysis
If anSMtoUCMDB integration instance is enabled in ServiceManager (Tailoring > Integration
Manager) and theShow UCMDB Browser Impact widget option is enabled, ServiceManager users
can access the Impact Simulation widget of UCMDB Browser, as described in the following table. Pay
attention to the following:

l The Impact Simulation widget uses a default impact severity that is defined in theSMtoUCMDB
integration instance. The out-of-box value is Critical. For more information, see "How to Add
UCMDB andUCMDB Browser Connection Information" on page 65.

l UCMDB Browser uses blue lines and black lines to indicate different types of relationships. For
more information, refer to theServiceModeling section in theUniversal CMDB Browser Help
Center.

Note: If there is noSMtoUCMDB integration instance enabled or if theShow UCMDB Browser
Impact widget option is disabled in the integration instance, theVisualize Impact button and
Run Impact Analysis icon andmenu option described in the following table are not displayed.

Module How to access

Incident 1. Open an incident record.

2. Click the Smart Indicator icon for the following fields:
o Primary Affected Service
o Affected CI

3. On the Context Details form, click Visualize Impact .

Interaction 1. Open an interaction record.
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Module How to access

2. Click the Smart Indicator icon for theAffected Service field.

3. On the Context Details form, click Visualize Impact.

Change or
Change
Task

1. Open a Change or Change Task record.

2. Click theRun Impact Analysis icon for theService field or click More > Run
Impact Analysis.

3. If aNext button appears, click Next to view the next impact analysis graph.

Note: Because a Change or Change Task recordmay have a number of
affected CIs, the Impact Simulation result may need to be displayed inmore
than one page depending on theMaximum Trigger CIs per Impact Graph
setting that is defined in the integration instance. If more than one page is
needed, aNext button appears at the top of each impact graph page before the
last one.

Core Features
This section explains the rudimentary concepts behind the Federation, Push, and Population features
as they pertain to the integration.

This section includes:

l "Push" below

l "Federation" on the next page

l " Population" on the next page

Push
UCMDB can automatically discover most types of CIs available in ServiceManager. This integration
enables you to push these types of CIs from UCMDB to ServiceManager.

The following figure shows how data is pushed from UCMDB to ServiceManager (SM). The data is
physically pushed (copied) from UCMDB to SM. Once the data is physically located in SM, the data is
utilized by the SM user that consumes this information in various SM processes.
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Note: CI Type and Attribute Push

Only information that is physically present in UCMDB can be pushed to SM.

Federation
With the federation feature, UCMDB pulls various ticket information (for example, Incident, Problem,
Change, and Change Task ticket information) from SM. This enables users to see ticket information in
UCMDB as ticket CIs that are connected to the relevant Nodes.

Note: Change Task federation is supported only when the ServiceManagerEnhancedAdapter9.41
is used.

When data is federated (reflected or mirrored) from SM to UCMDB, the data is not physically present in
UCMDB, instead it is passed over to UCMDB throughWeb Services.

Population
You can also use this integration to populate those types of CIs that UCMDB cannot automatically
discover or CIs that have been created in ServiceManager before you have a UCMDB system
deployed.

Population is the reverse of Push. The following figure shows how data is populated from SM to
UCMDB. One SM CI record with multiple attributes is transferred to UCMDB as multiple CI records.
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How CI information is Synchronized
Between UCMDB and Service Manager
This section explains how CI information is transferred between the UCMDB and ServiceManager
systems.

This section includes:

l "CI Information Usage" on the next page

l "High-Level Components of the Integration" on the next page

l "Relationships Between Integration Components" on page 26

l "What Information is Stored in UCMDB" on page 27

l "What Information is Stored in ServiceManager" on page 27

CI Display Name Field in Service Manager
Prior to version 9.41, ServiceManager used the CI Identifier field (logical.name field in the device table)
to store Configuration Item (CI) names, and used the CI Name field (id field in the device table) to store
CI identification numbers. When CIs were pushed from UCMDB to ServiceManager, their names in
UCMDB were synchronized to the logical.name field in ServiceManager, and duplicate CI names were
renamed because logical.name values must be unique in ServiceManager.

Starting with version 9.41, ServiceManager uses the logical.name field to store CI identification
numbers, and a new field namedDisplay Name (display.name in the device table) to store CI names.
The original CI Name field (id field in the device table) is removed from the CI form (but still kept in the
dbdict). CI display names must follow these rules:

l Duplicate Display Names are always allowed for CIs that are created from UCMDB.

l Duplicate Display Names are not allowed for CIs that are created from ServiceManager,  unless
they belong to different CI types.

Note: Because ServiceManager 9.41 or later allows duplicate CI names (as long as the CIs
belong to different CI types), the automatic CI renamingmechanism is removed since Service
Manager 9.41. After upgrading to ServiceManager 9.41 or later, if you still need to push CI data to
the CI Identifier (logical.name) field in ServiceManager, you need to enable logical.name support
first andmake sure that each value to be pushed is unique. Otherwise, ServiceManager cannot
create the CIs.
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CI Information Usage
When referring to the concept of CI information it is important to make the distinction between a
UCMDB CI and a ServiceManager (SM) CI. The UCMDB model represents a topology that contains a
number of CI types and relationships.

The UCMDB topology can be represented in ServiceManager as a single entity. Multiple CIs from
UCMDB and their attributes aremerged into a single record in SM and the relevant UCMDB attributes
aremapped to their appropriate counterparts in the SM record.

The above figure shows the correlation between the UCMDB topological model and its representation
of the Computer Instance together with its parallel representation in SM. The SM computer CI contains
all of the UCMDB information that is passed through the integration.

In the push flow, in the UCMDB topological view several CIs such as Node, IP, Interface, Location,
File System, CPU, Disk Device and their Relationships are converted into a single SM computer
record with the IP, MAC Address and Location, File System, CPU and Disk Device attributes.

In the population flow, the conversion is reversed.

High-Level Components of the Integration
The following diagram shows the high-level components of the UCMDB integration, and illustrates the
interactions between UCMDB and ServiceManager.
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Relationships Between Integration

Components
The following figure illustrates the relationships between the ServiceManager Adapter components in
UCMDB and the associated components in ServiceManager.

The ServiceManager Adapter includes configuration files, which are used tomapUCMDB entities to
their counterparts in ServiceManager during data push, as well as map ServiceManager CIs to
UCMDB entities during population.

The configuration files utilize UCMDB queries that define a superset of data relevant for the integration.
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What Information is Stored in UCMDB
Your UCMDB system stores the actual state of CIs and CI relationships as CI attributes. Typically,
UCMDB uses one or more integrations and discovery mechanisms (feeders) to automatically detect CI
attribute values. The UCMDB-SM integration only uses a subset of the CI attributes available in a
UCMDB system.

What Information is Stored in Service

Manager
Your ServiceManager system stores themanaged or expected state of CIs and CI relationships as
attribute values in a CI record. To be part of the integration, a CI attribute in your UCMDB systemmust
map to amanaged field in the ServiceManager CI record. You can add, remove, or update the
managed fields that are part of the integration by tailoring the ServiceManager web services that
manage the integration.

ServiceManager runs according to a set of rules that define what actions you want the system to take
whenever a CI’s actual state does not match the expected state as defined in the CI record. You define
these rules from the Discovery Event Manager (DEM) in ServiceManager where you can do the
following:

l Automatically update a CI record tomatch the attribute values listed in the actual state (This is the
default behavior)

l Automatically create a change record to review the differences between the actual state and the
managed state

l Automatically create an incident record to review the differences between the actual state and the
managed state

Discovery Event Manager
The Discovery Event Manager tool provides you with information about configuration items (CIs) in use
by your organization. Discovery Event Manager collects data from associatedWeb services, such as
theMicro Focus Universal ConfigurationManagement Database (UCMDB) for enterprise IT
organizations. UCMDB captures, documents, and stores information about CIs, service
dependencies, and relationships that support business services. The Discovery Event Manager tool
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takes the information captured by UCMDB and compares the actual state of each incoming CI record
(both existing and new) to themanaged field state of the CI record in ServiceManager.

If the actual state of an incoming UCMDB CI record differs from themanaged field state of the CI
record in ServiceManager, the Discovery Event Manager tool works with ConfigurationManagement
and ChangeManagement to perform any required changes to the incoming CI record according to the
rules you have set in the Discovery Event Manager tool.

Related topics

"Discovery Event Manager change open process" on page 42
"Discovery Event Manager managed fields" below
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on the next page
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Discovery Event Manager managed fields
Managed fields are key fields in the ServiceManager configuration item (CI) record types that the
Discovery Event Manager tool uses to validate the incoming CI records fromWeb services. By default,
the fields of the incoming CI records shouldmatch the key fields in the ServiceManager CI records.

If Discovery Event Manager discovers any discrepancies between the actual state of the incoming CI
record fields and the ServiceManager managed fields, these discrepancies are handled by Change
Management by default. Rules define what to do with a CI record tomake it compliant with the CI
record types in ServiceManager.

Related topics

"Discovery Event Manager" on the previous page
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32
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"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" below
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on the next page
"View ormodify rules in Discovery Event Manager" on page 36

Add a managed field in Discovery Event Manager
Managed fields are key fields in ServiceManager configuration item (CI) record types. They are
important to helping the Discovery Event Manager tool to discover differences between the data in the
incoming CI records fromWeb services versus what ServiceManager is expecting to receive in those
records. If the incoming records do not match themanaged key fields in ServiceManager, the rules set
in the Discovery Event Manager tool determine what will happen to those incoming CI records.

For example: If the joinbizservice table has three fields in theManaged Fields tab in Discovery Event
Manager and some of the expected information is different or missing from any of those fields, the
Discovery Event Manager tool will deal with that incoming CI record that is not compliant with the
ServiceManager managed fields for that CI record type.

If you determine that a necessary field is not included in the existing discovery process, you can add a
managed field to the applicable table using the settings on theManaged Fields tab.

Note: If a managed field does not exist in an incoming CI record, the Discovery Event Manager
tool is not able to find discrepancies based on that field.

Tip: The following steps describe how tomanually add amanaged field. If you want to
automatically addmultiple or all fields from a table as managed fields, you can click the Load
Fields button on theManaged Fields tab.

To add amanaged field:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager rules form is displayed.

2. Click Search to retrieve a list of CI ID types.
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3. Select the ID type for the fields you want to view, and then select theManaged Fields tab. You
can see which fields are beingmanaged for this CI type.

4. To select a new field you want managed, do the following:
a. Select the drop-down arrow in the next blank Field Name field. You will see the list of fields

related to this CI type.

b. Select the field you want to add to theManaged Fields tab for this CI type.

c. For a field that is part of an array of structures, choose aStructure and specify the field's
Index value. For example, the CI type computer contains array elements, such as ports,
printers, and scanners. Choose an array element within the structure, and then choose the
corresponding index number.

d. Click Save.

5. Repeat this process to add amanaged field for another ID type.

6. Click OK.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" below
"View ormodify rules in Discovery Event Manager" on page 36

View, modify, or delete a managed field in

Discovery Event Manager
Applies to User Roles:

System Administrator
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Managed fields are important to ensuring that the Discovery Event Manager tool can process incoming
configuration item (CI) data fromWeb services. When the inventory of your organization changes, you
can add or update the CI types based on your new inventory requirements. You can also review the
managed fields for existing CI types to determine if the necessary fields exist and add, modify, or
delete managed fields.

Warning: If you are deleting a field, make sure you select the field you want to delete. If you delete the
wrong field, youmust add the field back into theManaged Fields tab.

To view, modify, or delete amanaged field:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form is displayed.

2. Click Search to retrieve a list of CI ID types.

3. Select the ID type for the fields you want to view, and then select theManaged Fields tab. A list
of managed fields for the selected CI type is displayed.

4. Select the field you want to edit or delete.
o Make any necessary changes.

o Click Delete to delete a field that is no longer valid.

o Click Save.

5. Click OK.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on the next page
"Discovery Event Manager rule options" on the next page

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View ormodify rules in Discovery Event Manager" on page 36
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Discovery Event Manager rules
Discovery Event Manager processing is governed by rules that define what actions Discovery Event
Manager will perform when the actual state of an incoming configuration item (CI) record differs from
themanaged state of a CI record in ServiceManager.

During initial configuration of Discovery Event Manager, you start with a basic set of rules for Change
Management. You can refine those rules as necessary. Each rule identifies a series of checks that
Discovery Event Manager processes whenever a CI record is received fromWeb services. Depending
on the rule, Discovery Event Manager may add or delete the record, open a change, log the information,
or update the record's status.

ServiceManager opens a change or incident based on the settings defined in the populateChange or
populateIncident function in the discoveryEvent ScriptLibrary record. You can override the default
settings by writing a custom JavaScript on theChange Customization or Incident Customization
tab.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rule options" below

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Discovery Event Manager rule options
Rules help to automate the process of managing incoming configuration item (CI) records. When you
have rules set up, you canmanage whether a record is added, updated, or deleted to the CI records in
ServiceManager. The Discovery Event Manager tool checks the incoming CI records and determines
what to do when the actual state of the CI records does not match themanaged state of the CI records
in ServiceManager. When Discovery Event Manager finds the rule that applies to an incoming CI
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record type, the server checks the rule, and then updates the record according to the rules you have set
up.

Example: If a user's machine has 4GB of RAM added and the Discovery Event Manager tool
discovers that the actual state of the CI record does not match the ServiceManager managed state for
that CI record type, the Discovery Event Manager tool opens an unplanned change. This then gives the
ChangeManager the opportunity to review the CI record and determine what tasks to complete.

Actions are required in the following cases:

l Records that do not exist.

l Records that contain unexpected data.

l Records aremarked for deletion.

The following options are available when configuring rules tomeet your business needs:

l Action if matching record does not exist: If a CI record does not exist in ServiceManager.
o Add the record: (Default) When the information received fromWeb services through Discovery

Event Manager does not bring up amatching record in ServiceManager, add the record.

o Add the record, and set dependency as true: This option is available only for synchronization
of CI relationship data. ServiceManager will add the CI relationship record and enable outage
dependency for the record by checking its Outage Dependency check box and setting its
number of dependent downstream CIs to 1.

o Open an Incident:Open an incident to investigate a new CI record that currently does not exist
in ServiceManager to determine if it is compliant with ServiceManager.

o Open a Change:Open an unplanned change to review the new CI record, because it currently
does not exist in ServiceManager. This change gives the ServiceManager Administrator an
opportunity to deny the ChangeManagement request and back it out by using the change
management process or to accept the actual state of the new CI record and assign tasks
accordingly.

l Action if record exists but unexpected data discovered:Changes to the information in an
existing CI record raise a flag for the Discovery Event Manager tool. Some of the information is not
part of themanaged state in ServiceManager. The unexpected data in the CI recordmust be logged
or reviewed.
o Open a Change: (Default) Open an unplanned change to review the actual state of the CI

record. This change gives the ServiceManager Administrator an opportunity to deny the Change
Management request and back it out by using the changemanagement process, or to accept the
actual state of the existing CI record and assign tasks accordingly.
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o Log Results and update record: Log the results of the actual state of the CI record, and then
update the record.

o Open an Incident:Open an Incident to investigate the actual state of a CI record and determine
what actions must be performed or initiated to bring the record into compliance with Service
Manager.

l Action if record is to be deleted: If an external event specifies that the record needs to be
deleted.
o Delete record: (Default for CI relationship records) This option is available for synchronization

of both CI and CI relationship records. ServiceManagerautomatically deletes the record.

o Open an Incident: This option is available only for synchronization of CI relationship records.
ServiceManager opens an incident to investigate the deleted record and determines which
actions must be performed or initiated to bring the record into compliance with ServiceManager.

o Open a Change: This option is available only for synchronization of CI relationship records.
ServiceManager opens an unplanned change to review the deleted record. The change allows
someone to investigate whether the deleted record is compliant with your business practices. If
the record is compliant, the change can be approved. If the record is not compliant, then the
change can be denied and the record added back to the system.

o Update record to the selected status: (Default) This option is available only for
synchronization of CI records. ServiceManager updates the status of the CI record to a value
selected from the drop-down list (for example, Retired/Consumed), instead of deleting the
record permanently.

o Open an Incident to update record to the selected status: This option is available only for
synchronization of CI records. ServiceManager opens an incident to update the record’s status
to a value selected from the drop-down list (for example,Retired/Consumed). Once the incident
has been closed, ServiceManager automatically updates the CI record to the selected status.

o Open a Change to update record to the selected status: This option is available only for
synchronization of CI records. ServiceManager opens an unplanned change to update the CI
record’s status to a value selected from the drop-down list (for example, Retired/Consumed).
The change allows someone to investigate whether the requested status change is compliant
with your business practices. Once the change has been approved and closed, ServiceManager
automatically changes the CI record to the selected status. If the change has been denied,
ServiceManager makes no changes to the CI record.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager change open process" on page 42
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
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"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" below
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on the next page

Add a rule in Discovery Event Manager
Applies to User Roles:

System Administrator

Rules are the core of Discovery Event Manager processing. Based on your organization's
requirements, you can refine the basic set of rules that are configured with the Discovery Event
Manager tool by adding rules.

To add a rule:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click New. The new rule form opens.

3. Enter the new rule name.

4. Select a table to be associated with the rule from the Table Name list, and then click Next.

5. Enter the condition for the rule. The rule is added to the records table.

6. Click Save.

7. Click OK.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager change open process" on page 42
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
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"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on the next page
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" below

View or modify rules in Discovery Event Manager
Applies to User Roles:

System Administrator

Rules help you to automate the change control process, so that incoming configuration item (CI)
records can be updated to comply with the CI record fields in ServiceManager. As you reevaluate your
organization's requirements, youmay view the rules that are set up andmake changes as you see fit.

To view ormodify existing rules:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click Search to retrieve a list of CI ID types.

3. Select the ID type for the rules you want to view.

4. Select theRules tab. The existing rules settings for the selected CI type are displayed.

5. If you want to edit the rule, do the following:
o Make the necessary changes. For example, if you choose to select a different action step for

records that do not exist, make your change.

o Click Save.

6. Click OK.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on the previous page
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"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" below
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30

Delete a set of rules in Discovery Event Manager
Applies to User Roles:

System Administrator

Rules help to automate the change control process, so that incoming configuration item (CI) records
can be updated to comply with the CI record fields in ServiceManager. As you reevaluate your
organization's requirements, youmay realize that the existing rules settings for a CI type are no longer
valid. You can delete the existing rules settings to replace them with a new set of rules.

Warning: Make sure you are deleting the rules for the CI ID type you want deleted. If you delete the
wrong set of rules by mistake, you will have to add the CI ID type and set up the rules for each action
that needs to be taken.

To delete a set of rules:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click Search to retrieve a list of CI ID types.

3. Select the CI ID type, and then select theRules tab. Existing rules settings for the selected CI
type are displayed.

4. After you determine that you want to delete the rules for this CI type, click Delete.

5. Click OK.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on the next page
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
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"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"View, modify, or delete a configuration item in Discovery Event Manager" on the next page
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Add a configuration item in Discovery Event

Manager
Applies to User Roles:

System Administrator

As inventory changes within your organization, you will need to add new configuration item (CI) types,
or possibly update or delete others, to keep your inventory records up-to-date for the Discovery Event
Manager tool. You canmanage the CI types in the CI record type table.

To add a configuration item in Discovery Event Manager:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click New.

3. Enter the name of the new CI record type.

4. Select a table from the table list, and then click Next.

5. Enter the Condition for the CI record type. The CI record type is added to the records table.

o The conditionmust ensure that only one rule is applied when the web service request is
processed.

o An empty condition evaluates to true by default.

6. Click Save.

7. Click OK.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32
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"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on the next page
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" below
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

View, modify, or delete a configuration item in

Discovery Event Manager
Applies to User Roles:

System Administrator

As inventory changes within your organization, you will need to add, update, or delete configuration
item (CI) types to keep your inventory records up-to-date for the Discovery Event Manager tool. You
canmanage the CI types in the CI record type table.

To view, modify, or delete a configuration item in Discovery Event Manager:

Warning: If you are deleting a CI record type, make sure you select the CI record type you want to
delete. If you delete the wrong record type, youmust add the record back into the CI Record ID table.

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click Search to retrieve a list of CI ID types.

3. Select the ID type you want to view, and then click Previous orNext to scroll through the list of
records.

4. Select theRules tab to view the rules that are set for the selected CI type.

5. Select the record you want to change andmake any necessary changes.

6. Select the ID type you want to delete, and then click Delete.

7. Click Save.

8. Click OK.

Related topics

ServiceManagerEnhancedAdapter9.41 User Guide
Chapter 1: Introduction

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 39 of 241



"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" below
"Customize incidents in Discovery Event Manager" on the next page
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Customize changes in Discovery Event

Manager
Applies to User Roles:

System Administrator

If your best practice is to have an incoming configuration item (CI) record that is not compliant with the
managed state of that CI record in ServiceManager go through the changemanagement process, you
can customize how you want the Discovery Event Manager tool to process those incoming CI records.

To customize the way changes are handled within Discovery Event Manager:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click Search to retrieve a list of Configuration Item (CI) ID types.

3. Select the ID type for the customization you want to make, and then select theChange
Customization tab.

4. Enter the customized script you want to override the default values set by the discoveryEvent
ScriptLibrary record (the change recordmay be referenced as "change").

5. Click Save.

6. Click OK.
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Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize incidents in Discovery Event Manager" below
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Customize incidents in Discovery Event

Manager
Applies to User Roles:

System Administrator

If your best practice is to have an incident logged against an incoming configuration item (CI) record
that is not compliant with themanaged state of a CI record in ServiceManager, you can customize the
rules you set for automatically opening an incident record.

To customize the JavaScript for opening an incident record:

1. Click Tailoring >Web Services > Discovered Event Manager Rules. The Discovery Event
Manager form opens.

2. Click Search to retrieve a list of Configuration Item (CI) ID types.

3. Select the ID type for the customization you want to make to incidents, and then select the
Incident Customization tab.

4. Enter the customized script you have created to override the default values set by the
discoveryEventScriptLibrary record (the incident recordmay be referenced as "incident").

5. Click Save.

6. Click OK.
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Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Discovery Event Manager change open

process
You can use the Discovery Event Manager tool to automate the change open process. When a change
is needed to address issues for review or tasks to be performed, the change open process begins. The
change goes through phases that drive the unplanned change through the necessary tasks to update
themanaged fields of a CI or to determine if the change is necessary or desired.

The change phases are as follows:

Discovery Assessment phase: Assess whether or not an unplanned change is allowed. Comments
can be added and updated in this phase, as needed. The CCB Approver must confirm that the change
is desired.

l If the change is approved, update themanaged field and close the change.

l If the change is denied, move it to the Discovery Backout phase to undo the change.

Discovery Backout phase: Back out a change after determining that the change is not necessary or
desired. Comments can be added and updated in this phase, as needed, including updates tomodified
data. If the backout of the change is complete, move it to the Discovery Verification phase.

l If the denied change is verified, close the change.

l If the denied change is not verified, return to the Discovery Backout phase.
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Discovery Implementation phase: The change requires further consideration before it is closed.

l If the backout of the change fails verification, return to the Discovery Implementation phase for
further consideration.

l If verification of the change succeeds, close the change.

Discovery Verification phase: Verify that the change is successfully implemented.

l If verification of the change fails, return to the Discovery Implementation phase.

l If verification of the change succeeds, close the change.

Related topics

"Discovery Event Manager" on page 27
"Discovery Event Manager managed fields" on page 28
"Discovery Event Manager rules" on page 32
"Discovery Event Manager rule options" on page 32

"Add a configuration item in Discovery Event Manager" on page 38
"Add amanaged field in Discovery Event Manager" on page 29
"Add a rule in Discovery Event Manager" on page 35
"Customize changes in Discovery Event Manager" on page 40
"Customize incidents in Discovery Event Manager" on page 41
"Delete a set of rules in Discovery Event Manager" on page 37
"View, modify, or delete a configuration item in Discovery Event Manager" on page 39
"View, modify, or delete amanaged field in Discovery Event Manager" on page 30
"View ormodify rules in Discovery Event Manager" on page 36

Related reference

Unplanned Change Flow diagram
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Chapter 2: How to Upgrade Your
Integration
This chapter describes the upgrade steps required to use the ServiceManagerEnhancedAdapter9.41
adapter with ServiceManager, including steps to adapt the integration to the logical name solution
introduced in ServiceManager 9.41 and steps tomigrate from an XSLT-based adapter to a generic
adapter.

The logical name solution contains significant CI related code changes. For example, prior to version
9.41, ServiceManager used the logical.name field in the device table to store CI names. The
logical.name field must be unique in the ServiceManager system, but UCMDB allows duplicate CI
names. As a result, CIs may have to be renamedwhen they are pushed from UCMDB to Service
Manager. Starting with version 9.41, ServiceManager stores CI names in the display.name field in the
device table, and stores unique CI identification numbers in the logical.name field. The display.name
field allows duplicate values if they are pushed from UCMDB, and requires unique values for CIs that
are created from ServiceManager (unless they are not of the sameCI type).

Before you proceed to the upgrade steps described in this chapter, make sure you have a good
understanding of the logical name solution and its impact on the SM-UCMDB integration. For details,
see theServiceManger Logical Name Solutionwhite paper.

Perform the following tasks to upgrade your integration to use the
ServiceManagerEnhancedAdapter9.41 adapter.

Task 1: Close All SM Unplanned Changes and Incidents Created for CI Modifications 45

Task 2: Upgrade ServiceManager 45

(Optional) Task 3: Copy Data to the joinnode Table 45

Task 4: Update the DEMRules in ServiceManager 46

Task 5: Enable the RESTful APIs for Custom CI Types in ServiceManager 47

Task 6: Upgrade UCMDB 49

Task 7: Update the Configurations for Custom CI Types in UCMDB 50

Task 8: Upgrade Field Mapping 56

Task 9: Reconfigure an Integration Point 59

Task 10: Run a Full Push to Resynchronize CI Names 59

Task 11: Restore the DEMRules in ServiceManager 60
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Task 1: Close All SM Unplanned
Changes and Incidents Created for CI
Modifications
Before you upgrade to ServiceManager (SM) 9.41 or later, close all unplanned change and incident
records that were created due to CI modifications. After upgrading to version 9.41 or later, you will run a
full data push to resynchronize CI names from UCMDB to the display.name field in the Service
Manager device table.

Task 2: Upgrade Service Manager
If you want to use the ServiceManagerAdapter9.41 adapter for the integration, youmust upgrade
ServiceManager to version 9.41 or later, which uses display.name instead of logical.name for field
mapping between UCMDB and ServiceManager.

Note: The upgrade includes the SM server, Windows and web clients, applications, Service
Request Catalog (SRC), andMobility client. If you upgrade only the server and clients and your
applications version is still earlier than 9.41, you can only use an old adapter rather than any of the
ServiceManager 9.41 adapters.

For information about how to upgrade ServiceManager, see theServiceManager Upgrade
Documentation.

(Optional) Task 3: Copy Data to the
joinnode Table
Starting with version 9.32, ServiceManager uses the joinnode table to replace themainframe,
networkcomponents, storage, and computer tables. If you are upgrading from ServiceManager 9.31
or earlier and want to migrate to the joinnode-based datamappings, you need to copy data to the
joinnode table.

Note: If you want to use the original tables instead of joinnode, this task is not needed. Instead,
you need tomodify the datamappings of your ServiceManager adapter in UCMDB.

To copy your data to the joinnode table, follow these steps:
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1. Log in to ServiceManager as a system administrator.

2. Open DatabaseManager

3. Enter cidatacopy in the Table field, and then click Search. The Copy CI Type Data form opens.

4. Click Search. A list of records is displayed: joincomputer, joinmainframe,
joinnetworkcomponents, and joinstorage.

5. Select each record from the list, update or add source/target fields as needed, and click theCopy
Data button. One of the followingmessages is displayed:
o A message that resembles “<XXX> records were successfully copied, and <YYY> records

were ignored within xxx ms”, where XXX and YYY represent the numbers of records copied
and ignored, respectively.

o “Configuration validation failed, and no records were copied. Please check your Source
Fields/Target Fields settings and run Copy Data again.”

6. If the error message is displayed, correct your Source Fields/Target Fields settings, and click
Copy Data again until all of your records have been successfully processed.

Task 4: Update the DEM Rules in Service
Manager
ServiceManager 9.41 or later uses an updated CI form, so youmay want to correct the CI names in the
logical.name field that have been renamed, and update the CI Display Name (display.name) field
values in ServiceManager by using the new field mapping.

To do this, you need to run a full data push to resynchronize the CIs to ServiceManager. Before doing
so, youmust update the DEM rules to prevent unwanted Change or Incident records from being created
due to the CI name changes.

1. Log in to ServiceManager as a System Administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Click Search.

4. For each DEM rule record, select Log Results and update record forAction if record exists
but unexpected data discovered.
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Task 5: Enable the RESTful APIs for
Custom CI Types in Service Manager
If your existing UCMDB-SM integration environment uses any custom CI types, you need to update
the External Access Definition of each custom CI type in ServiceManager to enable its RESTful API
for using a generic adapter. A ServiceManager generic adapter requires the ucmdbIntegration RESTful
APIs to work.

The following table describes the parameters that you need to update in each External Access
Definition in ServiceManager (System Administration > Tailoring >Web Services > External
Access Definition).

Parameter Description
Example
Value

RESTful Enabled Enables the RESTful API (must be set to true to enable the
RESTful API)

true

Resource
Collection Name

Specifies a unique name for the resource collection. The
following convention is recommended: <WS Object Name>+'s'

ucmdbATMs

Resource Name Specifies a name for the resource. The following convention is
recommended: <WS Object Name>

ucmdbATM

Unique Keys Unique keys of the relevant device table logical.name

Max Records
Returned in Query

Maximum number of returned records in one query 1000

Resource
Collection Actions
- POST

Action to invoke for a POST request on the resource collection Create

Resource Actions -
POST

Action to invoke for a POST request on the resource Create

Resource Actions -
PUT

Action to invoke for a PUT request on the resource Update

Resource Actions -
DELETE

Action to invoke for a DELETE request on the resource Delete

To access these parameters, follow these steps:

1. Open the External Access Definition for the custom CI type.
a. Click Tailoring > Web Services >Web Service Configuration to open the External Access

Definition form.
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b. In the Service Name field, type ucmdbIntegration.

c. In the Name field, select the table for the custom CI type.

d. In the Object Name field, type the relevant web service object name.

e. Click Search.

2. Click theRestful tab, and update the parameters.

As an example, the following figure shows the external access definition of a custom CI type
named ATMMachine.
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Task 6: Upgrade UCMDB
ServiceManager 9.41 or later can work with XSLT-based adapters and generic adapters specifically
designed for ServiceManager 9.41 or later:

l ServiceManagerAdapter9.41 for UCMDB 10.01, 10.11, 10.20, 10.21, or 10.30

Note: These are four XSLT-based adapters, one for each of the UCMDB versions.

l ServiceManagerEnhancedAdapter9.41 for UCMDB 10.20, 10.21, or 10.30

Note: These are two generic adapters based on the UCMDB generic framework, one for each
of UCMDB 10.20 and 10.21.

For more information, see "Integration Requirements" on page 61.
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Task 7: Update the Configurations for
Custom CI Types in UCMDB
The configurations for all out-of-the-box CI types in UCMDB 10.20 are already based on the Service
Manager EnhancedGeneric Adapter. However, you still need to perform the following steps to
manually update the configurations for your custom CI types in UCMDB.

Step 1. Convert the mapping scripts from

XSLT to XML and Groovy.
The old ServiceManager adapters use XSLT scripts for field mapping between UCMDB and SM. Most
of themapping scripts were developed for the four typical mapping scenarios described in the following
table.

Scenario Notes

One to One field
mapping

l One field in one side is mapped to one field in the other side

l The value is synchronized between UCMDB and SM directly (without
value conversion)

One toMany field
mapping

l One field in one side is mapped tomany fields in the other side

l The value of the one field is calculated based on the values of many fields

Many toMany field
mapping

l Multiple fields are defined as a child CI type of the relevant CI type

l A single record has multiple child instances

Value Conversion l The value of one field is converted to another value based on a specific
algorithm

l Value conversion can happen on all kinds of field mappings (one to one,
one tomany, andmany tomany)

The ServiceManager EnhancedGeneric Adapter uses XML andGroovy mapping scripts. Oldmapping
scripts for the out-of-the-box CI types have been converted to XML andGroovy by default. However,
you still need to convert your existing custom scripts to XML andGroovy.

To convert a custommapping script, you need to identify its mapping scenario (One to One, One to
Many, Many toMany, or Value Conversion) first; then you can convert the script by referring to the
following sample scripts for your specific scenario.
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Tip: In all mapping scenarios, you can use the Visual Mapping tool to generate an XML script
skeleton. Compared with the use of an old XSLT adapter, this is much easier as you can drag and
drop themapped fields to generate the script instead of writing every code line from scratch. For
details about how to use XML andGroovy scripts in the UCMDB integration framework, see the
Micro Focus Universal CMDB 10.20 Developer ReferenceGuide.

Tip: The ServiceManager EnhancedGeneric Adapter has four out-of-the-box Groovy scripts,
which you can use as a reference:

l SMUtils.groovy: defines commonmethods used for push, population, and federation.

l SMPushFunctions.groovy: defines themethods used in the out-of-the-box pushmapping
scripts.

l SMPopulateFunctions.groovy: defines themethods used in the out-of-the-box population
mapping scripts.

l SMFederationFunctions.groovy: defines themethods used in the out-of-the-box federation
mapping scripts.

Additionally, the SMFederationConverter.groovy script defines value conversions for federation.

Field mappingmust use the correct data type for each attribute. It is convenient to determine the data
type for an attribute by using the Visual Mapping tool. The following figure illustrates the data type for
the CIIdentifier attribute. You can either find the data type from the External Class Model Attributes
pane or simply drag and drop the attribute from that pane to the Visual Mapping area to automatically
get the correct data type.
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One to One Field Mapping

Sample Script in XSLT:

<Type>computer</Type>

Or

<UCMDBId><xsl:value-of select="@id"/></UCMDBId>

Or

<xsl:for-each select="@display_label">
<DisplayName><xsl:value-of select="."/></DisplayName>

</xsl:for-each>

Sample Script in XML (Groovy is not required in this scenario):

<target_mapping datatype="STRING" name="DisplayName" value="Root['display_
label']"/>

Where: The datatype must be the correct data type defined in ServiceManager for the attribute. You
can find the data type from the Visual Mapping tool interface.

One to Many Field Mapping

Sample Script in XSLT:

<xsl:variable name="prefix" select="'Value&gt;'"/>
<xsl:variable name="suffix" select="'&lt;/Value'"/>
<Subtype>

<xsl:choose>
<xsl:when test="contains(@node_role,concat

($prefix,'desktop',$suffix))">Desktop</xsl:when>
<xsl:when test="@os_family">
<xsl:value-of select="@os_family"/>
</xsl:when>
<xsl:otherwise>Server</xsl:otherwise>
</xsl:choose>

</Subtype>

Sample Script in XML:

<target_mapping datatype="STRING" name="Subtype" value="SMPushFunctions.getSubType
('computer',Root['node_role'],Root['os_family'])"/>

Sample Script in Groovy:

Youmust develop a groovy function to implement themapping logic. Usually the relevant fields in the
counterpart system will be used as the parameters of the Groovy function.
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Many to Many Field Mapping

Sample Script in XSLT:

<xsl:for-each select="cpus">
<cpu>

<xsl:for-each select="cpu">
<cpu>

<CpuID><xsl:value-of select="@cpu_id"/></CpuID>
<CpuName><xsl:value-of select="@name"/></CpuName>
<CpuClockSpeed>

<xsl:value-of select="@cpu_clock_speed"/>
</CpuClockSpeed>

</cpu>
</xsl:for-each>

</cpu>
</xsl:for-each>

Sample Script in XML:

<for-each-source-entity count-index="i" source-entities="Root.Cpu">
<target_entity name="cpu">

<target_mapping datatype="STRING" name="CpuID" value="Root.Cpu[i]
['cpu_id']"/>

<target_mapping datatype="STRING" name="CpuName" value="Root.Cpu[i]
['name']"/>

<target_mapping datatype="STRING" name="CpuClockSpeed" value="Root.Cpu
[i]['cpu_clock_speed']"/>

</target_entity>
</for-each-source-entity>

Where: <source-entities> (Root Cpu) comes from the local TQL query structure, while <target_entity
name> (cpu) comes from the <cpu> tag in the XSLT file.

Note: Groovy scripts are not required for this scenario.

Value Conversion

Sample Script in XSLT:

<xsl:if test="@customer_id">
<xsl:variable name="ucmdbCustomerId" select="@customer_id"/>
<xsl:variable name="tenantMappingEntry" select="document('SM_MT_

mapping.xml')/list['TenantMapping']/entry[@ucmdb=$ucmdbCustomerId]"/>
<xsl:choose>

<xsl:when test="$tenantMappingEntry">
<CustomerId><xsl:value-of

select="$tenantMappingEntry/@sm"/></CustomerId>
</xsl:when>
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<xsl:otherwise>
<CustomerId><xsl:value-of select="@customer_id"/></CustomerId>

</xsl:otherwise>
</xsl:choose>

</xsl:if>

Or

<xsl:if test="contains(@node_role,concat($prefix,'virtualized_system',$suffix))">
<IsVisualization>true</IsVisualization>

</xsl:if>

Sample Script in XML:

<target_mapping datatype="STRING" name="CustomerId"
value="SMPushFunctions.getCustomerId(CustomerInformation)"/>

Or

<target_mapping datatype="BOOLEAN" name="IsVisualization"
value="SMPushFunctions.isVisualization(Root['node_role'])"/>

Note: Usually the relevant field in the counterpart system will be used as one of the parameters of
the Groovy function.

Sample Scripts in Groovy:

/**
* Priority Mapping
* [uCMDB value : SM value ]
*/
private static final def PriorityMapping = [

"1_critical":"1",
"2_high":"2",
"3_average":"3",
"4_low":"4"];

/**

* Convert the Priority value from uCMDB to SM
*
* @param priority uCMDB Priority value
* @return SM Priority value
*/
public static String convertPriority(String priority, DataAdapterLogger log)

{
return convertEnumValue(priority,"Priority");

}
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Step 2. Update the configuration files.
Update the files as described in the following table.

File Description

icon.properties This configuration file defines the UCMDB icons that will be displayed in the
mapping tool for ServiceManager CI Types. If you have defined any custom CI
types in SM, you can update this configuration file to assign them appropriate
icons.

For more information, see theUniversal CMDB Data Flow Management Guide.

sm.properties This is the integration adapter configuration file. If you havemodified the out-of-
the-box settings in your old sm.properties file (for example, the number of
concurrent threads), you need to update this configuration file accordingly for
those options that are still valid in the ServiceManager EnhancedGeneric
Adapter.

For more information, see "How to Update the Integration Adapter Configuration
File (sm.properties)" on page 162.

smFedConf.xml This configuration file is used for federation and is introduced by the Service
Manager EnhancedGeneric Adapter. If you have any custom logic for the
federation feature, such as custom fields for federation CIs, you need to update
this configuration file.

For more information, see "Troubleshooting Federation Issues" on page 236.

smPopConf.xml This configuration file is used for population and replaces the old
smPopConfFile.xml configuration file. If you have any custom logic for the
population feature, such as custom query conditions, you need to update this
configuration file.

For more information, see the following topics:

"What Is the Purpose of the <container> Element in the Population Configuration
File (smPopConf.xml)?" on page 144

"No TQLQuery Configured in smPopConf.xml " on page 232

smPushConf.xml This configuration file is used for relationship data push and replaces the old
smSyncConfFile.xml configuration file.

For more information about this file, see the following topics:

"How toMap a Relationship TypeQuery to the ServiceManagerWeb Service
Object" on page 176

"Query not Configured in smPushConf.xml" on page 226
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Step 3. Enable Push, Population and

Federation for CI types.
Once you have completed the tasks described above, youmust edit your integration point to add Push
and Population jobs for the CI types, as well as enable Federation for supported CI types. For details,
see the following topics:

"How to Create an Integration Point in UCMDB" on page 69

"How to Define Data Push Jobs in UCMDB" on page 76

"How to Define Population Jobs in UCMDB" on page 73

"How to Add an Attribute of a Supported CI Type for Federation" on page 212

Task 8: Upgrade Field Mapping
The out-of-box mapping files in the ServiceManager 9.41 adapters are already updated to align with the
logical name solution. You need tomake similar updates to your own field mapping.

Note: In ServiceManager 9.41 or later, the original CI Name field (the id field in the device table)
is removed from the Configuration Item detail form.

Upgrading the field mappings includes the following steps.

Step 1. Upgrade your data push field mapping

To update your CI pushmapping files, follow these steps:

1. Switch themapping field from CIIdentifier to DisplayName.

For example, from

<target_mapping name="CIIdentifier" datatype="STRING" value="Root['display_
label']"/>

to:

<target_mapping name="DisplayName" datatype="STRING" value="Root['display_
label']"/>

2. (Optional) Simplify the business logic for DisplayName.
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If you have customized the original CIIdentifier field values to appendmore fields so that they are
unique and not renamed by ServiceManager, you can remove such business logic. This is
because the DisplayName field in ServiceManager now supports duplicate values.

Step 2. Upgrade your population field mapping

You need tomake the following changes to your population field mapping files:

1. Change “CIIdentifier” to “DisplayName”.

2. Change “CIName” to “CIIdentifier”.

3. Make sure that the global.id field is included in themapping files. For example:

<target_mapping datatype="STRING" name="global_id" value="bizservice
['UCMDBId']"/>

For the Relationship and Running Software populationmapping files, perform the following additional
steps:

1. Remove all upstream and downstream “name”mapping entries from all relationship population
mapping files. The following are two example "name" mapping entries:

<target_mapping name="name" datatype="STRING" value="cirelationship1to1
['upstreamci.logical.name']"/>

<target_mapping name="name" datatype="STRING" value="cirelationship1to1
['downstreamci.logical.name']"/>

2. Remove the “name”mapping entry (the entry in bold) from the container node in the running
software populationmapping file.

<for-each-source-entity count-index="i" source-
entities="runningsoftware.computer">

<target_entity name="Node">

<target_mapping name="name" datatype="STRING"
value="runningsoftware.computer[i]['CIIdentifier']"/>

<target_mapping name="global_id" datatype="STRING"
value="runningsoftware.computer[i]['UCMDBId']"/>

</target_entity>

</for-each-source-entity>

Step 3. Upgrade your federation configuration files

Make the following updates to your federation configuration files:
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l Update the smFedConf.xml file to change one groovy method to convertArrayOrString, as shown
below:

<property ucmdbName="reference_number" smName="IncidentID"
valueConverter="convertArrayOrString"/>

l Add the following two functions to the SMFederationConverter.groovy file.

/**
* Convert arraylist to a string
*
* @param to be converted
* @return converted string value
*/
public static String convertArrayString(def arrStr, DataAdapterLogger log){
def strList=''
for (s in arrStr) {
strList+='"'+s+'"'+',';
}
if (strList.size()&gt;0)
strList=strList.substring(0, strList.length()-1);
return '{' + strList +'}';
}
public static String convertArrayOrString(def str, DataAdapterLogger log){
if (str instanceof String)
return convertString(str, log);
else
return convertArrayString(str, log);
}

Step 4. Configure the UCMDB JMX console

Configure the UCMDB JMX console, as described in the following steps.

Note: This feature enables the UCMDB global ID solution for ServiceManager. It is available only
in UCMDB 10.21 or later. For this reason, a known issue (QCCR1E122493) exists in
UCMDB versions earlier than 10.21: If two CIs with the same display name are pushed to SM and
then updated in SM with a new display name, when you run a population job to synchronize the CIs
back to UCMDB, the two CIs aremerged in UCMDB and therefore have the same ucmdb.id value
in SM.

1. Go to the JMX Console: http://<UCMDB server name>:<port>/jmx-console/.

2. EnterUCMDB:service=Settings Services in the search box, and press Enter.

3. Click setSettingValue to go to this section.

4. In the customerID field, enter your customer ID.
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5. In the name field, enter reconciliation.match.attributes.

6. In the value field, enter global_id.

7. Click Invoke.

If the configuration is successfully completed, the followingmessage is displayed:

Setting [reconciliation.match.attributes] value changed successfully to
[global_id]

Task 9: Reconfigure an Integration Point
You need to set up an integration point to use the ServiceManagerEnhancedAdapter9.41 adapter, and
activate the integration point. For details, see "How to Create an Integration Point in UCMDB" on
page 69.

Once this adapter is successfully enabled, you should be able to open one of the out-of-box mapping
files in the Visual Mapping tool interface without any problems. For details on how to use the Visual
Mapping tool, refer to theUniversal CMDB Data Flow Management Guide.

Task 10: Run a Full Push to
Resynchronize CI Names
Due to the logical name solution that was introduced in ServiceManager 9.41, once you have upgraded
to ServiceManager 9.41 or later, youmust run a full data push to resynchronize CI names to the CI
display name field in ServiceManager. When performing this step, you need to use the new integration
point that you reconfigured.

To resynchronize CIs, follow these steps:

1. Run a Full Push in UCMDB.

2. Check the CI data in ServiceManager.
a. Perform a search to find the CIs.

b. Verify that the Display Name field values of the CIs have been updated correctly.

Note: The display names of Retired CIs are not updated, because they are already
removed from UCMDB.
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Task 11: Restore the DEM Rules in
Service Manager
After you have run a full data push to resynchronize CI names to ServiceManager, youmust restore
the DEM rules to their original state so that they can function as usual.

To restore the DEM rules, follow these steps:

1. Log in to ServiceManager as a System Administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Click Search.

4. In each DEM rule, forAction if record exists but unexpected data discovered, restore the
setting to the original value (for example, Open a Change orOpen an Incident).
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Chapter 3: Integration Setup
Before implementing the integration in your production environment, you can set up the integration in a
test environment using the out-of-the-box integration configurations. This chapter describes the basic
integration setup tasks without any tailoring or multi-tenancy configurations.

Integration Requirements 61

Integration SetupOverview 63

ServiceManager Setup 63

Universal CMDB Setup 69

Populating UCMDB with ServiceManager CI Data 72

Pushing UCMDB CI Data to ServiceManager 76

Federating ServiceManager Ticket Data to UCMDB 82

Tip: Before you proceed to implementing the integration in your production environment, you can
refer to the following chapters for further information:

l "Multi-Tenancy (Multi-Company) Setup" on page 101, which describes how you set up the
integration in multi-tenancy mode.

l "Standards and Best Practices" on page 122, which describes best practices for implementing
the integration and also provides Frequently-Asked-Questions information.

l "Tailoring the Integration" on page 146, which describes how you can tailor the integration to
better suit your business needs.

l "Troubleshooting" on page 221, which provides information on troubleshooting data push and
population issues.

Integration Requirements
This section describes the integration requirements when using the
ServiceManagerEnhancedAdapter9.41 adapter.
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Supported Product Versions
The supported product versions for using this adapter are listed in the following table.

Important: If using UCMDB 11.0, CP 26 is required to integrate UCMDB with ServiceManager or
other applications.

Product Versions Notes

ServiceManager 9.41 or later
To support the embedding of
UCMDB Browser's CI
Visualization and Impact
Visualization widgets in Service
Manager, the following product
versions are required:

l ServiceManager 9.50 or
later

l UCMDB Browser 4.10 or
later

UCMDB 10.20 or later

UCMDB Browser Compatible versions for
UCMDB

Setting up Required Components
Youmust set up the following required components to establish an integration between UCMDB and
ServiceManager.

l Universal CMDB installation
Add a UCMDB Probe for the population feature if you do not already have one.

l ServiceManager installation
Add the UCMDB URL to the SMtoUCMDB integration instance in ServiceManager Integration
Manager.

l Network connection between the Universal CMDB and ServiceManager systems.

For instructions on installing and configuring your systems, see the UCMDB and ServiceManager
documentation.
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Deploying an Appropriate Adapter
To use a ServiceManager 9.41 adapter, all of your ServiceManager server, clients, and applications
must be version 9.41 or later. You need to verify your ServiceManager applications version and then
find the correct adapter.

To to this, follow these steps:

1. Log in to ServiceManager as a system administrator.

2. Enter db in the command line, and press Enter.

3. Enter scversion in the Table field, and then click Search.

4. Click Search again.

5. Check the Application Version value that is displayed.

6. If your applications version is earlier than 9.41, use the ServiceManagerAdapter9.41 adapter.

7. If you are running ServiceManager applications 9.41 or later, use the
ServiceManagerEnhancedAdapter9.41 adapter.

Integration Setup Overview
The integration requires setup on both the UCMDB and ServiceManager systems.

This task includes the following steps:

1. Set up the ServiceManager system.
See "ServiceManager Setup" below.

2. Set up the UCMDB system.
See "Universal CMDB Setup" on page 69.

3. Run the UCMDB population jobs to synchronize CIs to UCMDB.
See "Populating UCMDB with ServiceManager CI Data" on page 72.

4. Run the UCMDB data push jobs to transfer CIs to ServiceManager.
See "Populating UCMDB with ServiceManager CI Data" on page 72.

Service Manager Setup
Youmust complete the following tasks from your ServiceManager system to support the integration.
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1. Create a dedicated integration user account in ServiceManager.
See "How to Create an Integration User Account" below.

2. Add the UCMDB connection information to theSMtoUCMDB integration instance configured in
IntegrationManager.
See "How to Add UCMDB andUCMDB Browser Connection Information" on the next page.

How to Create an Integration User Account
This integration requires an administrator user account for UCMDB to connect to ServiceManager. The
user account must already exist in both UCMDB and ServiceManager.

Note: The ServiceManager EnhancedGeneric Adapter requires the ServiceManager
ucmdbIntegration RESTful APIs to work. For this reason, the integration user account must have
theRESTful API capability word in ServiceManager.

To create a dedicated integration user account in ServiceManager:

1. Log in to ServiceManager as a system administrator.

2. Type contacts in the ServiceManager command line, and press ENTER.

3. Create a new contact record for the integration user account.
a. In the Contact Name field, type a name. For example, UCMDBIntUser.

b. Click Add, and thenOK.

4. Type operator in the ServiceManager command line, and press ENTER.

5. In the Login Name field, type the username of an existing system administrator account, and click
Search.
The system administrator account is displayed.

6. Create a new user account based on the existing one.
a. Change the Login Name to the integration account name that you want (for example, ucmdb).

b. Type a Full Name. For example, UCMDB.

c. In the Contact ID field, click the Fill icon and select the contact record that you have just
created.

d. Click Add.

e. Select theSecurity tab, and change the password.

f. Select theStartup tab, and add theRESTful API capability word for the operator.

g. Click OK.
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The integration user account is created. Later you will need to add this user account
(username/password) in UCMDB, and then specify this user account in the Credentials ID field when
creating an integration point in UCMDB. See "How to Create an Integration Point in UCMDB" on
page 69.

How to Add UCMDB and UCMDB Browser

Connection Information
UCMDB-SM integration requires the UCMDB connection information to obtain CI attribute information
from the UCMDB system, and display it in the Actual State section in the ServiceManager
configuration item form; it also requires UCMDB Browser connection information to retrieve data from
UCMDB Browser and display the data to ServiceManager users.

Caution: If you do not specify the correct connection information, an error, instead of correct
CI related data, is displayed to ServiceManager users.

This task includes the following steps:

1. Log in to ServiceManager as a system administrator.

2. Click Tailoring > Integration Manager.

3. Click Add.

4. In the Integration Template field, select SMtoUCMDB.

Some fields in the form are automatically populated with a value. The empty fields can be ignored.

5. (Optional) Update theName, Log Level, andDescription fields as needed.

6. On theUCMDB Server Configuration tab, provide a value for each field in the following table.

Important: When specifying UCMDB URLs, use the fully qualified domain name (FQDN)
rather than the IP address of the server.

Field Description

UCMDB
webservice
URL

Enter the URL to the Universal CMDB web service API. The URL has the
following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

Replace <UCMDB server name> with the fully-qualified domain name
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Field Description

(FQDN) of your UCMDB server, and replace <port> with the communications
port your UCMDB server uses.

User Id Enter the user name required tomanage CIs on the UCMDB system. For
example, enter admin , which is the out-of-the-box administrator user name.

Password Enter the password required tomanage CIs on the UCMDB system. For
example, enter admin , which is out-of-box password for the admin user
account.

Multi-tenant
UCMDB
webservice
URL

This is the URL that ServiceManager uses to synchronize company records
with UCMDB when running in multi-company mode. This URL should use the
following format:

http://<UCMDB server
name>:<port>/axis2/services/UcmdbManagementService.

Replace <UCMDB server name> with the fully-qualified domain name
(FQDN) of your UCMDB server, and replace <port> with the communications
port your UCMDB server uses.

UserId

Password

This is UCMDB account (user name/password) that has the privilege to
add/delete company records.

7. Click Test Connection to verify that your UCMDB Server configuration is correct.

8. On theUCMDB Browser Configuration tab, configure each field or option as described in the
following table.

Field /
Option

Default
value Description

UCMDB
Browser
URL

Enter your UCMDB Browser URL in the following format:

http://<UCMDB Browser server name>:<port>/ucmdb-browser

Replace <UCMDB Browser server name> and <port> with the
fully-qualified domain name (FQDN) and communications port of
UCMDB Browser server host, respectively.

Important: When specifying UCMDB Browser URL, use the
FQDN rather than the IP address of the server host.

Note: If you specify theUCMDB Browser URL here, the
View in UCMDB Browser button will replace theView in
UCMDB button in CI records synchronized from UCMDB;
only when you leave this field empty, theView in UCMDB
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Field /
Option

Default
value Description

button will appear.

Show
UCMDB
Browser
Impact
widget

false
(disabled)

(Optional) Select this option if you want to embed UCMDB
Browser Impact widget in ServiceManager.

Tip: This option shows or hides the Impact Widget tab on
this page.

Show
UCMDB
Browser CI
Visualization
widget

false
(disabled)

(Optional) Select this option if you want to embed UCMDB
Browser CI Visualization widget in ServiceManager.

Tip: This option shows or hides theCI Visualization Widget
tab on this page.

Use a
dedicated
user account

false
(disabled)

(Optional) Select this option if LW-SSO is not enabled for the
integration and you want to configure a dedicated
UCMDB Browser user account for users to view UCMDB Browser
data from ServiceManager.

This option enables users to access UCMDB Browser data
directly from the ServiceManager user interface without the need
to enter a user name and password, and is therefore useful when
LW-SSO is not enabled for the integration.

For example, this dedicated user account is used when users view
an embedded UCMDB Browser widget (such as CI Visualization
and Impact Simulation) from a ServiceManager record or when
users click theView in UCMDB Browser button from aCI record
in ServiceManager.

Note: This option takes effect only when LW-SSO is not
enabled for the integration. If you have enabled both LW-SSO
and this option for the integration, LW-SSO is used.

Tip: This option shows or hides theDedicated User tab on
this page.

Impact
Widget tab >
Maximum
Trigger CIs
per Impact
Graph

100 This is themaximum number of CIs that ServiceManager is
allowed to send to UCMDB Browser as trigger CIs when running
impact simulation. For example, if the number of affected service
and CIs of a Change record exceeds this value, when users click
Run Impact Analysis for the Change record, the impact analysis
result is displayed onmultiple pages, each of which except the last
one contains aNext button on the top. Users can click Next to
view the next impact simulation graph.
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Field /
Option

Default
value Description

Caution: The value of this field must not be greater than 100.

Impact
Widget tab >
Impact
Bundle

This is a rule bundle that is defined in UCMDB Server and will be
used for impact analysis.

If you leave this field blank, the List of impact rule bundles
setting in UCMDB will be used. To access this setting in UCMDB,
go toAdministration > Infrastructure Settings Manager, and
chooseUCMDB Browser Settings. An empty value of this
settingmeans all rule bundles will be used.

Impact
Widget tab >
Default
Impact
Severity

critical This is the default impact severity for impact analysis. You can set
it to critical, high,medium, low, or none.

Note: A severity of "none" will be used when this field is left
blank.

CI
Visualization
Widget tab >
Filter TQL
for CI
Visualization

This is a filter TQL query that is used to retrieve CI relationship
graphs from UCMDB Browser. A filter TQL query is used to restrict
the CI types and relationship types that you want to display on
each relationship graph.

Dedicated
User tab >
User Id

Create a dedicated user account in UCMDB Browser and grant
appropriate permissions to this account.

Caution: This user account must be granted only limited
permissions that are just enough to view the Impact
Simulation, Get Related, and History widgets and to access
CIs. For information about how to specify which widgets are
displayed to a user and how to authorize CI access for a user,
refer to theUCMDB Browser Installation and Configuration
Guide.

Enter the user name in this field.

Dedicated
User tab >
Encrypted
Password

Obtain an encrypted value of the password of the dedicated user
account, and enter the value in this field.

To obtain an encrypted value for the password of a
UCMDB Browser user account, follow these steps:

a. Open UCMDB URL in your browser.

b. Click JMX Console from the login page.
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Field /
Option

Default
value Description

c. Log in to the JMX Console as an administrator.

d. Search for getencryptedPasswordForURL and then open this
section.

e. In theUser Name andPassword fields, enter the user name
and password of the user account that you want to use.

f. Click Invoke.

An encrypted value of the password is returned.

9. Click Finish.

ServiceManager creates an SMtoUCMDB integration instance.

10. Go to Integration Manager, and then click the SMtoUCMDB integration instance.

11. Click Next until the Initialize link becomes active, and then click the link.

Note: This step creates records in the cirelationship1to1 table so that CI relationships can
be properly populated to UCMDB.

12. Click Finish to go back to IntegrationManager, select the SMtoUCMDB integration instance, and
then click Enable to enable the integration instance.

Universal CMDB Setup
Youmust complete the following task from your UCMDB system to support the integration:

Create an integration point between UCMDB and ServiceManager. See "How to Create an Integration
Point in UCMDB" below.

How to Create an Integration Point in UCMDB
A default UCMDB installation already includes the ServiceManagerEnhancedAdapter9.41 package. To
use the integration package, youmust create an integration point that lists the connection properties for
the integration.

Caution: For data population, this integration supports the use of only one probe for your Service
Manager system. Do not run population jobs on different probes by setting upmultiple integration
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points with different probes for your ServiceManager system. Only one probe is allowed for one
ServiceManager system.

To create an integration point, follow these steps:

1. Log in to UCMDB as an administrator.

2. Add the integration user account that you created in ServiceManager.
a. Click Administration > Users and Roles.

b. Click theAdd New User icon .

c. For User Name and Password, type the user name and password that you created in Service
Manager. See "How to Create an Integration User Account" on page 64.

d. Click Next, and then select Admin from the Role List .

e. Click Finish. The integration user account is added.

3. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of existing
integration points.

4. Click theNew Integration Point icon .
UCMDB displays a New Integration Point properties window.

5. Complete the integration and adapter property fields as described in the following table.

Field name
Is
required? Description

Integration
Name

Yes Type the name (unique key) of the integration point. For example,
sm_integration.

Integration
Description

No Type a description for the integration point.

Adapter Yes Select HP Software Products / Micro Focus Products >
Service Manager > ServiceManagerEnhancedAdapter9.41.

Is Integration
Activated

Yes Enable this option to indicate the integration point is active.

Hostname/IP Yes Type the hostname or IP address of the ServiceManager server.

For example, localhost.

Port Yes Type the communications port of the ServiceManager server. For
example, 13080.

URL
Override

No This field value (if any) supersedes the Hostname/IP and Port
settings described above.
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Field name
Is
required? Description

Use this field If you want UCMDB to connect to ServiceManager
in any combinations of the following ways:

o Connect to ServiceManager over HTTPS or over both HTTP
and HTTPS

o Connect to multiple ServiceManager server nodes (horizontally
scaled environment)

o Connect to one single ServiceManager server node through
multiple ports (vertically scaled environment)

For more information, see "Push in Clustered Environments" on
page 127.

Type one or more ServiceManager web services URLs (separated
by a semicolon) in this field.

Each URLmust use this format:

http(s)://<hostname>:<port>/SM/9/rest

The following are two example values of this field:

o https://localhost:13443/SM/9/rest

o http://localhost:13080/SM/9/rest;
https://localhost:13443/SM/9/rest;
http://smfpe04:13080/SM/9/rest

Credentials
ID

Yes Click Generic Protocol, click theAdd icon to add the integration
user account that you created, and then select it. This account
must exist in both ServiceManager and UCMDB. See "How to
Create an Integration User Account" on page 64.

Data Flow
Probe

Yes Select the name of the Data Flow Probe used to run population
jobs. You should have already added the data flow probe for the
integration after installing UCMDB. See "Integration
Requirements" on page 61.

6. Click Test Connection to make sure that a successful connection has been established.

7. Click OK.
The integration point is created and its details are displayed.

8. Click the Federation tab, and complete the following configuration.
a. In Supported and Selected CI Types, select the following CI types as needed from

ItProcessRecord:
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i. Incident

ii. Problem

iii. Request for Change

b. For each CI type you selected (Incident, Problem, or RequestForChange), select Retrieve
CIs of selected CI Type forCI Type Retrieval Mode.

9. Click thePopulation andData Push tabs to view the default integration job details.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. If needed, you can create a new job for the integration point. For information
about creating integration jobs, see "How to Define Data Push Jobs in UCMDB" on page 76
and "How to Define Population Jobs in UCMDB" on the next page.

10. Click theSave Integration Point icon .

Populating UCMDBwith Service
Manager CI Data
In addition to pushing CI data from UCMDB to ServiceManager, this integration also supports the
population of CI data (including CIs and CI relationships) from ServiceManager to UCMDB. The
integration can then update the list of CIs in UCMDB if new CIs or new attribute values are found in
ServiceManager. The population of data from ServiceManager to UCMDB is defined in the Integration
Studio in UCMDB. You canmanually run the population jobs, howeverWe recommend that you
schedule these jobs to keep your CIs and CI attributes up to date.

This task includes the following steps:

1. Define CI/CI Relationship population jobs in UCMDB.
See "How to Define Population Jobs in UCMDB" on the next page.
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2. View the transferred CI/CI Relationship data in UCMDB.
See "View ServiceManager CI Data in UCMDB" on page 75.

3. Schedule CI population jobs to keep CIs and CI attributes up to date.
See "How to Schedule CI Population Jobs" on page 75.

How to Define Population Jobs in UCMDB
A CI or relationship population job copies certain types of CIs or relationships from ServiceManager to
UCMDB.

To define a CI or CI relationship population job, follow these steps:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of existing
integration points.

3. Open the integration point that you created for ServiceManager.

4. Click thePopulation tab, and add a new job as follows.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. The following table lists the default population jobs and their queries. If
needed, you can create, update or remove queries for each job.

Integration Job Queries for CI / CI relationship population

SMConfiguration
Item Population
job

Out-of-the-box, the following queries are available for this job, which
populates UCMDB with CI records from ServiceManager:

o SM Business Service Population 2.0: Populates UCMDB with CIs
of the bizservice type.

o SM RunningSoftware Population 2.0: Populates UCMDB with CIs
of the RunningSoftware type.

o SM Computer Population: Populates UCMDB with CIs of the
computer type.

o SM CLIP Down Time Population 2.0: Populates UCMDB with CIs
of the planned outage type.

SM Relations
Population job

Out-of-the-box, the following queries are defined for this job, which
populates UCMDB with CI Relationship records from ServiceManager:

o SM Biz To Biz With Containment 2.0: Populates UCMDB with CI

Queries for CI / CI relationship population
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Integration Job Queries for CI / CI relationship population

relationships in which a bizservice CI contains another.

o SM Biz To Biz With Usage 2.0: Populates UCMDB with CI
relationships in which a bizservice CI uses another.

o SM Biz To Computer With Containment 2.0: Populates UCMDB
with CI relationships in which a bizservice CI contains a computer CI.

o SM Biz To Computer With Usage 2.0: Populates UCMDB with CI
relationships in which a bizservice CI uses a computer CI.

o SM Computer To Computer With Connects 2.0: Populates
UCMDB with CI relationships in which a computer CI connects to
another.

o SM Biz To Software With Containment 2.0: Populates UCMDB
with CI relationships in which a bizservice CI contains a software CI.

o SM Biz To Software With Usage 2.0: Populates UCMDB with CI
relationships in which a bizservice CI uses a software CI.

o SM Computer Composition Software 2.0: Populates UCMDB with
CI relationships in which a computer CI connects to a software CI.

o SM CI Connection Down Time CI 2.0: Populates UCMDB with CI
relationships in which a CI connects to a down time CI.

Queries for CI / CI relationship population, continued

a. Click theNew Integration Job icon .

b. Type a Name for the integration job. For example, CI_Population_Job1.

c. Click theAdd Query icon to add existing queries to the job (see the table above).

d. Select theAllow Integration Job to delete removed data check box for the query.

e. Click OK to save the job.

5. Run the jobmanually to see if the integration job works properly.

a. To populate UCMDB with all relevant data for the job, click the icon.

b. To populate UCMDB with only CI data changes since the job last ran, click the icon.

6. Wait for the job to complete, and click theRefresh iconmultiple times as needed until the job is
completed.

Note: When the job is completed, the job status becomes one of the following: Succeeded,
Passed with failures, or Failed.
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7. Click theStatistics tab to view the results. If the job failed, click theQuery Status tab and Job
Errors tab for more information. For details, see "Troubleshooting Population Issues" on
page 230.

8. Click OK.

If the job is completed successfully, you can view the transferred CI data in UCMDB and schedule the
job so that it can run automatically.

View Service Manager CI Data in UCMDB
After a population job is successfully completed, you can search for the ServiceManager CI records in
UCMDB, and verify that their attributes are correctly populated.

The ServiceManagerDisplay Name field is populated to theName field on the Configuration Item
Properties pane in UCMDB.

Note: To see the entire attributemappings of a CI type, you can open its population XML file (for
example, SM Business Service Population.xml), where the UCMDB attribute field names and
themapped ServiceManager web service field caption names are defined. For more information,
see "Tailoring the Integration" on page 146.

How to Schedule CI Population Jobs
You can schedule CI population jobs tomatch the discovery/maintenance schedule of your Service
Manager feeders. For example, if your ServiceManager feeders send CI data updates on a daily
schedule, then the population jobs must also run on a daily schedule. By using amatching schedule
you can ensure that your UCMDB system always has themost current CI data.

This task includes the following steps:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of integration
points.

3. Open the integration point for ServiceManager.

4. Click thePopulation tab, and select a population job from the list.

5. Click theEdit Integration Job icon.
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6. Select theScheduler enabled option.

7. Select the scheduling options that you want to use. For example, select Repeat every: Day and
Ends: Never.

8. Select a Time Zone.

9. Click OK.

Pushing UCMDBCI Data to Service
Manager
The integration requires a one-time transfer of CIs from UCMDB to ServiceManager to populate the
ServiceManager system with CIs. The integration will then update the list of CIs in ServiceManager
when UCMDB discovers new CIs or new attribute values. The integration accomplishes the push of CI
data using data push jobs in the UCMDB system. We recommend that you schedule these jobs to
keep your CIs and CI attributes up to date.

This task includes the following steps:

1. Define CI/CI Relationship data push jobs.
See "How to Define Data Push Jobs in UCMDB" below.

2. View the CI/CI Relationship data pushed from UCMDB.
See "How to View UCMDB CI Data in ServiceManager" on page 81.

3. Schedule data push jobs to keep CI/CI Relationship data up to date.
See "How to Schedule Data Push Jobs" on page 79.

How to Define Data Push Jobs in UCMDB
Data push jobs copy CI or CI Relationship records from your UCMDB system to your ServiceManager
system.

To define a CI or CI relationship push job, follow these steps:

1. Log in to UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of existing
integration points.

3. Select the Integration Point that you created for ServiceManager. For example, sm_integration.
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4. Click theData Push tab.

5. Follow these steps to add a new data push job:

a. Click theNew Integration Job icon .

Note: UCMDB creates a default data push job when creating an integration point. The
following table lists the default data push job and its queries. If needed, you can create,
update, or remove queries for the push job. To access these out-of-the-box queries for push,
go toModeling >Modeling Studio > Resources, select Queries for Resource Type, and
then navigate toRoot > Integration > Service Manager > Push. For information about
tailoring data push queries, see "How to Create aQuery to Synchronize the CI Type" on
page 196.

Integration
job Queries

Integration
job

Queries

SM Push
job

Out-of-the-box, the following queries are available for this job, which pushes CI
records from UCMDB to ServiceManager:

o SM Mainframe Push 2.0: pushes CIs of themainframe type.
o SM Business Element Push 2.0: pushes CIs of the business application, and

infrastructure service types

o SM Network Component Push 2.0: pushes CIs of the network component
type.

o SM Running Software Push 2.0: pushes CIs of the running software type.
o SM Business Service Push 2.0: pushes CIs of the business service type.
o SM Computer Push 2.0: pushes CIs of the computer type.
o SM Storage Push 2.0: pushes CIs of the storage type.
o SM Switch Push 2.0: pushes CIs of the switch type.
o SM Net Printer Push 2.0: pushes CIs of the net printer type.
o SM Cluster Push 2.0: pushes CIs of the cluster type.
o SM Mobile Device Push 2.0: pushes CIs of themobile device type.
o SM Local Printer Push 2.0: pushes CIs of the local printer type.

Out-of-the-box, the following queries are available for this job, which pushes CI
Relationship records from UCMDB to ServiceManager:

o SM Layer2 Topology Relations Push 2.0: pushes compound CI

Queries for CI / CI Relationship Push
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Integration
job Queries

relationships between nodes.

o SM Business Service Relations Push 2.0: pushes CI relationships whose
upstream CI type is business service.

o SM CRG Relations Push 2.0: pushes CI relationships whose upstream CI
type is cluster.

o SM Node Relations Push 2.0: pushes direct CI relationships whose
upstream CI type is node.

Queries for CI / CI Relationship Push , continued

b. In theName field, type a unique name for the job. For example, CI_Push_Job1.

c. Click theAdd Query icon to add existing queries to the job.

d. Select theAllow Integration Job to delete removed data option for each query.

e. Click OK to save the job.

6. Run the jobmanually to verify that the integration job works properly.

Caution: If you have a huge amount of CI data in your UCMDB system, and this is your first
time to push CI /CI Relationship data to ServiceManager, it is recommended to select the
“Add the record” option instead of “Open a change” or “Open an incident” for “Action if
matching record does not exist” in each Discovery Event Manager Rules definition. Failure to
do somay cause unnecessary performance problems. For details, see "How to Add
Discovery Event Manager Rules" on page 168.

a. To push all relevant data for the job, click the icon.

b. To push only data that was changed since the job last ran, click the icon.

Tip: You can stop a running push job by pressing theStops the selected job icon .

7. Wait for the job to complete, and click theRefresh iconmultiple times as needed until the job is
completed.

Note: When the job is completed, the job status becomes one of the following depending on
the results: Completed successfully, Completed, or Failed.

8. Click theStatistics tab to view the results; if any errors occur click theQuery Status tab and Job
Errors tab for more information. For details, see "Troubleshooting Data Push Issues" on
page 221.

9. Click OK.
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If the job is completed successfully, you can view the UCMDB CI data in ServiceManager, and
schedule the job so that it can run automatically.

How to Schedule Data Push Jobs
It is a best practice to schedule the data push jobs tomatch the discovery schedule of your Service
Manager feeders. For example, if your ServiceManager feeders send CI data updates on a daily
schedule, the data push jobs must also run on a daily schedule. By using amatching schedule you can
ensure that your ServiceManager system always has themost current CI data.

UCMDB allows you to schedule updates directly from a data push job. This task includes the following
steps:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of integration
points.

3. Select the integration point that you created for ServiceManager. For example, SM Integration.

4. Click theData Push tab.

5. Select a push job. For example, SM Configuration Item Push Job 2.0.

6. Click theEdit Integration Job icon .

Tip: UCMDB allows you to define two different schedules for two types of data push: Delta
Sync, and Full Sync. For recommendations on push scheduling, see "Push Scheduling
Recommendations" on page 125.

7. Define a schedule for Delta Sync.
a. Click theDelta Synchronization tab.

b. Select theScheduler enabled option.
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c. Select the scheduling options that you want to use.

8. Click the Full Synchronization tab, and select the scheduling options that you want to use.

9. Click OK to save the data push job.

10. Repeat step 6 to step 9 for the rest of data push jobs of the integration point.

11. Save the integration point.

Data Push Error Handling
When a scheduled data push job in UCMDB is running, someCI datamay fail to be pushed due to an
error. When this happens, the order of pushing failed CIs is as follows:

1. UCMDB runs the job at one point and fails to push some data (CIs).

2. The ServiceManager (SM) adapter calls a UCMDB API tomark these CIs as failed.

3. UCMDB runs this job again at another point.

4. UCMDB picks up the failed CIs and sends them to the SM adapter first, and then sends new CIs
to the SM adapter.

5. The SM adapter pushes all of the CIs from UCMDB to SM.
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How to View UCMDB CI Data in Service

Manager
After a push job is successfully completed, you can search for and verify the pushed CI/CI relationship
data in ServiceManager.

CI records pushed from UCMDB contains aView in UCMDB orView in UCMDB Browser button,
which enables you to access UCMDB or UCMDB Browser to view the CI information.

Note:
l If you specified the UCMDB Browser URL in the System Information Record in SM, theView
in UCMDB Browser button is displayed; otherwise theView in UCMDB button is displayed.

l The UCMDB Browser is a lightweight UI designed for simple access to UCMDB configuration
information. This is a tool for searching, locating and consuming configuration related data. It is
an optional add-on to UCMDB. For more information, refer to the UCMDB Browser
documentation.

To view UCMDB CI data in ServiceManager:

1. Log in to ServiceManager as a system administrator.

2. Navigate toConfiguration Management > Search CIs.

3. Open a CI record pushed from UCMDB.

4. If theView in UCMDB button is available, view the CI record in UCMDB.
a. Click theView in UCMDB button. The UCMDB login screen opens.

b. Type a UCMDB username and password to log in.

The CI record opens in UCMDB. You can view its properties.

Note: You can enable Lightweight Single Sign-On (LW-SSO) for the integration so that
ServiceManager web client users can bypass the UCMDB login screen. For details, see
"How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 135.

5. If theView in UCMDB Browser button is available, view the CI record in the UCMDB Browser.
a. Click theView in UCMDB Browser button. The UCMDB Browser login screen opens.

b. Type a UCMDB Browser username and password to log in. The CI record opens in the
UCMDB Browser. You can view its properties and other information.
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6. Open theActual State section.
ServiceManager sends a web services request to UCMDB and displays all CI attributes that the
request returns.

Note: The web services request uses the UCMDB webservice URL and account (for
example, admin/admin) defined in theSMtoUCMDB integration instance in ServiceManager.
See "How to Add UCMDB andUCMDB Browser Connection Information" on page 65.

How to View the Change History of the

Primary CI of a Problem Record
When integrated with UCMDB Browser, ServiceManager displays aPrimary CI History in UCMDB
section in a problem record whose primary CI is synchronized from UCMDB. You can view the CI
changes on that primary CI for root cause investigation.

For information about how to enable an integration with UCMDB Browser, see "How to Add UCMDB
andUCMDB Browser Connection Information" on page 65.

To view the primary CI change history, follow these steps:

1. Log in to ServiceManager.

2. Navigate toProblem Management, and perform a search to open a problem record whose
Primary CI is synchronized from UCMDB.

3. Click thePrimary CI History in UCMDB tab.

Federating Service Manager Ticket Data
to UCMDB
Federation does not physically copy data from ServiceManager (SM) to UCMDB; it only retrieves SM
data for displaying in UCMDB. Out-of-the-box, the UCMDB-SM integration supports federation for the
following external CI types in UCMDB: Incident, Problem, RequestForChange, and ChangeTask. If
you have enabled these CI types for federation when creating your integration point, in UCMDB you
can retrieve Incident, Problem, Change, and Change Task record data from SM.
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Out-of-the-box, each of the CI types (Incident, Problem, Change, and Change Task) supports
federation of a subset of their attributes in ServiceManager; however, the integration can federatemore
attributes if tailored as such.

This section includes:

l "Federation Queries" below

l "Examples of Using Federation" below

l "How to Add an Attribute of a Supported CI Type for Federation" on page 212

Federation Queries
Federation uses queries to determine what data to retrieve from ServiceManager. To retrieve specific
ticket data from ServiceManager, you need to create a TQL query first.

The ServiceManagerEnhancedGenericAdapter9-x provides a bunch of sample federation queries,
which you can use as a reference. They are available from the following path in UCMDB:Modeling >
Modeling Studio > Resources > Integration > Service Manager > Federation.

Examples of Using Federation
You can use the federation feature in many different ways. The following are only examples of using the
feature:

l "Example 1: Federate All SM Incident Tickets" below

l "Example 2: Federate SM Incident Records that Affect a UCMDB Business Service CI" on page 88

l "Example 3: Federate Incident, Change, and Problem Record Data from ServiceManager for
UCMDB CIs" on page 95

l "Example 4: Retrieve ServiceManager Records Related to a UCMDB CI" on page 98

Example 1: Federate All SM Incident Tickets
This example illustrates how you retrieve information of all Incident records that exist in Service
Manager.
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1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio > Resources.

3. For Resource Type, select Queries from the list.

4. Click New > Query.

5. On theCI Types tab, navigate to ItProcessRecord > Incident, and drag it to the query pane on
the right side.

6. Specify ServiceManager as the data source for the Incident query node.
a. Select the Incident query node, click theData Sources tab on the lower right pane, and then

click Edit.

b. Select theSelect integration points option, and then select your integration point name (for
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example, sm_integration). Click OK.

7. Click theSave icon , and then type a query name and select a location in which to save the

query (for example, select theRoot folder).

8. Select the Incident query node, and then click theCalculate Query Result Count icon .
UCMDB returns the query result count. For example, the following figure shows that there are a
total of 116 Incident records in ServiceManager.

ServiceManagerEnhancedAdapter9.41 User Guide
Federating ServiceManager Ticket Data to UCMDB

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 85 of 241



9. Right-click the Incident query node, and select Show Element Instances. UCMDB displays a list
of all Incident records that exist in ServiceManager.
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10. Select an Incident record from the list, and click theProperties icon to view its details.
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Example 2: Federate SM Incident Records that

Affect a UCMDB Business Service CI
The following example illustrates how to federate a list of ServiceManager Incident records whose
Affected Service or Affected CI field contains a UCMDB Business Service CI.

In this example, IM10005 in SM has an affected service named bizservice1, which was pushed from
UCMDB.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio > Resources.

3. For Resource Type, select Queries from the list.

4. Click New > Query.

5. On theCI Type tab, navigate toConfigurationItem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

6. Navigate to ItProcessRecord > Incident, and drag the icon to the query pane.
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7. Click theCreate Relationship icon .

8. Select the Incident query node, and drag the arrow from this node to the BusinessService node to
create a regular relationship between the nodes.
a. Select Regular Relationship, and click OK.

b. SelectMembership, and optionally enter a relationship name (for example,Membership).
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Click OK.

9. Specify UCMDB as the data source for the BusinessService query node. To do this, follow these
steps:
a. Select theBusinessService query node.

b. On the lower right pane, click theData Sources tab and then click Edit.

c. Make sure that the Local data source (UCMDB only) option is selected.
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d. Click OK.

10. Repeat the steps above to specify your integration point as the data source for the Incident query
node (for example, sm_integration).
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11. Click theCalculate Query Result Count icon . The number of SM Incidents and the number

of their affected UCMDB Business Service CIs are displayed.
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12. Click thePreview icon to view the query results .
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13. Select each SM Incident record from either the CI Selector pane or the query pane, and click the

Properties icon to view its details .
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14. Select each UCMDB CI record from the CI Selector pane, and click theProperties icon to view
its details.

Example 3: Federate Incident, Change, and

Problem Record Data from Service Manager for

UCMDB CIs
The following example illustrates how to retrieve information of Incident, Change and Problem records
in ServiceManager that affect a UCMDB Business Service CI.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio > Resources.

3. For Resource Type, select Queries from the list.

4. Click New > Query.
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5. On the CI Type tab, go toConfigurationItem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

6. Go to ItProcessRecord, and drag Incident, Problem, andRequestForChange to the query
pane.

7. Click theCreate Relationship icon to create regular relationships between the

BusinessService node and the other nodes, as shown in the following figure.

8. Select each node and click theData Sources tab to specify a data source for each node.
a. For the BusinessService node, specify UCMDB as the data source.

b. For the Incident, Problem, and RequestForChange nodes, specify your integration point as
the data source (sm_integration in this example).

9. Save the query.

10. Optionally, edit the BusinessService node properties as needed.
a. Select the BusinessServic node, and click Edit on the lower right pane.

b. Click theCardinality tab. The default Cardinality setting is displayed.
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c. If you wish, change either or both of theAND operators toOR. This will change the filter
criteria and therefore the query results.

11. Click thePreview icon to view the query results.
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12. Select each SM Incident record from either the CI Selector pane or the query pane, and click the

Properties icon to view its details.

13. Select each UCMDB CI record from either the CI Selector pane or the query pane, and on the
Related CIs tab click Show Related CIs to view its related CIs in both SM andUCMDB.

Example 4: Retrieve Service Manager Records

Related to a UCMDB CI
The following example illustrates how to retrieve ServiceManager records related to a UCMDB CI by
using the Get Related CIs functionality.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling > IT Universe Manager.

3. On theSearch CIs tab, search for a UCMDB CI that has related records in ServiceManager. For
example, enter bizservice1 in the CI Name field, click Search, and then double-click the CI to
open it.

4. If the Get Related CIs pane is not displayed, click theShow Get Related CIs pane icon .
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5. Click theSelect target Integration Points for related CIs icon .

6. Select theSelect integration points option, and then select bothUCMDB and your integration
point. Click OK.

7. Click Show Related CIs. The CI’s related SM records and UCMDB CIs are displayed.
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8. Select each SM record from the query pane, and click theProperties icon to view its details.
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Chapter 4: Multi-Tenancy (Multi-
Company) Setup
The UCMDB-SM Integration supports amulti-tenancy configuration in which both the ServiceManager
and UCMDB systems track Configuration Items (CIs) and Configuration Item Relationships (CIRs) by
company ID. In amulti-tenancy configuration, you can tailor the integration so that each tenant only
sees and works with the CIs and CIRs that match their company ID. Multi-tenancy is intended for
managed service providers (MSPs) who wish to offer ConfigurationManagement as a service to
multiple tenants.

Multi-Tenancy (Multi-Company) Support 101

Multi-Tenancy Requirements 109

Setting up theMulti-Tenancy Integration in UCMDB 109

Setting up theMulti-Tenancy Integration in ServiceManager 113

Multi-Tenancy (Multi-Company) Support
Multi-tenancy is when a single instance of software runs on a server, servingmultiple client
organizations (also referred to as tenants). Multi-tenancy contrasts with amulti-instance architecture
where separate software instances or hardware systems are set up for different client organizations.

When implementing amulti-tenant architecture, a software application is designed to virtually partition
its data and configuration so that each client organization works with a customized virtual application
instance. The following figure illustrates an examplemulti-tenant integration deployment.
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Every tenant configured in UCMDB works with the relevant tenant in SM. If UCMDB did not configure
tenants, the tenant configurationmust be activated in order to transfer the configuration from SM to
UCMDB automatically. This function is performed once only by the system administrator.

In the event that UCMDB tenant configuration already exists and the SM configuration does not exist,
SM tenants must bemanually configured according to the UCMDB configuration.

Implementing Multi-Tenancy in the UCMDB-

SM Integration
SM stores the company records that describe each tenant in themulti-tenant configuration. The
ServiceManager system is the definitive source for company records and pushes all new company IDs
to the UCMDB system creating the equivalent entity in UCMDB.

SM tracks the company ID of each CI and relationship in amulti-tenant configuration. CI records inherit
the company ID of the UCMDB feeder that discovered them. Relationship records inherit the company
ID of the parent CI in the relationship.

Mandanten SM Security Layer
Mandanten is an SM software layer that is used to filter the customer ID from the CI information. SM
uses theMandanten to ensure that operators only see CI and relationship records where the CI's
company ID matches the operator's company ID. If the view is restricted with Mandanten, then Service
Manager also restricts the view to all other related records such as change requests and incidents.

What Multi-Tenant Information is Stored in

UCMDB
Your UCMDB system stores a company ID attribute for each CI and CIR. The company ID determines
what adapter and synchronization schedule your UCMDB system uses to update CI data. Each CI and
relationship record can only have one company ID. The UCMDB system obtains a company ID from
the ServiceManager system.
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If more than one tenant (company) shares the sameCI, each tenant has their own unique CI record
describing the CI. In effect, the UCMDB system creates multiple CI records to track onemanaged
asset. Each tenant’s CI record is unique to that tenant and lists the company's unique company ID.

What Multi-Tenant Information is Stored in

Service Manager
Your ServiceManager stores the company records that describe each tenant in themulti-tenant
configuration. The ServiceManager system is the definitive source of company IDs and pushes new
and updated information to your UCMDB system.

ServiceManager tracks the company ID of each CI and relationship in amulti-tenant configuration. CI
records inherit the company ID of the UCMDB feeder that discovered them. Relationship records
inherit the company ID of the parent CI in the relationship.

In a best practices implementation, ServiceManager uses Mandanten to ensure that operators only
see CI and relationship records where the CI’s company ID matches the operator’s company ID. If you
restrict the view with Mandanten, then ServiceManager also restricts the view to all other related
records such as change requests and incidents.

Synchronization of Company Records
If your systemmeets all the conditions for multi-tenancy support, ServiceManager creates a schedule
record to push the company ID of the company record to your UCMDB system. ServiceManager uses
the following rules to determine whether to push the company ID to your UCMDB system.

Conditions

Tenant
information
synchronized?

Schedule record created
and action taken in
UCMDB

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You create a new company record in Service
Manager

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Add new company ID

l UCMDB-SM integration enabled Yes Synch Company with
UCMDB - <UCMDB

Conditions where Service Manager synchronizes company ID with UCMDB
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Conditions

Tenant
information
synchronized?

Schedule record created
and action taken in
UCMDB

l You update an existing company record that
has not been synchronized with UCMDB

l Multi-company mode enabled in Service
Manager

Company ID>

l Add new company ID

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You disable the option to show a company in
multi-company lists on a company
synchronized with UCMDB

Yes Inactivate Company with
UCMDB - <UCMDB
Company ID>

l Inactivate existing
company ID

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You select the option to resynchronize with
UCMDB on an existing company record

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Add new company ID

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You enable the option to show a company in
multi-company lists for an inactivated company

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Reactivate company ID

l UCMDB-SM integration disabled

l Multi-company mode enabled in Service
Manager

l You update an existing company record that
has already been synchronized with UCMDB

No None

l UCMDB-SM integration disabled

l Multi-company mode enabled in Service
Manager

l You create a new company record in Service
Manager

No None

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You disable the option to show a company in

No None

Conditions where Service Manager synchronizes company ID with UCMDB, continued
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Conditions

Tenant
information
synchronized?

Schedule record created
and action taken in
UCMDB

multi-company lists on a company not
synchronized with UCMDB

l UCMDB-SM integration enabled

l Multi-company mode disabled in Service
Manager

l You create a new company record in Service
Manager

No None

Conditions where Service Manager synchronizes company ID with UCMDB, continued

UCMDB Customer ID
When you enable themulti-tenancy integration, ServiceManager displays a new field in each company
record called UCMDB Customer ID. In order to synchronize a company record with UCMDB, youmust
first provide a value for this field. After you provide a UCMDB Customer ID value this field becomes
read-only. You cannot change a company's UCMDB Customer ID after you set it.

This field only accepts numeric data up to ten characters long. ServiceManager requires the field value
to be a unique positive whole number. You cannot enter duplicate values or use decimals, negative
numbers, or zero.

Your UCMDB system automatically uses the UCMDB customer ID of 1 when running in single tenant
mode. You can reuse this default value in your multi-tenant implementation by assigning a Service
Manager company to have this UCMDB customer ID value. Out-of-the-box, no ServiceManager
company has the UCMDB customer ID of 1.

UCMDB User ID and Password
When you enable themulti-tenancy integration, ServiceManager displays two new fields in each
company record called UCMDB UserId and UCMDB Password. These fields allow you to specify the
connection information you want ServiceManager to use when requesting information for the Actual
State section. Any user name and password you enter in these fields must be valid for your UCMDB
system.

The user name and password you provide in the Company Information record takes precedence over
the user name and password you provide in the System Information record. This allows managed
service providers to control access to the UCMDB system on a tenant-by-tenant basis. If you do not
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provide a company-specific UCMDB user name and password, ServiceManager uses the credentials
you provided in the System Information record.

Company Code
Themulti-tenancy integration requires that each company record has a unique Company Code
(company field) value. Since Company Code is a required field, your existing company records should
already have Company Code values. However you should ensure that each company record has a
unique Company Code value.

When using ServiceManager EnhancedGeneric Adapter for UCMDB-SM integration, youmust define
your company codes in the ServiceManagerEnhancedAdapter9.41/mappings/scripts/SMUtils.groovy
file using the following format (where a comma is used to separatemapping entries):

["<UCMDB Company 1 Code>":"<SMCompany 1 Code>", "<UCMDB Company 2 Code>":"<SM
Company 2 Code>"]

For example: ["1":"microfocus", "2":"sap"]

Caution: You should not change the Company Code value after you have enabled themulti-
tenancy integration because this will cause your ServiceManager data to become out of synch.

CI Reconciliation Rules
CIs that are pushed from UCMDB are identified only by their global.id value in UCMDB. By default,
only the ucmdb.id field in the device table is used in CI reconciliation (the company.id field is not used).

You can add reconciliation rules manually through Tailoring >Web Services > DEM Reconciliation
Rules. For details, see "How to Add DEMReconciliation Rules" on page 166.

Company Information Pushed to CI and CI

Relationship Records
When you enable themulti-tenancy integration, ServiceManager inserts the SM Company Code value
in CI and relationship records during data push. ServiceManager uses the UCMDB Customer ID to
look up thematching SM Company Code value.
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Company Information Replicated to Incident

Records
When you enable themulti-tenancy integration and select the option to create incidents when UCMDB
discovers new, updated, or deleted CIs, ServiceManager inserts the SM Company Code value in the
incident record during replication. ServiceManager uses the UCMDB Customer ID to look up the
matching SM Company Code value.

Schedule Records
ServiceManager uses the problem schedule process tomanage the synchronization of company IDs
to your UCMDB system. You canmanually enable the problem schedule process from the System
Status form.

When the synchronization criteria aremet as described in Table "Conditions where ServiceManager
synchronizes company ID with UCMDB" on page 103, ServiceManager creates a “Synch Company
with UCMDB - <UCMDB Company ID>” schedule record (for example, “Synch Company with
UCMDB - 1234567890”). If you inactivate a company, ServiceManager creates an “Inactivate
Company with UCMDB - <UCMDB Company ID>” schedule record (for example, “Inactivate
Company with UCMDB - 1234567890”). The problem schedule process processes the new schedule
record on the next background process iteration.

If your ServiceManager system cannot connect to your UCMDB system for some reason, it will
reschedule the company synchronization at the next scheduled interval (the out-of-the-box interval is 5
minutes). The problem schedule process updates the schedule record with the status rescheduled. If
the ServiceManager system receives any other error message while connecting to the UCMDB
system, it updates the schedule record with the status “application failed due to error - check msglog for
possible messages.”

Tenant-Specific Discovery Event Manager

(DEM) Rules
You can implement the condition field function in order to create SM DEM rules that are specific to a
particular tenant in amulti-tenancy UCMDB-SM integration.
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Tenant rules vary according to SM tenant configuration requirements, for each record information type
pushed from UCMDB to SM different tenants can configure different DEM tenant rules.

Each tenant can have its own set of unique requirements and thereforemay implement different
processes through the integration.

One tenant may require the addition of CIs directly to SM while another tenant may require opening
changes for each CI.

The following table shows a sample set of DEM rules that illustrate how to accomplish this.

DEM rule ID Action on new CI Condition

ucmdbNode_advantage Add CI company in $L.file=”advantage”

ucmdbNode_hp Create change company in $L.file=”HP”

Tenant-specific DEM rules

Note: DEM Rules

When creating DEM rules, be sure to create separate DEM rules for each tenant.

Multi-Tenancy Use Cases
The following table describes the necessary actions to perform in various deployment situations to
address multi-tenancy issues.

Deployment
Integration
Type Description

UCMDB
withmulti-
tenancy
rules

SM without
multi-
tenancy
rules

When implementing a UCMDB-SM deployment that has existingmulti-tenancy rules
in UCMDB and does not havemulti-tenancy rules configured in SM, the user creates
multi-tenancy rules in SMmanually and according to the rules in UCMDB.

SM with
multi-
tenancy
rules

When implementing a UCMDB-SM deployment that has existingmulti-tenancy rules
in configured SM and does not havemulti-tenancy rules configured in UCMDB, the
user creates multi-tenancy rules in UCMDB manually as well as according to the
rules previously configured in SM.

Multi-tenancy use cases
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Deployment
Integration
Type Description

UCMDB
without
multi-
tenancy
rules

UCMDB
without
multi-
tenancy
rules

SM without
multi-
tenancy
rules

When implementing a UCMDB-SM deployment that does not havemulti-tenancy
rules configured in UCMDB or in SM, the user configures the rules in SM.

During the configuration process using the SMmulti-tenancy wizard the user can
create corresponding tenancy configuration in UCMDB. By creating corresponding
tenancy configurations in SM the user also creates a corresponding tenant in
UCMDB.

Multi-tenancy use cases, continued

Multi-Tenancy Requirements
Your systemmust meet the following requirements in order for the integration to support multi-tenancy.

l Integration enabled between UCMDB and ServiceManager

l Multi-company mode enabled on the ServiceManager system

l Problem schedule process running on the ServiceManager system

For additional information about themulti-tenancy integration, you can visit theMicro Focus Software
Support Online web site or refer to the ServiceManager help.

Setting up the Multi-Tenancy Integration
in UCMDB
You need to perform the following tasks in UCMDB to set up themulti-tenancy integration.

1. Install a separate data flow probe for each tenant the integration will support.
See "How to Install a Separate Data Flow Probe for Each Tenant" on the next page.

ServiceManagerEnhancedAdapter9.41 User Guide
Multi-Tenancy Requirements

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 109 of 241

https://softwaresupport.softwaregrp.com/
https://softwaresupport.softwaregrp.com/


2. Start tenant-specific data flow probes.
See "How to Start Tenant-Specific Data Flow Probes" on the next page.

3. Configure IP address ranges for tenant-specific data flow probes.
See "How to Configure IP Ranges for Tenant-Specific Data Flow Probes" on page 112.

Caution: Multi-tenancy is not supported for population when the integration uses the Service
Manager EnhancedGeneric Adapter.

How to Install a Separate Data Flow Probe for

Each Tenant
If you plan to support a multi-tenant configuration, youmust install a separate data probe for each
tenant. Out-of-the-box, the UCMDB installer only installs one data flow probe and service.

To install additional data flow probes and start them from your operating system command prompt:

1. Log in to the host of your UCMDB system as an administrator.

2. Insert the Universal CMDB SetupWindows DVD into the system disc drive.

3. Start the Data Flow Probe installer (HPUCMDB_DataFlowProbe_x.xx.exe).

4. Follow the on-screen instructions to complete the wizard, but use the following values for each
data flow probe you wish to install.
a. Type a unique path for each installation folder.

b. Use the sameUCMDB application server address for each data flow probe.

c. Type a valid data flow probe address.

d. Type a unique name for each data flow probe identifier.

e. Create a unique customer Data Flow Probe domain for each probe (Clear the Use Default
CMDB Domain option).

f. Use the same probe gateway and probemanager settings for each probe (for example, use
combined or separate processes).

See theUniversal CMDB Deployment Guide for complete installation instructions.

5. Repeat step 3 and step 4 for each data flow probe you wish to install.

6. Open the probe’s DiscoveryProbe.properties file in a text editor. By default, this file is located
in the following folder:
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<UCMDB installation folder>\<data flow probe installation folder>\conf

For example, C:\UCMDB\DataFlowProbe\conf.

Note: The <data flow probe installation folder> must be unique for each tenant.

7. Edit the following properties in the configuration file.

Property Value

serverName Verify the name of the UCMDB server

customerId Type the customer ID for the tenant this data flow probe
supports

appilog.collectors.probe.name Verify the probe name is unique such as server + tenant
ID

applilog.collectors.domain Verify the domain name of the data flow probe

appilog.collectors.local.ip Verify the data flow probe gateway name

appilog.collectors.probe.ip Verify the data flow probemanager name

appilog.collectors.rmi.port Type a unique port for each probe

appilog.collectors.rmi.gw.port Type a unique port for each probe

appilog.collectors.probe.html.port Type a unique port for each probe

appilog.collectors.local.html.port Type a unique port for each probe

appilog.collectors.ProbeUseSpecific

RMIPortFrom

Type a unique port for each probe or type 0 to have the
system automatically select it

appilog.collectors.bigBrother.port Type a unique port for each probe

Discovery Probe properties set for each tenant

8. Save the configuration file.

9. Repeat step 6 to step 8 for the data flow probe of each tenant.

How to Start Tenant-Specific Data Flow

Probes
To start tenant-specific data flow probes:
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1. Open theOS command prompt and navigate to the probe’s bin folder. For example,
C:\UCMDB\DataFlowProbe1\bin.

2. Type gateway console.

3. Repeat step 1 to step 2 for each data flow probe you want to start.

How to Configure IP Ranges for Tenant-

Specific Data Flow Probes
To configure IP ranges for tenant-specific data flow probes:

1. Log in to UCMDB as an administrator using the company ID of the tenant whose data flow probe
you want to configure.

2. Navigate toData Flow Management > Data Flow Probe Setup.

3. Expand the data flow probe domain containing the probe you want to start. For example,
Customer2.

4. Expand the Probe node and select the data flow probe you want to start. For example,
Probe2Customer2.

5. Click theAdd IP range icon .

6. Type an IP range you want the Data Flow Probe to scan. Optionally, add any IP ranges you want
to exclude.

7. Click OK to save the IP range.

8. Repeat step 1 to step 7 for each data flow probe you want to configure.
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Setting up the Multi-Tenancy Integration
in Service Manager
You need to perform the following tasks in ServiceManager to set up themulti-tenancy integration.

Multi-tenancy support is an optional feature of the integration intended for Managed Service Providers
(MSPs) who want to offer ConfigurationManagement as a service to their tenants. In amulti-tenancy
configuration, each CI and CIR record has a corresponding company ID. Out-of-the-box, Service
Manager allows all operators to view CI data regardless of the company ID. If you wish to restrict
access to CI data by company ID, youmust enableMandanten and use the company ID field as a
restricting query. See the ServiceManager help for more information about multi-company mode and
Mandanten.

Youmust complete the following tasks from your ServiceManager system to enablemulti-tenancy
support for the integration.

1. Start the process schedule.
See "How to Start the Schedule Process " on the next page.

2. Configure the ServiceManager System Information Record and IntegrationManager.
See "How to Configure the ServiceManager System Information Record and Integration
Manager" on the next page.

3. Add tenant-specific UCMDB ID and password values to company records (optional).
See "How to Add Tenant-Specific UCMDB User ID and Password Values" on page 116.

4. Add UCMDB Customer ID values to existing company records.
See "How to Add UCMDB Customer ID values to Existing Companies" on page 116.

5. Synchronize existing company records with UCMDB.
See "How to Synchronize Existing Companies from ServiceManager to UCMDB" on page 117.

6. Verify that ServiceManager synchronized company records with UCMDB (optional).
See "How to View Whether Company Information Is in UCMDB" on page 118.

7. Resynchronize existing company records with UCMDB (as needed).
See "How to Resynchronize an Existing Company with UCMDB" on page 119.

8. Inactivate company records you do not want to be part of the integration (as needed).
See "How to Inactivate a Synchronized Company" on page 119.

9. Reactivate inactive company records you want to be part of the integration (as needed).
See "How to Reactivate an Inactive Company" on page 120
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10. Add tenant-specific DEM rules.
See "How to Add Tenant-Specific DEM Rules" on page 121.

How to Start the Schedule Process
This integration needs the problem schedule process in order to synchronize company records from
ServiceManager to UCMDB. Make sure that the process is started before you synchronize company
records.

To start the problem schedule process:

1. Log in to ServiceManager as a system administrator.

2. From the System Navigator, click System Status.
A list of the currently started schedules is displayed.

3. Click theRefresh Display button to refresh the list.

4. If the problem schedule process is not in the list, perform the following steps:
a. Click theStart Scheduler button.

b. Double-click the problem schedule process.

A message is displayed, indicating that the problem schedule process is started.

How to Configure the Service Manager

System Information Record and Integration

Manager
To enable the integration to support multi-tenancy, youmust provide additional information in the
ServiceManager System Information Record.

To provide additional information in the ServiceManager System Information Record, follow these
steps:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration >Miscellaneous >
System Information Record.
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3. Click theGeneral tab.

4. Enable theRun in Multi-Company Mode option and then click Save.

ServiceManager displays themessage: Information record updated.

5. Click Tailoring > Integration Manager.

6. Click Add.

7. In the Integration Template field, select SMtoUCMDB.

Some fields in the form are automatically populated with a value. The empty fields can be ignored.

8. (Optional) Update theName, Log Level, andDescription fields as needed.

9. Configure the following fields on theUCMDB Server Configuration tab.
a. In theUCMDB web service URL field, type the URL to the synchronize CIs web service

API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

Replace <UCMDB server name>with the host name of your UCMDB server, and replace
<port>with the communications port your UCMDB server uses.

b. In theUser Id andPassword fields, type the user credentials required tomanage CIs on the
UCMDB system. For example, the out-of-the-box administrator credentials are
admin/admin.

c. In theMulti-tenant web service URL field, type the URL to the synchronize company IDs web
service API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/UcmdbManagementService

Replace <UCMDB server name>with the host name of your UCMDB server, and replace
<port>with the communications port your UCMDB server uses.

d. Type the user name and password required to synchronize company IDs on the UCMDB
system. For example, the out-of-the-box system administrator credentials for UCMDB 9.x are
sysadmin/sysadmin.

10. Click Finish.

11. Log out of the ServiceManager system, and log in again with an administrator account.

12. Click System Status > Display Options > All Tasks.

13. Type k in the Command field next to the problem schedule process and click Execute
Commands. Wait a few minutes for the problem schedule process to close.

14. Click Start Scheduler.
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15. Double-click the problem schedule process. The system now supports multi-tenancy for
UCMDB.

How to Add Tenant-Specific UCMDB User ID

and Password Values
You can provide a tenant-specific UCMDB user name and password for ServiceManager to use when
requesting information for the Actual State section. If you provide no credentials, ServiceManager
uses the credentials in the System Information Record for all tenants.

Note: Any credentials you provide in the company record take precedence over credentials you
provide in the System Information Record. The UCMDB UserId and UCMDB Password fields are
available only when you have enabled themulti-tenancy integration.

To add tenant-specific UCMDB user name and password:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.

5. Type the user name you want this company to use to connect to UCMDB in the UCMDB UserId
field.

6. Type the password for the UCMDB user name in the UCMDB Password field.

7. Click Save.

8. Repeat step 3 through step 7 for each company for which you want to provide credentials.

How to Add UCMDB Customer ID values to

Existing Companies
You can use the following steps to add a UCMDB Customer ID value to your existing ServiceManager
company records.
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1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.

5. Type a numeric value in the UCMDB Customer ID field for this company.

6. Click Save.

7. ServiceManager prompts to confirm that you want to synchronize the record with UCMDB. Click
Yes if you want to synchronize the company now, or click No if you want synchronize the
company later.

8. Click Next to go to the next company in the record list.

9. Repeat step 5 through step 8 for each company in the record list.

How to Synchronize Existing Companies

from Service Manager to UCMDB
Your ServiceManager systemmay already contain company records that you want to use with the
multi-tenancy integration.

If you update any field in a company record that has not yet been synchronized to UCMDB, Service
Manager prompts whether you want to synchronize the company to UCMDB.

Note: ServiceManager will not prompt you to synchronize the company record if you have
disabled the option to show the company inmulti-company lists, or if there is a pending schedule
record associated with the company. See "How to Inactivate a Synchronized Company" on
page 119 for more information.

This task includes the following steps:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.
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5. Select a company record to update.

6. Update the company record.

7. Click Save. ServiceManager prompts you to confirm that you want to synchronize the record with
UCMDB.

Note: ServiceManager saves the company record regardless of your synchronization
choice.

How to View Whether Company Information

Is in UCMDB
When you enable themulti-tenancy integration, ServiceManager displays a read-only field in each
company record that indicates whether or not the UCMDB Customer ID has been synchronized with
your UCMDB system.

Note: The UCMDB Customer ID field is visible only when you enable themulti-tenant UCMDB
integration.

To view whether company information is in UCMDB:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.

5. Review the status of theSynched with UCMDB field.
If the check box is checked, then ServiceManager has already synchronized the company ID with
your UCMDB system. If the check box is unchecked, then ServiceManager has yet to add this
company to your UCMDB system.

Note: Formore information about synchronization failures, see "Schedule Records" on
page 107.
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How to Resynchronize an Existing Company

with UCMDB
ServiceManager provides you ameans to resynchronize company records with your UCMDB system
in case you lose UCMDB data for some reason. For example, youmight intentionally remove UCMDB
data during integration testing, or youmight need to recover data after a disaster. You can force Service
Manager to synchronize companies with your UCMDB system with the Re-synch with UCMDB option.

To resynchronize an existing company with UCMDB:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.

5. Select a company record to synchronize.

6. Click theRe-synch button next to theSynched with UCMDB check box.

Note: TheRe-synch button is available only from company records that have already been
synchronized with UCMDB and have theSynched with UCMDB check box checked. If your
UCMDB system already has a company with this ID value, it will ignore the resynchronization
request. ServiceManager will also ignore a resynchronization request if there is an existing
schedule record to resynchronize the company with UCMDB. In this case, it displays the
message “A schedule record has already been added to re-synch this company with
UCMDB.”

How to Inactivate a Synchronized Company
After you have synchronized a company record with UCMDB you can no longer delete the record.
Instead, you can inactivate a company record, which causes the UCMDB system to cease all further
CI updates for the company. Any existing CI data for the company remains in the UCMDB system
associated with the inactive UCMDB Customer ID, but both the company and any associated CIs will
no longer be visible from the UCMDB system.

To inactivate a synchronized company:
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1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.

5. Select a company record to inactivate.

6. Select No from Show Company in Multi-Company Lists.

7. Click Save.

8. If this company was previously synchronized with UCMDB, ServiceManager prompts you to
confirm the inactivation.

9. Click Yes to confirm the inactivation orNo to cancel your changes.

How to Reactivate an Inactive Company
You can reactivate any inactive companies on your ServiceManager system to include them in the
multi-tenancy integration. Youmust also synchronize the company with UCMDB for UCMDB to
process any CI updates for this company.

To reactivate an inactive company:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the search
form blank to search all company records.

4. Click Search.

5. Select a company record to reactivate.

6. Select Yes from Show Company in Multi-Company Lists.

7. Click Save. ServiceManager prompts you to reactivate the company with UCMDB.

8. Click Yes. ServiceManager creates a schedule record to reactivate the company.
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How to Add Tenant-Specific DEM Rules
You can use the condition field to create DEM rules that are specific to a particular tenant in amulti-
tenancy UCMDB-SM integration. For example, one tenant may want to add CIs directly to Service
Manager while another tenant may want to open changes for each CI. The following sample DEM rules
illustrate how to accomplish this.

DEM rule Id Action on new CI Condition

ucmdbNode_advantage Add CI company in $L.file="advantage"

ucmdbNode_hp Create change company in $L.file="HP"

Tenant-specific DEM rules

Tip: It is a best practice to create a separate DEM rule for each tenant.
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Chapter 5: Standards and Best
Practices
This chapter provides best practices for using the integration.

UCMDB-SM Configuration Best Practices 122

Frequently AskedQuestions 135

UCMDB-SM Configuration Best Practices
This section provides best practices and recommendations for successfully implementing this
integration in various environments. This section provides you with valuable understandings and
techniques that will enhance the UCMDB-SM integration as well as solve common problems by
providing solutions and workarounds to these issues. These practices and recommendations may vary
slightly according to each implementation, as the specific system requirements and settings alter per
system environment.

This section includes:

l "Bi-Directional Data Synchronization Recommendations" on page 124

l "Push Scheduling Recommendations" on page 125

l "Push in Clustered Environments" on page 127

l "Initial Load Configurations" on page 129

l "How to Configure Differential or Delta Load DEMRules" on page 134

l "Fault Detection and Recovery for Push" on page 135

l "How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 135

Centralized CI Type Management
The ServiceManager EnhancedGeneric Adapter allows centralized CI typemanagement. Centralized
CI typemanagement enables you tomanage CI types from UCMDB without the need to domuch
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tailoring work on the ServiceManager (SM) side. You can then synchronize CIs from UCMDB to
SM through data push.

Managing Out-Of-the-Box CI Types

ServiceManager and UCMDB provide out-of-the-box CI types, as well as mapping files for them. To
modify an out-of-the-box CI type (for example, adding new attributes according to your business
needs), you only need to open the Visual Mapping tool, manually add new attributes to this CI type, and
then apply the update without leaving UCMDB. The new attribute will be automatically added to the
relevant web service object on the SM side.

Managing New Custom CI Types

To add a new CI type according to your business needs, you only need to add a new CI type and create
a TQL query in UCMDB, and then create amatching SM CI type by using the Visual Mapping Tool
without the need to leave UCMDB.

When you create a new SM CI type in the UCMDB Visual Mapping Tool interface, all relevant SM
objects (DBDICT, JoinDef, Web Service API, DEM Rule, and so on) for the new CI type are
automatically created on the SM side, except the format and icon (the new CI type uses the
configurationItem format by default).

Note: The population feature enables you to synchronize CIs from SM to UCMDB. For
information about the circumstances under which you need to use the population feature, see
"When Do I Need the Population Feature?" on page 139.

Visual Mapping Tool
The UCMDB generic adapter framework comes with a Visual Mapping tool, which provides a graphic
user interface for you to configure value and field mappings for complex data push or population
configurations.

The following table describes the panes of this graphic user interface.

Pane Description

Local Query Displays a hierarchical tree structure of the local TQL query in the CMDB.

Local Query
Attributes

This is the Attributes pane for the Local Query pane. It displays attributes of a local
integration TQL query.

Visual
Mapping

Allows you to establishmapping for items you select from the Local Query pane and
the External Class Model pane through a drag and drop.
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Pane Description

XMLEditor Allows to you edit XML mapping files in a text editor.

External
Class Model

Displays a hierarchical tree structure of the external class model. For the UCMDB-
SM integration, this pane displays supported CI types from the ServiceManager
(SM) side.

External
Class Model
Attributes

The Attributes pane for the External Class Model pane displays attributes of an
external class model. For the UCMDB-SM integration, this pane displays attributes
from the SM side.

Bi-Directional Data Synchronization

Recommendations
UCMDB-SM integration supports bi-directional data synchronization between UCMDB and Service
Manager (SM). We recommend that you follow the following best practices to avoid unnecessary
problems due to improper use of the data push and population features:

l For CIs/CI Relationships that UCMDB can automatically discover, use UCMDB as the data
source. Do not make changes to them in ServiceManager; instead, always let UCMDB discover
their changes and push the changes to SM.

l For CIs/CI Relationships that UCMDB cannot automatically discover, use SM as the data source.
Do not make changes to them in UCMDB; instead, always make changes to them in SM and
populate the changes to UCMDB.

l For CIs/CI Relationships that are already created in SM and UCMDB can automatically discover,
run a one-time population to synchronize them to UCMDB, and then use UCMDB as their data
source.

Caution: Problems like the followingmay occur if you do not follow these best practices:

Problem 1:

[Population Adapter] After CIs/CI Relationships are pushed from UCMDB, if you directly make
changes in SM to these records without ever populating them back to UCMDB first, the changes
may not be populated to UCMDB.

Workaround:
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Changing these UCMDB records in SM is not recommended; however if you need to do so you
can do the following to solve this issue: After the records are pushed to SM, populate them back to
UCMDB first beforemaking any changes to them in SM. This way the changes can then be
populated to UCMDB.

Problem 2:

[Population Adapter] After a Composition relationship between a Node CI (node 1) and Running
Software CI is pushed to SM, if you change the upstream CI of the relationship from node 1 to
node 2 in SM and then run a change population to populate this change, the Running Software CI
will be removed in UCMDB.

Workaround:

It is recommended that you remove the running software in UCMDB and create a new one instead
of directly replacing the container of the running software in SM. If you cannot avoid doing so, do
the following:

After you change the upstream CI of the relationship from node 1 to node 2, do not directly run the
change population. Follow these steps to avoid this issue:

1. Update the Running Software CI in SM (or simply save it to mark it as updated).

2. Run a Running Software CI change population. This will create a new Composition
relationship between node 2 and this Running Software CI.

3. Run a delta population to synchronize the relationship change to UCMDB. The relationship
between node 1 and the Running Software CI will be removed, and the new relationship
created in step 2 will remain.

If you have run a delta population after changing the upstream CI of the relationship from node 1 to
node 2, and as a result the Running Software CI has been removed in UCMDB, follow these steps
to solve this issue:

1. Update the Running Software CI in SM (or simply save it to mark it as updated).

2. Run a Running Software CI change population. This will create the Running Software CI, and
a new Composition relationship between node 2 and this Running Software CI.

Push Scheduling Recommendations
Push jobs are run using twomainmethods, the first of which is manually executing the push job and the
second is scheduling the push job.
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All push jobs can potentially produce a strain on the UCMDB and SM systems; We recommend that
you adhere to the following guidelines.

Scheduler time frames
It is important for you to understand the function of the Scheduler “time frame” concept. Running push
jobs creates an increase in system activity andmay affect application responsiveness. In order to
enable users to effectively interact with applications We recommend the following guidelines:

In order to reduce system strain, schedule the UCMDB to SM push to run at non-peak usage hours,
preferably when system usage is at aminimum.

Scheduler frequency
It is important to be aware of the business requirements when configuring the schedule frequency. The
scheduler frequency depends on infrastructure environment changes that must be synchronized
between UCMDB and SM.

Define the scheduling frequency based on the business requirements for consuming up-to-date CI
information. Most implementations require a daily update. When scheduling small IT systems that are
prone to frequent changes, the scheduling frequency may need to be increased.

Push Job dependencies
UCMDB Push Jobs do not support dependencies between each other. Each “Push Job” is considered
a separate task and users cannot define job dependencies. For example, that one job is dependent on
another or upon completion before the next job is run.

It is important that both CI queries and their dependent Relationship queries exist in the same Job in
order to avoid relationships not being pushed to ServiceManager. You can change the position of each
query in the list to define an appropriate execution sequence. See the following figure for an example.
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Push in Clustered Environments
A clustered SM environment is comprised of multiple servlets running in parallel with a load balancer
that dispatches user requests to any available servlet. Youmust configure the UCMDB-SM integration
to point to a specific servlet and not to the SM loadBalancer. In order to perform this, youmust first
create a dedicated web service listener.

This section includes:

l "DedicatedWeb Services" below

l "Step-by-Step Cluster Configuration Process" on the next page

l "Connecting toMultiple SM Processes" on page 129

Dedicated Web Services
A ServiceManager system configured for vertical or horizontal scaling uses a load balancer to redirect
client connection requests to an available SM process. However, most Web Services clients cannot
handle a redirect request and will fail if they use the SM load balancer as the endpoint URL.

We recommend creating one or more SM processes dedicated toWeb Services requests. The user
must configure the relevant external web service clients to connect directly to the dedicated Service
Manager processes.
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Step-by-Step Cluster Configuration Process
This section describes the steps to configure a cluster environment for the integration.

How to ConfigureWebClients
To configure the relevant external web clients:

1. Stop the ServiceManager service.

2. Open the sm.cfg file, and create a dedicated SM process to listen forWeb Services requests
using the -debugnode parameter.
The following entries create a dedicated process listening on ports 13085 and 13445.

Explanation

The code excerpt illustrates the various settings for each of the SM process listeners (web
services) that enable SM clients to connect to the SM service.

Line 01 defines the load balancer port (13080).

Lines 02 and 03 define the SM ports to which non-dedicated SM clients are redirected by the SM
load balancer.

Line 04 defines the debugnode port that is utilized by the dedicated SM clients.

Note: Debugnode parameter

The debugnode parameter tells the SM load balancer not to forward any client connection requests
to this ServiceManager process. Only clients that directly connect to the process can access this
port.

How to Configure the Debugnode
To configure the debugnode:

ServiceManagerEnhancedAdapter9.41 User Guide
UCMDB-SM Configuration Best Practices

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 128 of 241



1. Start the SM service.

2. Configure any external web service clients to connect directly to the SM processes running in
debugnode. When performing an integration using UCMDB, the ServiceManager Adapter for SM
should be configured to connect to the debugnode port.
For example, for normal connections set the endpoint URL to:

http://<fully qualified host name>:13085/SM/9/rest/<Service Name>

and for SSL-encrypted connections set the URL to:

https://<fully qualified host name>:13445/SM/9/rest/<Service Name>

These clients may include UCMDB (for push purposes), Connect-It, and additional applications.

Connecting to Multiple SM Processes
If you want to improve performance, you can connect to multiple ServiceManager processes. The
integration supports both ServiceManager vertical and horizontal load balancer environments.

You can createmore than one SM process that is dedicated toWeb Services requests, and configure
theURL Override field of the integration point with the dedicated SM processes. This field value (if
any) overrides the Hostname/IP and Port settings.

The following is an example value of this field, which connects two SM processes:

http://<fully qualified host name1>:13080/SM/9/rest;http://<fully qualified host
name2>:13082/SM/9/rest

Initial Load Configurations
Before the configuration process can begin, youmust first assess the amount of CI and relationship
data to be transferred from UCMDB to SM and ascertain the iteration process that is required based on
the volume.

Youmust first assess whether or not all of the data can be pushed in a single iteration. This is
ascertained by the amount of data that is included in the push queries and the amount of time you have
to push this data.

This section includes:
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l "Push Performance in a Single-Threaded Environment" below

l "ImplementingMulti-Threading" on the next page

l "Push Performance inMulti-Threaded Environments" on page 132

l "Push Performance inMultiple SM Processes Environments" on page 132

l "How to Set up SM DEMRules for Initial Loads" on page 133

Note: The performance data presented in this document is based on tests that were performed at
Micro Focus and is provided for reference only. The integration performancemay significantly
differ in your environment depending on your hardware configuration.

Push Performance in a Single-Threaded

Environment
The Push of 22,500 UCMDB root CIs (roots in queries) and/or Relationships in a single-threaded
environment takes about an hour and is performed in a linear fashion. See the following table.

Number of root CIs/CI Relationships Pushed
per Hour Multi-Threading Settings in sm.properties

22,500 number.of.concurent.sending.threads=1

min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

recommended.min.cis.per.chunk=50

Performance data in a single-threaded environment

To view or edit the sm.properties file in UCMDB, navigate toData Flow Management > Adapter
Management > ServiceManagerEnhancedAdapter9.41 > Configuration Files > sm.properties.

Number of Root CIs and Relationships/22,500

The push time (in hours) in any given environment is calculated as follows:

If the push of a single planned query has the potential of breaching the permitted time frame, the data
must be divided into several queries. Each query must be pushed individually.

This query division is performed by creating several queries, each with different node conditions that
enable data filtering. Once all queries are pushed for the first time, the Initial Load process is complete.
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Note: When applying node conditions to the various ServiceManager queries, youmust make
sure that all of the information is included in the queries, so that all relevant data is copied to
ServiceManager.

Implementing Multi-Threading
In order to improve performance, the ServiceManager adapter utilizes multiple threads for the push of
CI and Relationship data to SM. The following section explains these settings and how to configure
them for maximum performance.

Themulti-threading configuration is defined in the sm.properties file on the UCMDB server. To view or
edit the file in UCMDB, navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41 > Configuration Files > sm.properties.

The following are examplemulti-threading definitions in the sm.properties file:

01 number.of.concurrent.sending.threads=6

02 min.objects.for.concurrent.sending=50

03 number.of.chunks.per.thread=3

04 recommended.min.cis.per.chunk=50

Explanation

The code excerpt illustrates the relevant multi threading settings on the UCMDB server.

l Line 01 defines the number of parallel threads UCMDB will open to SM for CI push. Setting this
parameter to 1 disables multi-threading, while a values of 2 or higher enables multi-threading.

l Line 02 defines theminimum number of SM objects needed to usemultiple threads as opposed to a
single thread.

l Line 03 defines the number of chunks per thread. This numbermultiplied by the number of threads
gives you the total number of CI data chunks.

l Line 04 defines the recommendedminimum number of CIs per CI data chunk.

The total number of chunks = number.of.chunks.per.thread * number.of.concurrent.sending.threads

The integration implements a queuemechanism as follows:

The data passed from UCMDB to SM is divided into equal chunks, and these chunks are placed in a
queue.
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Each available thread pulls the next chunk from the queue until all threads are available. Once this
process has completed, the push is complete.

Themechanism is designed tominimize idle time of each thread. As each thread processes its chunk
in parallel, some threads may finish before others and it is inefficient for them to wait for each other.

Caution: Defining too many threads

It is ineffective to over-increase the number of threads as this causes the SM server to overload. In
enterprise environments where the SM server processing the push data is very robust the number
of threads can be increased to 10 and in some cases even 20; however, youmust take into
account that increasing the number of threads raises CPU usage on the SM server during push,
whichmay reduce application performance.

Push Performance in Multi-Threaded

Environments
The push of 60,000 UCMDB root CIs (roots in queries) and/or Relationships in an out-of-the-box multi-
threaded environment takes about an hour and is performed in a linear fashion. See the following table.

Number of Root CIs/Relationships Pushed
per Hour

Multi-Threading Settings in sm.properties
(Default)

60,000 number.of.concurrent.sending.threads=6

min.objects.for.concurrent.sending=50

number.of.chunks.per.thread=3

recommended.min.cis.per.chunk=50

Performance Data in an Out-Of-The-Box Multi-Threaded Environment

The push time (in hours) in any given environment is calculated as follows:

Number of Root CIs and Relationships/60,000

Push Performance in Multiple SM Processes

Environments
The Push of 190,000 UCMDB root CIs (roots in queries) and/or Relationships in amulti-threaded
environment with multiple SM processes takes about an hour and is performed in a linear fashion. See
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the following table:

Number of root
CIs/Relationships
pushed per hour SM processes

Multi-threading settings in sm.properties
(default)

160,000 2 server hosts, with
each host running 4
processes

number.of.concurrent.sending.threads=60

min.objects.for.concurrent.sending=50

number.of.chunks.per.thread=3

recommended.min.cis.per.chunk=50

Data Push Chunk Size = 4000 (in Integration
Settings in UCMDB)

Performance data in a multiple SM processes environment

Formore information about definingmultiple SM processes for the integration, see "How to Create an
Integration Point in UCMDB" on page 69.

The push time (in hours) in any given environment is calculated as follows:

Number of Root CIs and Relationships/160,000

How to Set up SM DEMRules for Initial Loads
SMDiscovered Event Manager Rules (DEM Rules) enable the user to define the appropriate action to
take for each event type that is reported to SM.

Each CI and relationship record pushed from UCMDB to SM is analyzed against the existing SM
records and open Change requests. SM rules define the appropriate action to be taken for each type of
CI data update that is sent to SM.

To view or update the SM Discovered Event Manager Rules:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Press ENTER or click theSearch button.
A list of all the Discovered Event Manager Rules is displayed. Each rule is usually linked to a CI
Type or a subset of CIs of the same type.

4. Click the individual CI Discovered Event Manager Rule to view its details.

To set up DEMRules for initial loads:
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Tip: When performing an Initial Loadwe recommend setting the SM Discovered Event Manager
Rules to add newly reported CIs as described below. This minimizes the “noise” of an Initial Load,
which could potentially create tens of thousands of Changes or Incidents.

For each of the Discovered Event Manager Rules, perform the following steps:

1. Select the relevant Discovered Event Manager Rule.

2. Go to theAction if matching record does not exist section, select theAdd the record option.

3. In theAction if record does not exist but unexpected data discovered section, select the
Log Results and Update Record option.

4. In theAction if record is to be deleted section, select theDelete Record option.

5. Save the Discovered Event Manager Rule record.

How to Configure Differential or Delta Load

DEM Rules
Tip: Once the “Initial Load” or “Data Load” of the CI data is completedwe recommend applying
Differential or Delta Load settings. These settings apply to all data loaded from UCMDB to SM.

These loads send only updates regardingmodifications discovered in the IT infrastructure from
UCMDB to SM.

To set up the SM DEMRules for Differential or Delta Loads:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Press Enter or click theSearch button.
A list of all the Discovered Event Manager Rules in SM is displayed.

4. For each of the Discovered Event Manager Rules, perform the following steps:
a. Select the relevant Discovered Event Manager Rule.

b. In theAction if matching record does not exist section, select the appropriate action
required for each newly detected CI. If uncertain, select theAdd the record option.

c. In theAction if record does exist but unexpected data discovered section, select the
appropriate action for each CI that was modified, resulting in an unexpected or incorrect result.
The recommended best practice is to select theOpen a Change option.
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d. In theAction if record is to be deleted section, select the appropriate action required for
each CI that was removed. The recommended best practice is to select theDelete Record
option for CI Relationships, and select theUpdate record to the selected status option for
CIs.

e. Save the Discovered Event Manager Rule record.

Fault Detection and Recovery for Push
Universal CMDB has provided a fault detection and recovery mechanism since version 9.05: individual
CI failures no longer cause the entire push to fail, and you can review all failed CIs in the Universal
CMDB studio and then re-push them.

How to Enable Lightweight Single Sign-On

(LW-SSO) Configuration
You can enable LW-SSO for the integration so that users can directly view UCMDB CI records from
the ServiceManager web client by clicking theView in UCMDB button, without providing a UCMDB
username and password.

Note: LW-SSO is not supported for the ServiceManagerWindows client.

To enable LW-SSO for the integration:

1. For each ServiceManager user account that needs LW-SSO, create a user account in UCMDB
with the same username. The passwords in the two systems can be different.

2. Enable LW-SSO in the ServiceManagerWeb tier. For details, see theConfigure LW-SSO in the
ServiceManagerWeb tier topic in the ServiceManager help.

3. Enable LW-SSO in UCMDB. For details, see theUniversal CMDB Deployment Guide.

Frequently Asked Questions
This section provides answers to frequently asked questions about the UCMDB-SM integration.

This section includes:
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l "When Is a New CI Created in ServiceManager? " below

l "Can I Analyze the Reason for a CI Deletion in SM?" on the next page

l "How Do I Monitor Relationship Changes Between UCMDB and SM?" on the next page

l "What Kinds of Relationships are Pushed from UCMDB to SM?" on page 138

l "What is a Root CI Node?" on page 138

l "What Is a Root Relationship?" on page 138

l "What is the “Virtual-Compound” Relationship Type Used in a UCMDB-SM Integration Query?" on
page 139

l "When Do I Need the Population Feature?" on page 139

l "Can I Populate Physically Deleted CIs from SM to UCMDB?" on page 140

l "How Do I Keep theOutage Dependency Setting of a CI Relationship in SM?" on page 140

l "How Do I Create an XMLConfiguration File?" on page 142

l "How Do I Use the Load Fields Button to AddMultiple Managed Fields?" on page 143

l "What Is the Purpose of the <container> Element in the Population Configuration File
(smPopConf.xml)?" on page 144

l "Can I Populate Sub-Item Deletions?" on page 144

l "What Happens if a Population Job Failed or Completed?" on page 145

When Is a New CI Created in Service

Manager?
CIs are created in SM under the following circumstances:

l A CI is manually added to SM through the ConfigurationManagement module or the Request
module.

l UCMDB reports a newly discovered CI according to the following:
o When a new CI is reported and the Discovered Event Manager Rules are set to Add the

Record.

o When a new CI is reported, the Discovered Event Manager Rules are set toOpen an Incident
and the Incident has been closed.

o When a new CI is reported, the Discovered Event Manager Rules are set toOpen a Change
and the Change has been verified.
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Can I Analyze the Reason for a CI Deletion in

SM?
No.

SM opens a change request on the deleted CI and includes the following information:

“Delete event for CI “CI Name” triggered by discovery”.

Workaround

An SM change request does not contain a description of the reason for deletion, however it is possible
to extract specific information about CI deletions from the UCMDB History Database. UCMDB data
provides information about the user or the discovery pattern that initiated the CI deletion.

How Do I Monitor Relationship Changes

Between UCMDB and SM?
To understand the relationship change in SM, a distinctionmust bemade between the various types of
Relationship Changes:

l The second endpoint of the relationship has Changed, so instead of CI X being linked to CI Y
through a relationship, now CI X is related to CI Z.

l An attribute of the relationship has changed.

The first type of Relationship change is supported by the UCMDB-SM integration, therefore, such
“Relationship Changes” can either invoke CI relationship updates, or perform the creation of Incidents
or Changes, which are then reviewed andmonitored.

The second is also supported, but it is not covered out-of-the-box; you can configure the Universal
CMDB query to expose such attributes of the relationship, and configure the ServiceManagerWSDL
to expose themapped field, and then configure the adapter mapping configuration in the XML and
Groovy. However such a Relationship Attribute Change cannot perform the creation of Incidents or
Changes, and only supports invoking CI relationship updates directly.
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What Kinds of Relationships are Pushed from

UCMDB to SM?
Any kinds of relationships are pushed from UCMDB to SM under the following conditions:

l The relationship appears in a PushQuery located in theService Manager > Push folder in the
UCMDB Query Manager.

l The relationship is namedRoot in the PushQuery.

l The relationship is mapped to an appropriate target in SM in the UCMDB configuration files (XML
andGroovy files).

The out-of-the-box relationships that are pushed from UCMDB to SM are relationships between two
CIs such as:

l Between Business Services and Applications;

l Between Business Service and Host;

l Between an Application and a Network Component; or

l Between Host, Network Components and Printers.

What is a Root CI Node?
A Root node is a TQL query node that represents the CI type that is created through push to SM from
the TQL query structure. The rest of the TQL query structure contains information that can be
incorporated within the Root CI type and is used to enrich the record in SM with additional information
and or attributes.

What Is a Root Relationship?
A Root relationship is a relationship within a query and created in SM through push. It represents a
relationship between two Root CIs. Only the relationships marked with Root are pushed to SM.
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What is the “Virtual-Compound” Relationship

Type Used in a UCMDB-SM Integration

Query?
Whenmore than two UCMDB CI entities are connected in series, the “Virtual-Compound” represents
the relationship between the first and last entities. This is a virtual relationship, as no physical
representation exists.

The “Virtual-Compound” relationship type is a relationship that links two CI type entities that have a
logical relationship. See the following figure.

Explanation

The illustration shows an example of a Virtual-Compound relationship. The relationship in SM is
created directly between the Host and the Business Service.

When Do I Need the Population Feature?
You need the population feature under any of the following circumstances:

l You have donemodeling in SM, especially when you are in the planning and design phases, and
you want your models to be reflected in UCMDB;

l Youwant to implement the UCMDB-SM integration, however you have already invested in your SM
CMDB and do not want to lose that investment;

l Youwant to continue tomaintain some parts of the SM CMDB while maturing your
UCMDB/Discovery implementation.
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Can I Populate Physically Deleted CIs from

SM to UCMDB?
No.

Physical deletions of CIs are allowed in SM, but SM cannot get such “deletion changes” and the
population feature will not synchronize such changes to UCMDB.

Physical deletions of CIs can be considered as exceptions, which occur only after you create CIs by
mistake. Normally, you delete a CI by setting its status to something likeRetired/Consumed. If such
CIs have been populated to UCMDB, it is your responsibility to remove themmanually from UCMDB.

How Do I Keep the Outage Dependency

Setting of a CI Relationship in SM?
Out-of-the-box, CI relationships that are pushed from UCMDB to SM do not have outage dependency
information by default. If you need such information, you can set the DEM rule of the CI Relationship
WSDL as follows:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Open the ucmdbRelationship record.

4. On the Rules tab, select Add the record, and set dependency as true.
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This will set the Outage Dependency of each CI Relationship to true, and set the number of
dependent downstream CIs to 1 (because UCMDB supports only one-to-one relationships).

If you want to set outage dependency only for some relationships, for example, if you want to configure
outage dependency for relationships that start from Business Service, you can configure the adapter
configuration file (XML) andWSDL definition; you can also configure outage dependency per
relationship type (UCMDB query).

1. In theWSDL definition, expose fields outage.dependency and outage.threshold.

2. In the XML file, set the exposed outage fields. For example, if you want to set the outage
dependency to true and threshold to 1 for Business Service relationships, you simply need to
change the XMLmapping fileSM Business Service Relations Push 2.0.xml. In the XML
mapping file, use the following OutageDependency and OutageThreadhold settings:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<integration>

<info>
<source name="UCMDB" vendor="HP" version="10.20"/>
<target name="SM" vendor="HP" version="9.40"/>

</info>
<import>

<scriptFile path="mappings.scripts.SMPushFunctions"/>
</import>
<target_entities>

<source_instance root-element-name="Root_directly" query-name="EA_SM
Business Service Relations Push">

<target_entity name="Relationship">
<target_mapping datatype="STRING" name="RelationshipType"

value="SMPushFunctions.getDisplayName(Root_directly['element_
type'],ClassModel)"/>

<target_mapping datatype="STRING" name="ParentCI"
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value="SMPushFunctions.getEndId(OutputCI.getExternalId().getEnd1Id())"/>
<target_mapping datatype="STRING_LIST" name="ChildCIs"

value="[SMPushFunctions.getEndId(OutputCI.getExternalId().getEnd2Id())]"/>

<target_mapping datatype="BOOLEAN" name="OutageDependency"
value="true"/>

<target_mapping datatype="NUMBER" name="OutageThreadhold"
value="1"/>

</target_entity>
</source_instance>

</target_entities>
</integration>

How Do I Create an XML Configuration File?
You create an XML configuration file in Adapter Management. You can copy the content of an existing
XML configuration file to the new file and thenmake necessary edits.

To create an XML configuration file:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management.
ServiceManagerEnhancedAdapter9.41 > Configuration Files.

3. Click theCreate new resource icon .

4. Select New Configuration File.

5. Enter a name for the file. The file name should use this format: <AdapterID>/mappings/<Synch
Type>/<filename>. For example:
ServiceManagerEnhancedAdapter9.41/mappings/push/SM Computer Push

2.0.xml.

6. Click OK. A message is displayed, asking if you want to open the file in the Visual Mapping tool
editor.

7. Click Yes orNo to continue.
UCMDB creates the new XML configuration file in the Configuration Files folder of the adapter.

8. Copy the content of an existing XML configuration file to the new file.

9. Make necessary edits to the new file.

Caution: Invalid XML
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When removing XML elements from an XML file, keep inmind that the remaining elements must
constitute a valid XML file, which will be used to translate the UCMDB Query Definition.

How Do I Use the Load Fields Button to Add

Multiple Managed Fields?
ServiceManager stores a list of managed fields in the ucmdbIntegration web service, which consists
of a number of web services objects. You can addmoremanaged fields to DEMRules so that Service
Manager canmonitor changes inmore CI attributes in UCMDB and trigger the actions defined in
relevant DEM Rules.

You canmanually addmanaged fields that are exposed in associatedWSDL definitions to DEMRules;
however, you can use the Load Fields button to automatically (and therefore correctly) addmanaged
fields to DEMRules.

1. Click theManaged Fields tab of the DEMRule.

2. Click the Load Fields button.

3. If the table (in the Table Name field) of the DEM rule record has only oneWSDL definition
associated to it, all fields exposed in theWSDL definition are immediately added to theManaged
Fields list.
A message is displayed: <XX> new fields loaded.

4. If the table has more than oneWSDL definition associated to it, theManaged Fields Importing
wizard opens, and a list of WSDL definitions (ucmdbIntegration web service objects) is displayed.
a. Select one or more objects, and click Next. All new fields that can be added from the selected

web service objects are displayed.

b. If you want to add all of the fields, click Finish; if you want to ignore some of them, change
their Action value from Add to Ignore, and then click Finish.
A message is displayed: <XX> new fields loaded.

5. Save the DEMRule record.
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What Is the Purpose of the <container>

Element in the Population Configuration File

(smPopConf.xml)?
Out-of-the-box, the smPopConf.xml file has a container element.

<tql name="SM RunningSoftware Population 2.0" citype="running_software">
<request type="Retrieve" dataType="ci"
resourceCollectionName="ucmdbRunningSoftwares"
resourceName="ucmdbRunningSoftware"
basicQueryCondition="type=&quot;runningsoftware&quot;"
fullQueryCondition="istatus~=&quot;Retired/Consumed&quot;"
changedCreationQueryCondition="created.by.date&gt;'{fromDate}' and

istatus~=&quot;Retired/Consumed&quot;"
changedUpdateQueryCondition="created.by.date&lt;='{fromDate}' and

devicemodtime&gt;'{fromDate}' and istatus~=&quot;Retired/Consumed&quot;"
changedDeletionQueryCondition="devicemodtime&gt;'{fromDate}' and

istatus=&quot;Retired/Consumed&quot;"/>
<container tql="SM Computer Population 2.0"
keyFields="CIIdentifier"
linkTql="SM Computer Composition Software 2.0"
linkRetrieveCondition="downstreamci.logical.name=&quot;$$$&quot; and

upstreamci.type=&quot;computer&quot; and
downstreamci.type=&quot;runningsoftware&quot; and
relationship.subtype=&quot;Composition&quot;"

linkRetrieveConditionKey="CIIdentifier"
linkValueFields="upstreamci.logical.name"/>

</tql>

l In UCMDB, RunningSoftware CIs must exist together with a Root Container (Node); however,
ServiceManager allows RunningSoftware CIs without a Node.

l The integration adapter synchronizes CIs and Relationships separately; when populating a
RunningSoftware CI, the integration has no chance to check if a relationship exists between the CI
and a Node.

With the <container> element, the integration populates RunningSoftware CIs together with a
container.

Can I Populate Sub-Item Deletions?
Yes.
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ServiceManager and UCMDB store CI information in different data structures, and therefore one SM
CI may be synchronized to UCMDB as several CIs. For example, during population, an SM computer
CI record is synchronized to a Node CI in UCMDB, and the computer CI’s attributes to CIs such as IP,
Interface, Location, etc (which are referred to as sub-items of the Node CI.). In this case, the Node CI
is the root CI.

The integration allows you to populate sub-item deletions to UCMDB. For example, if you delete the IP
Address attribute value of a computer, the corresponding IP CI record in UCMDB will be deleted too.

What Happens if a Population Job Failed or

Completed?
When a population job failed

The failure prevents the remaining population tasks from running. The next job run will start from the
last Success time. If pagination occurs (that is, the tasks are divided intomultiple pages), the tasks will
run again and again within the first page from the last “Success” time (once the end of the first page is
reached, no new tasks will be executed).

When a population job completed

When the status of a job is "completed" (but not "completed successfully"), warnings occurred. A
warning does not prevent the remaining population tasks from running. The next job run will run all tasks
again starting from the last Success time. If pagination occurs (the tasks are divided intomultiple
pages), the tasks on all pages will be re-run (including those that successfully completed last time).
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Chapter 6: Tailoring the Integration
You can tailor the UCMDB-SM integration tomeet your business needs by adding or removing
managed CI types, attributes, and relationship types. This chapter describes the integration
architecture and tailoring options for data push, population, and federation.

Integration Architecture 146

Integration Tailoring Options 161

Integration Architecture
Before you tailor the integration, you should understand how the following components of the out-of-the-
box integration work.

l "Integration Class Model" below

l "Integration Queries" below

l "ServiceManagerWeb Services" on page 152

l "ServiceManager Reconciliation Rules" on page 157

l "ServiceManager Discovery Event Manager Rules" on page 158

Integration Class Model
UCMDB 9.x or later no longer uses a private class model of CI types tomanage integration CIs, as
was required in prior versions. Instead, the integration uses the standard UCMDB managed objects
andmaps them to ServiceManager CI types and attributes with queries and transformation files.

Integration Queries
This section describes out-of-the-box queries used for data push, Actual State, and population.
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l "Queries for Push" below

l "Queries for Actual State" on page 149

l "Queries for Population" on page 150

l "Query Requirements" on page 152

Queries for Push
For the push feature, the integration uses a collection of queries to gather CI attribute information from
Universal CMDB and send it to the ServiceManager system.

To access the out-of-the-box data push queries, navigate toModeling >Modeling Studio, select
Queries for Resource Type, and then navigate to theRoot > Integration > Service Manager > Push
folder.

If you want to change what CI types, Relationship types or attributes are part of the integration, you
must also edit the integration queries to support your updated CI types, CI Relationship types and
attributes.

Note: The ServiceManager EnhancedGeneric Adapter has been introduced since UCMDB
version 10.20. This adapter can coexist with an old XSLT adapter. In order to distinguish its
queries from those of an XSLT adapter, all queries of the enhanced adapter are suffixed with 2.0.

Query name Description

SM Local
Printer Push
2.0

This query gathers CI attributes from printer CIs. It also gathers related CI
attributes from the Node CI type.

SM Net Printer
Push 2.0

This query gathers CI attributes from Node CI types whose NodeRole contains
“printer.”

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SMMainframe
Push 2.0

This query gathers CI attributes from the following Node CI types: Mainframe
Logical Partition, andMainframeCPC.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SMMobile
Device Push
2.0

This query gathers CI attributes from Node CI types whose NodeRole contains
“pda_handheld.”

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.
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Query name Description

SMNetwork
Component
Push 2.0

This query gathers CI attributes from Node CI types whose NodeRole contains
router, adsl_modem, appletalk_gateway, bandwith_manager, cable_model, csu_
dsu, ethernet, fddi, firewall, hub, kvm_switch, load_balancer, multicast_enabled_
router, nat_router, token_ring, undefined_network_ component, voice_gateway,
voice_switch, or vpn_gateway.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Cluster
Push 2.0

This query gathers CI attributes from the following Node CI type:
ClusterResourceGroup.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, Location, and
Cluster.

SM Computer
Push 2.0

This query gathers CI attributes from the node CI type with NodeRole containing
“desktop”, “server”, “virtualized_system” or not set. It also gathers related CI
attributes from the following CI types through containers and links: IPAddress,
Interface, CPU, FileSystem, DiskDevice, and Location.

SM Storage
Push 2.0

This query gathers CI attributes from the Node CI type whose NodeRole contains
san_switch, san_gateway, san_router, or whose Display Name is Storage Array.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Running
Software Push
2.0

This query gathers CI attributes from Running Software CIs.

SM Switch
Push 2.0

This query gathers CI attributes from the Node CI type whose NodeRole contains
atm_switch, frame_relay_switch, or lan_switch.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Service
Element Push
2.0

This query gathers CI attributes from the Business Element CI type.

SM Business
Service Push
2.0

This query gathers CI attributes from the Business Service CI type.

SM Layer2
Topology
Relations
Push 2.0

This query gathers relationships between the following components: Two ormore
nodes. The query includes compound relationships because the relationships can
extend through a group.

SM Business This query gathers relationships between the following components:
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Query name Description

Service
Relations
Push 2.0

l Business Service and Running Software CIs

l Business Service and Node CIs

l Two ormore Business Services

The query includes compound relationships because the relationships can extend
through a group.

SM CRG
Relations
Push 2.0

This query gathers relationships between the following components: Node and
Cluster Resource Group CIs.

The query includes compound relationships because the relationships can extend
through a group.

SM Node
Relations
Push 2.0

This query gathers relationships between the following components:

l Node and Printer CIs

l Node and RunningSoftware CIs

The root class of the relationship is composition.

SM
ASM Relations
Push 2.0

This query gathers ASM discovered consumer-provider relationships that point
from a Business Element CI to a Running Software CI.

Note: This query does not support consumer-provider relationships between a
Business Element CI and a Cluster CI.

Note: Towork correctly, this query requires the ASM Enhanced package to
be deployed in UCMDB. This package is already included in UCMDB Content
Pack (CP) 17.

Queries for Actual State
Out-of-the-box, the queries in the following table are used for retrieving CI information from UCMDB to
the Actual State section of the ServiceManager Configuration Item (CI) form. ServiceManager
retrieves CI Actual State information by calling a UCMDB web service that retrieves CI data according
to these queries.

The queries are located in the Integration > SM Query folder in the UCMDB Modeling Studio.

Query name Description

localPrinterExtendedData This query gathers real-time extended information from Printer CIs
in UCMDB.
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Query name Description

applicationExtendedData This query gathers real-time extended information from
RunningSoftware CIs in UCMDB.

businessServiceExtendedData This query gathers real-time extended information from business
service CIs in UCMDB.

hostExtendedData This query gathers real-time extended information (such as Asset,
Party, Location, LogicalVolume, WindowsService, Printer,
InstalledSoftware, FileSystem, IPAddress, Interface, DiskDevice,
and Cpu) from the node CI type in UCMDB.

Queries for Federation
Each generic adapter stores the out-of-box federation queries in the Integration > Service Manager >
Federation folder in theModeling Studio.

For UCMDB 10.20, the generic adapter has defined a large number of out-of-box federation queries.
These queries are for the out-of-the-box CI Types in UCMDB. Due to a technical limitation in
UCMDB 10.20, you still need to define static federation queries for each of your custom CI types. For
information on how to define static federation queries, see theAchieving Data Federation Using the
Generic Adapter section in theMicro Focus Universal CMDB Developer ReferenceGuide.

Starting with UCMDB 10.21, you do not need to create additional static queries. The following out-of-
box static federation queries are used for all CI types:

l SM Incident 2.0

l SM Incident To CI 2.0

l SM Problem 2.0

l SM Problem ToCI 2.0

l SMRFC 2.0

l SMRFC ToCI 2.0

Queries for Population
For CI/CI Relationship population, the integration uses the following queries to save CI/CI Relationship
attribute information to UCMDB.
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Query Name Description

SM Business Service
Population 2.0

Defines the CI store structure of business service CIs.

SM Business
Application
Population 2.0

Defines the CI store structure of Application Service CIs.

SM
Infrastructure Service
Population 2.0

Defines the CI store structure of Infrastructure Service CIs.

SM Running
Software Population
2.0

Defines the CI store structure of running software CIs.

SM Computer
Population 2.0

Defines the CI store structure of computer CIs.

SM CLIP Down Time
Population 2.0

Defines the CI store structure of ScheduledDowntime CIs.

SM Biz Containment
Biz 2.0

This query defines the CI store structure of CI relationships in which a
bizservice CI contains another.

SM Biz Usage Biz
2.0

Defines the CI store structure of CI relationships in which a bizservice CI
uses another.

SM Biz Containment
Computer 2.0

This query defines the CI store structure of CI relationships in which a
bizservice CI contains a computer CI.

SM Biz Containment
Software 2.0

Defines the CI store structure of CI relationships in which a bizservice CI
contains a RunningSoftware CI.

SM Biz Usage
Computer 2.0

Defines the CI store structure of CI relationships in which a bizservice CI
uses a computer CI.

SM Biz Usage
Software 2.0

Defines the CI store structure of CI relationships in which a bizservice CI
uses a RunningSoftware CI.

SM Computer
Connects Computer
2.0

Defines the CI store structure of CI relationships in which a computer CI
connects to another.

SM Computer
Composition
Software 2.0

Defines the CI store structure of CI relationships in which a
RunningSoftware CI is contained within a computer CI and the
RunningSoftware CI cannot exist without the container.

SM CI Connection
Down TimeCI 2.0

Defines the CI store structure of CI relationships in which a
ScheduledDowntime CI connects to an affected CI.
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Query Requirements
The integration requires that any custom queries you createmeet certain formatting conditions. Any
queries that you want to include in the integrationmust meet these conditions:

l To query CIs, a query must contain one CI type labeled Root. The Root node is themain CI that
UCMDB synchronizes. All other CIs are contained CIs of the Root CI.

l To query relationships, a query must contain one or more relationships labeled Root.

l A query must contain only the Root CI and CIs that are directly connected to it. The Root CI is
always the top node of the query hierarchy.

l A query layout cannot have cycles.

l If a query synchronizing relationships has cardinality, it must be cardinality 1...*. Additional
cardinality entries must have anOR condition between them.

l If you want the integration to only synchronize specific CIs, youmust configure the condition on the
query to filter such CIs.

Service Manager Web Services
ServiceManager uses web services messages to get and receive CI information from your UCMDB
system. Out-of-the-box, UCMDB sends more CI attribute information than the ServiceManager
system actually manages. ServiceManager users can view all of the CI attribute information the
UCMDB system sends from the Actual State section of the CI record.

ServiceManager publishes several web services for use by the UCMDB-SM integration. The UCMDB
system uses the web services tomapUCMDB CI types and CI attributes to web services objects that
the ServiceManager system recognizes. You can add UCMDB CI types or CI attributes that you want
ServiceManager to manage by using the Visual Mapping tool, and the tool will automatically update
one or more of these web services to define web service objects.

Managed Fields
Note: Managed fields are used only for the data push feature.

A ServiceManager managed field is a field where the system compares the CI attribute value in the
incoming UCMDB web services message to the value in a ServiceManager CI record. If the values in
the web services message do not match those in the CI record, ServiceManager runs a Discovery
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Event Manager (DEM) rule to determine what action to take. The DEM rule determines which of the
fields that are published as web services objects are fields managed by the integration. Only value
changes inmanaged fields trigger the DEM rule.

The ucmdbIntegration web service consists of a set of web services objects, each of which defines a
list of web service fields. Out-of-the-box, the integration uses only part of them (see theMappings
between ServiceManager web service objects, tables, and DEM rules table), some of them (along with
their relevant DEM Rules) are deprecated and removed (see the Deprecated ucmdbIntegration web
service objects for data push table), and some are used for population or federation (see the
ucmdbIntegration web service objects used for population or federation table).

This web service object Publishes fields from this table And uses this DEM rule ID

Relationship cirelationship ucmdbRelationship

ucmdbRunningSoftware device ucmdbRunningSoftware

ucmdbBusinessService joinbizservice ucmdbBusinessService

ucmdbNode joinnode ucmdbNode

Mappings between Service Manager web service objects, tables, and DEM rules

This web service object Publishes fields from this table Replaced with (object)

ucmdbApplication device ucmdbRunningSoftware

ucmdbComputer ucmdbComputer ucmdbNode

ucmdbNetwork joinnetworkcomponents ucmdbNode

ucmdbPrinter joinofficeelectronics ucmdbNode

Deprecated ucmdbIntegration web service objects for data push

This web service
object

Publishes fields from this
table

And is used
for

Requires a DEM
Rule?

cirelationship1to1 cirelationship1to1 Population No

ucmdbIDPushBack device Population No

UcmdbChange cm3r Federation No

UcmdbChangeTask cm3t Federation No

UcmdbIncident probsummary Federation No

UcmdbProblem rootcause Federation No

ucmdbIntegration web service objects used for population or federation

The following sections list the fields published as web services objects used for data push (see the
Mappings between ServiceManager web service objects, tables, and DEM rules table) and indicate
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whether or not they aremanaged fields in an out-of-the-box ServiceManager system. You can use this
reference to determine if you need to publish a field as a web service object, and also if you need to
create a DEM rule for the object.

Object Name: Relationship

ServiceManager publishes the following fields from the cirelationship table:

Field published as web service
object

Caption used in web service
messages

Is the field a managed
field?

relationship.name RelationshipName

logical.name ParentCI

related.cis ChildCIs Yes

relationship.subtype RelationshipType

Web service and managed fields of the Relationship object

Object Name: ucmdbRunningSoftware

ServiceManager publishes the following fields from the device table:

Field published as web service
object

Caption used in web service
messages

Is the field a managed
field?

ucmdb.id UCMDBId

ci.name ApplicationName

type Type

subtype Subtype

company CompanyId

logical.name CIIdentifier

product.version ProductVersion

vendor Vendor

version Version

ci.name ServiceName Yes

sm.device.display.name DisplayName Yes

Web service and managed fields of the ucmdbRunningSoftware object
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Object Name: ucmdbBusinessService

ServiceManager publishes the following fields from the joinbizservice table:

Field published as web service
object

Caption used in web service
messages

Is the field a managed
field?

ucmdb.id UCMDBId

ci.name ServiceName Yes

type Type

subtype Subtype

company CustomerId

logical.name CIIdentifier

vendor ServiceProvider Yes

sm.device.display.name DisplayName Yes

Web service and managed fields of the ucmdbBusinessService object

Object Name: ucmdbNode

ServiceManager publishes the following fields from the joinnode table.

Field published as web service
object

Caption used in web service
messages

Is the field a managed
field?

ucmdb.id UCMDBId

type Type

subtype Subtype

company CustomerId

logical.name CIIdentifier

default.gateway DefaultGateway Yes

network.name DNSName Yes

building Building Yes

room Room Yes

floor Floor Yes

Web service and managed fields of the ucmdbNode object
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Field published as web service
object

Caption used in web service
messages

Is the field a managed
field?

location Location

addlIPAddr[addlIPAddress] AddlIPAddress Yes

addlIPAddr[addlSubnet] AddlSubnet Yes

addlMacAddress AddlMacAddress Yes

bios.id BIOSId Yes

operating.system OS Yes

os.version OSVersion Yes

physical.mem.total PhysicalMemory Yes

serial.no. SerialNo

vendor Vendor

cpu[cpu.id] CpuID

cpu[cpu.name] CpuName

cpu[cpu.clock.speed] CpuClockSpeed

file.system[mount.point] MountPoint

file.system[disk.type] DiskType

file.system[file.system.type] FilesystemType

file.system[disk.size] DiskSize

asset.tag AssetTag

machine.name HostName Yes

disk.device[model.name] ModelName

disk.device[disk.vendor] DiskVendor

disk.device[disk.name] DiskName

sm.device.display.name DisplayName Yes

isVisualization IsVisualization

istatus AssetStatus

Web service and managed fields of the ucmdbNode object, continued
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Service Manager Reconciliation Rules
ServiceManager reconciliation rules allow the integration to identify CI records in your Service
Manager system that match CIs in your UCMDB system. ServiceManager attempts to reconcile CI
records with every push of CI attributes from your UCMDB system. The integration uses the following
workflow tomatch UCMDB CIs with ServiceManager CIs.

1. The UCMDB system sends a web servicemessage containing the latest CI attribute data to
ServiceManager.

2. ServiceManager scans the web servicemessage for the CI ucmdb.id value.

Note: The ucmdb.id field is displayed in the Actual State Section of the CI form, with a label
of Ucmdb ID.

3. ServiceManager searches for an existing CI record that has the same ucmdb.id value.

4. If ServiceManager finds a CI that has the ucmdb.id value, no reconciliation is needed. Service
Manager compares the UCMDB CI attributes to the ServiceManager managed fields and runs the
appropriate Discovery Event Manager (DEM) rules as needed to update the CI record in Service
Manager.

5. If ServiceManager cannot find a CI that has the ucmdb.id value, it searches for a DEM
reconciliation rule record that is defined for the CI type.

6. If no DEM reconciliation rule record is found, ServiceManager creates the CI record according to
the appropriate DEM rules.

7. If a DEM reconciliation rule record is found, ServiceManager evaluates the rules and appends
(ucmdb.id=NULL or ucmdb.id~=NULL and istatus=”XXXXXX”) to the reconciliation rules in the
backend, where the istatus value is retrieved from the DEM rule for deletion (for example,
Retired/Consumed). If no istatus value is found in the DEM rule, ServiceManager only appends
ucmdb.id=NULL to the reconciliation rules in the backend.

8. If nomatching CI record is found by the reconciliation rules, ServiceManager creates the CI
record according to the appropriate DEM rules.

9. If a matching CI record is found by the reconciliation rules, ServiceManager updates the CI record
according to the appropriate DEM rules

Performance Implications
Because ServiceManager attempts to reconcile CIs with every push, the number of reconciliation
fields you have will affect the integration’s performance. Themore reconciliation rules you have, the
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more searches ServiceManager must perform tomatch CIs. To improve the performance of
reconciliation searches, you should choose reconciliation fields that are unique keys of the underlying
ServiceManager table. For example, if you want to reconcile CI records in the device table, use the
logical.name field as a reconciliation field because it is a unique key. For information about how to
create a reconciliation rule, see "How to Add DEMReconciliation Rules" on page 166.

Dependence on DEMRules
ServiceManager uses theAction if matching record does not existDEM rule whenever it cannot
reconcile CIs. Youmust review the DEM settings and decide if they meet your business standards
prior to the initial push of CIs from UCMDB to ServiceManager. For example, you can have Service
Manager create a change request for every CI in the initial CI push by selecting theOpen a Change
option.

Service Manager Discovery Event Manager

Rules
You only need to create Discovery Event Manager (DEM) rules if you want to accomplish any of the
following custom actions:

l "Change the Conditions UnderWhich a DEMRule Runs" below

l "Change the Action the DEMRule Takes" on the next page

l "Create Custom JavaScript to Open Change or Incident Records" on the next page

Change the Conditions Under Which a DEMRule

Runs
ServiceManager will run a DEM rule only if the condition field evaluates to true. Out-of-the-box, no
DEM rule has a condition statement that restricts when the rule runs, and all the integration DEM rules
will always run by default.

You can update a DEM rule's condition statements if you want to restrict when ServiceManager runs
your DEM rules. For example, adding the following condition to the ucmdbNode DEM rule restricts the
rule to desktop CIs.
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subtype in $L.file="Desktop"

You can also use the condition field to createmultiple DEM rules that apply to the same table name.
For example, the following DEM rules both apply to the joinnode table.

DEM rule Id Table Name Condition

ucmdbNode joinnode subtype in $L.file~="Desktop"

ucmdbDesktop joinnode subtype in $L.file="Desktop"

DEM rules using different conditions to affect the same table

Typically, you will only need to add conditions if your business processes require the integration to take
different actions with certain CI types or SLAs.

Change the Action the DEMRule Takes
Out-of-the-box, the integration DEM rules take the following actions:

l Add a CI record when the UCMDB data does not match an existing ServiceManager CI record

l Open a Change or log results and update a CI record when the UCMDB CI attribute data does not
match the CI attribute data in the ServiceManager CI record

l Delete a CI record when the UCMDB data specifies that the CI has been deleted

You can change the integration DEM rules tomeet your business processes. For example, you could
use the ucmdbNode DEM rule to open a change when the integration finds a non-desktop CI with
unexpected data, and use the ucmdbDesktop DEM rule to log results and update the record when the
integration finds a desktop CI with unexpected data.

Caution: If you want to use the ChangeManagement verification and ChangeManagement
validation features of the integration, your DEM rules must use theOpen a Change option for the
“Action if record exists but unexpected data discovered” event.

Create Custom JavaScript to Open Change or

Incident Records
ServiceManager uses the discoveryEvent JavaScript to create CI names and to set the values of
required fields when opening change or incident records. Out-of-the-box, the script uses the following
default values.
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Default values to create a newCI
You can update the createCIName and populateNewCI functions to set the following CI values.

CI attribute Default value defined in discoveryEvent

record.logical_name System generated ID number

record.assignment AUTO

record.istatus Installed

record.os_name Value in record.operating_system

Default values used to create a new CI

Default values to create a new change
You can update the populateChange function to set the following change values.

CI attribute Default value defined in discoveryEvent

change.category Unplanned Change

change.reason Value in reason

change.initial_impact 3

change.severity 3

change.coordinator Change.Coordinator

change.requested_by discovery

change.status initial

Default values used to create a new change

Default values to create a new incident
You can update the populateIncident function to set the following incident values.

CI attribute Default value defined in discoveryEvent

incident.category incident

incident.subcategory hardware

Default values used to create a new incident
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CI attribute Default value defined in discoveryEvent

incident.product_type missing or stolen

incident.assignment Hardware

incident.initial_impact 3

incident.severity 3

incident.logical_name Value of id

incident.site_cateogry C

incident.contact_name ANALYST, INCIDENT

incident.affected_item MyDevices

Default values used to create a new incident, continued

Integration Tailoring Options
The integration offers the following tailoring options:

How to Enable ASM Support 162

How to Update the Integration Adapter Configuration File (sm.properties) 162

How to Add DEMReconciliation Rules 166

How to Add Discovery Event Manager Rules 168

How to Add a CI Relationship Type to the Integration for Data Push 173

How to Add a CI Attribute to the Integration for Data Push 179

How to Add a CI Type to the Integration for Data Push 193

How to Add a Custom Query to an Integration Job 208

How to Add a CI Type, Attribute or Relationship Type to the Integration for Population 209

How to Enable or Disable UCMDB ID Pushback for a CI Type 209

How to Add an Attribute of a Supported CI Type for Federation 212

How to Enable the Automatic Deletion of CI Relationships from UCMDB 217
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How to Enable ASM Support
As of version 9.41, ServiceManager supports the Automated ServiceModeling (ASM) functionality in
the UCMDB Browser.

ASM can automatically discover Service CIs and the consumer-provider relationships between the
components of services. The Service Discovery process builds dependency graphs from the
consumer-provider components that make up a service.

Note: ASM is supported only for UCMDB 10.20 or later. To use ASM, the ASM Enhanced
packagemust be deployed in UCMDB.

You can tailor ServiceManager to integrate with Automated ServiceModeling (ASM) of the
UCMDB Browser. See the following instructions.

How to integrate with ASM

ASM enables ServiceManager users to view the accurate service trees that are discovered by
ASM and facilitates servicemodeling in ServiceManager.

For example, to integrate the ServiceManager ChangeManagement module with ASM, you can add a
control that calls the us.launch.external RAD application by passing the following URL:

http://[UCMDB browser server name]:[port]/ucmdb_
browser.jsp?username=<username>&password=<password>&server=Default%20Client&locale=
en#view=[Service Name];tab=service-modeling

Where:

l [UCMDB browser server name], [port], [username] and [password] are the UCMDB server host
name, communications port, integration account user name and password, respectively. These
parameters are configured in the UCMDB integration section in the System Information Record.

l [Service Name] is the display name of current service CI.

How to Update the Integration Adapter

Configuration File (sm.properties)
The integration uses a properties file (sm.properties) as a configuration file of the adapter. Out-of-the-
box, this file has been set up based on best practices, so usually you can keep the default parameter
values. Optionally, you can update the parameter values to better suit your needs.
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To update the sm.properties file:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41 > Configuration Files.

3. Click the properties configuration file: sm.properties.

4. Update the parameter values as needed. For a list of the parameters, see the following table.

Parameter Default value Comment

timeout.minutes 10 The integration connection timeout
value (in minutes)

number.of.concurrent.sending.thre
ads

6 The number of concurrent threads used
for the data push feature

o 1: Disabled

o 2 or higher: Enabled

Note: If you are connecting to
multiple ServiceManager
instances to improve the CI data
push performance (see the URL
Override configuration in "How to
Create an Integration Point in
UCMDB" on page 69), you are
recommended to increase this
value for optimized performance.
For example, set it to 12 if you are
connecting to two ServiceManager
instances.

min.objects.for.concurrent.sendin
g

50 Theminimum number of Service
Manager objects that is required to use
concurrent sending instead of single
thread sending

Note: It is used for the push
feature.

number.of.chunks.per.thread 3 The number of chunks per thread used
for the push feature

Total of number of chunks =
number.of.chunks.per.thread *
number.of.concurrent.sending.threads

Parameters in the sm.properties file
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Parameter Default value Comment

recommended.min.cis.per.chunk 50 Theminimum allowed number of CIs
per CI data chunk. This value is used to
mitigate the risk of making your data
chunks too small.

For example, suppose your system
uses the following settings:

o number.of.chunks.per.thread=3

o number.of.concurrent.sending.threa
ds=3

o recommended.min.cis.per.chunk=5
0

When pushing 1000 CIs, the number of
CIs in each chunk is calculated as
1000/3/3. The calculated value is
greater than the
recommended.min.cis.per.chunk value,
so the calculated value is used.
However, when pushing 270 CIs, the
calculated value is less than the
recommended.min.cis.per.chunk value,
so the calculated value is used.

max.running.hours.for.multi.thread
ed

20 Themaximum number of hours before a
push request times out in amulti-
threaded environment.

number.of.cis.per.request 1000 Themaximum number of objects
retrieved from ServiceManager by ID

Caution: It is used for the
population and federation features.
Do not set it to a number greater
than 1000 in case the request has a
64K limit.

federation.request.pagination.swit
ch

on

federation.request.max.size 2000 size of query conditions for federation

federation.isin.max.count 500 size of isin{} size

use.global.id true This parameter is obsolete for the

Parameters in the sm.properties file, continued
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Parameter Default value Comment

generic adapter starting with SM9.41.

type.of.expand.enum 2 It configures the valuemapping rule for
the UCMDB enum type

o 0: The feature will be disabled

o 1: The enum type will expand to
“{value}”

o 2: The enum type will expand to
“{index}-{value}”

Note: It is used for the push
feature.

op.pagination.switch on It indicates if pagination (client driven)
is enabled

o on: Enabled.

o off: Disabled.

Note: It is used for the population
feature.

pop.pagination.recordcount 1000 Themaximum number of records
displayed on each page when
pagination is enabled.

Note: It is used for the population
feature.

pop.createci.key sm_id The UCMDB field of a CI record that
stores the ServiceManager CI ID.

Note: It is used for UCMDB ID
Push Back by the population
feature.

ucmdbid.pushback.request UpdateucmdbID
PushBackReque
st

The web service request for pushing the
UCMDB ID back to ServiceManager.

Note: It is used for the population
feature.

check.sm.connections false It indicates whehter to check the SOAP
connections to ServiceManager

Parameters in the sm.properties file, continued
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Parameter Default value Comment

instances before running a job.

You can enable it under any of the
following circumstances:

o Your ServiceManager is running in
High Availability mode (with load
balancing), and you want to connect
UCMDB tomultiple Service
Manager instances.

o Youwant UCMDB to not run a job
when no integration connections are
available, rather than run the job and
then report a failure.

Parameters in the sm.properties file, continued

How to Add DEM Reconciliation Rules
It is possible that your ServiceManager system already contains CI records that match CIs in your
UCMDB system. Rather than add duplicate CI records to your ServiceManager system, you can
configure ServiceManager to reconcile CI records between the two systems based on specified
Discovery Event Manager (DEM) reconciliation rules.

A DEM reconciliation rule record enables you to specify what ServiceManager queries you want to use
to determine whether an existing CI recordmatches a CI in a UCMDB system. An administrator
typically specifies reconciliation rules prior to starting the integration to the UCMDB system so that
ServiceManager will not create duplicate CI records.

When performing CI reconciliation between ServiceManager and UCMDB, ServiceManager uses the
ucmdb.id field to query the device table or a join table to determine whether an Update or Create
operation is needed. The reconciliation process is as follows:

1. The UCMDB system sends a web servicemessage containing the latest CI attribute data to
ServiceManager.

2. ServiceManager scans the web servicemessage for the CI ucmdb.id value.

Note: The ucmdb.id field is displayed in the Actual State Section of the CI form, with a label
of Ucmdb ID.

3. ServiceManager searches for an existing CI record that has the same ucmdb.id value.
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4. If ServiceManager finds a CI that has the ucmdb.id value, no reconciliation is needed. Service
Manager compares the UCMDB CI attributes to the ServiceManager managed fields and runs the
appropriate Discovery Event Manager (DEM) rules as needed to update the CI record in Service
Manager.

5. If ServiceManager cannot find a CI that has the ucmdb.id value, it searches for a DEM
reconciliation rule record that is defined for the CI type.

6. If no DEM reconciliation rule record is found, ServiceManager creates the CI record according to
the appropriate DEM rules.

7. If a DEM reconciliation rule record is found, ServiceManager evaluates the rules and appends
(ucmdb.id=NULL or ucmdb.id~=NULL and istatus=”XXXXXX”) to the reconciliation rules in the
backend. The istatus value is retrieved from the DEM rule for deletion (for example,
Retired/Consumed). If no istatus value is found in the DEM rule, ServiceManager only appends
ucmdb.id=NULL to the reconciliation rules in the backend.

8. If nomatching CI record is found by the reconciliation rules, ServiceManager creates the CI
record according to the appropriate DEM rules.

9. If a matching CI record is found by the reconciliation rules, ServiceManager updates the CI record
according to the appropriate DEM rules

Multi-company mode

By default, ServiceManager uses only the ucmdb.id field for CI reconciliation and the company.id field
is not used. You canmanually add DEM reconciliation rules.

Using join tables for reconciliation

When setting reconciliation rules, if the CI type you are reconciling has a joindef definition (as defined in
the devtype table), use the join table name instead of the device table. For example, if you want to
reconcile computer CIs, use the joinnode table instead of the device table.

Sequence of reconciliation

By default, ServiceManager executes the reconciliation rules in their listed order. To change the order
in which ServiceManager reconciles CIs, you can add a numeric value to theSequence field.

Steps to add a DEM reconciliation rule record

To create a DEM reconciliation rule record, follow these steps:
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1. Click Tailoring >Web Services > DEM Reconciliation Rules.

ServiceManager displays the DEMReconcile Record form.

2. In the Table field, select a ServiceManager table against which you want to run reconciliation
queries.

Note: Only tables that are specified in CI type records are displayed in the drop-down list.
You can create only one DEM reconciliation record for one table.

3. Click New.

4. Enter expressions in theExpression column, and then enter a sequence number for each
expression in theSequence column. For example, you can add the following expressions for the
device table. In this example, ServiceManager looks for amatching record first based on the
logical.name field, and then based on the sm.device.display.name field.

Expression Sequence Notes

logical.name=logical.name in $L.file 1 Checks to see if the CI
Identifier matches the
logical.name value of an
existing CI in Service
Manager. If nomatching
record is found, go to the
next expression.

sm.device.display.name=sm.device.display.name
in $L.file

2 Checks to see if the CI
Display Namematches the
display.name value of an
existing CI in Service
Manager.

5. Click Add.

ServiceManager creates the DEM reconciliation rule record.

How to Add Discovery Event Manager Rules
ServiceManager uses Discovery Event Manager (DEM) to define the actions the system should
perform when the actual state of an incoming configuration item (CI) record differs from themanaged
state of a CI record in ServiceManager. The DEM rules allow you to define whether the Service
Manager system adds, updates, or deletes CI records based on incoming UCMDB data.

For CI records only, the DEM rules also allow you to define how ServiceManager should handle
duplicate logical names.
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To access DEM rules in ServiceManager, navigate to Tailoring >Web Services > Discovered
Event Manager Rules, and then click Search to view existing rules or click New to create new rules.

This section includes:

l "DEM Rules" below

l "CI Attributes Displayed in Change and Incident Records" on page 172

l "Searching for Change and Incident Records Opened by the Integration" on page 172

DEMRules
ServiceManager offers the following rules options:

Action if matching record does not exist
This is the action you want ServiceManager to take if it cannot find amatching CI record.

l Add the record:(Default) ServiceManager will add a CI record when it cannot find amatching
record. See "How to Add DEMReconciliation Rules" on page 166 to define what fields Service
Manager uses tomatch CI records.

l Add the record, and set dependency as true: This option is available only for synchronization of
CI relationship data. ServiceManager adds the CI relationship record and enables outage
dependency for the record by doing the following:
o Checks the Outage Dependency check box;

o Sets the number of dependent downstream CIs to 1. This is because UCMDB only supports
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one-to-one CI relationships.

l Open an Incident:ServiceManager opens an incident for someone to review the new CI record.
The incident enables someone to investigate whether the new CI record is compliant with your
business practices.

l Open a Change:ServiceManager opens an unplanned change for someone to review the new CI
record. The change allows you to investigate whether the new CI record is compliant with your
business practices. If the CI record is compliant, the change can be approved. If the CI record is not
compliant, then the change can be denied and the CI record removed. The change record lists both
the current and proposed attribute values.

Action if record exists but unexpected data

discovered
This is the action you want ServiceManager to perform if it does not find amatching CI attribute value.

l Open a Change: (Default) ServiceManager opens an unplanned change to review the actual state
of the CI record. The change allows someone to investigate whether the new attribute value is
compliant with your business practices. If the value is compliant, the change can be approved. If
the value is not compliant, then the change can be denied and the CI attribute value reverted to its
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managed state.

l Log Results and update record:ServiceManager logs the results of the actual state of the CI
record, and then updates the CI record.

l Open an Incident:ServiceManager opens an Incident to investigate the actual state of a CI record
and determines what actions must be performed or initiated to bring the record into compliance with
ServiceManager.

Action if record is to be deleted
This is the action you want ServiceManager to perform if an external event specifies that the record
needs to be deleted.

l Delete record: (Default for CI Relationship records) This option is available for synchronization of
both CI and CI Relationship records. ServiceManager automatically deletes the CI/CI Relationship
record.

l Open an Incident: This option is available only for synchronization of CI Relationship records.
ServiceManager opens an incident to investigate the deleted record and determines which actions
must be performed or initiated to bring the record into compliance with ServiceManager.

l Open a Change: This option is available only for synchronization of CI Relationship records.
ServiceManager opens an unplanned change to review the deleted record. The change allows
someone to investigate whether the deleted record is compliant with your business practices. If the
record is compliant, the change can be approved. If the record is not compliant, then the change can
be denied and the record added back to the system.

l Update record to the selected status: (Default for CI records) This option is available only for
synchronization of CI records. ServiceManager updates the status of the CI record to a value
selected from the drop-down list (for example, Retired/Consumed), rather than deletes the record
permanently.

Note: Values available from the drop-down list are defined in the ICM Status global list.

l Open a Change to update record to the selected status: This option is available only for
synchronization of CI records. ServiceManager opens an unplanned change to update the CI
record’s status to a value selected from the drop-down list (for example, Retired/Consumed). The
change allows someone to investigate whether the requested status change is compliant with your
business practices. Once the change has been approved and closed, ServiceManager
automatically changes the CI record to the selected status. If the change has been denied, Service
Manager makes no changes to the CI record.
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l Open an Incident to update record to the selected status: This option is available only for
synchronization of CI records. ServiceManager opens an incident to update the record’s status to a
value selected from the drop-down list (for example, Retired/Consumed). Once the incident has
been closed, ServiceManager automatically updates the CI record to the selected status.

CI Attributes Displayed in Change and Incident

Records
ServiceManager displays a Change Details section on the corresponding change or a CMDB Changes
section on the corresponding incident when you configure DEM to open either change records or
incident records when it discovers CI attribute changes through the UCMDB-SM integration. Service
Manager only displays a tab for CI attributes when the UCMDB-SM integration is enabled and you have
defined a rule in the Discovery Event Manager to create a change or incident record when a CI is
added, updated, or deleted.

Both the Change Details and CMDB Changes sections display the current CI attribute values
alongside the actual attribute values discovered by UCMDB. You can use this information to approve
or deny a change or escalate an incident to the proper assignment group.

Searching for Change and Incident Records

Opened by the Integration
You can use the following search criteria to find change and incident records opened by the UCMDB-
SM integration.

Record type Search option available

Change Search for records with the category unplanned change.

Incident Search for records using theGenerated by UCMDB Integration option.

Search options available for change and incident records
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How to Add a CI Relationship Type to the

Integration for Data Push
Once you have added a new CI type to the integration and have created relationships between it and
other CI types in UCMDB, for each of these relationship types you need to perform the following tasks
so that UCMDB can push each type of relationships to ServiceManager.

As an example, the following steps illustrate how you add a relationship type namedOwnership
(between theCost andCostCategoryCI types) to the integration for data push.

Note: These steps assume that you have already added theCost andCostCategoryCI types to
the integration.

1. Create a query to push the relationship type.
See "How to Create aQuery to Push a Relationship Type" below.

2. Map the relationship query to a ServiceManager web service object.
See "How toMap a Relationship TypeQuery to the ServiceManagerWeb Service Object" on
page 176.

3. Create an XML configuration file for the new relationship type.

See "How to Create an XMLConfiguration File for a Relationship Type" on page 177.

How to Create a Query to Push a Relationship

Type
Once you have created a relationship between two CI types, youmust create a query to push the
relationship to ServiceManager.

Note: Any query you createmust conform to the "Query Requirements" on page 152.

To create a new query calledCost CostCategory Ownership Relations for Ownership relationships
between the Cost and CostCategory CI types:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. Click New > Query. TheQuery Definition pane is displayed.
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4. From the CI Type Selector, drag the Cost and CostCategory CI types to the query pane.

5. Create anOwnership relationship from Cost to CostCategory.
a. Click theCreate Relationship icon.

b. Select theCost node, and drag the arrow from it to the CostCategory node.

c. Select Regular Relationship, and click OK.

d. Select Connection > Ownership, enter Ownership for Relationship Name, and click OK.
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AnOwnership relationship is created between the CI types.

6. Right-click the relationship arrow, and select Relationship Properties.

7. Change the element name fromOwnership toRoot (or a name starting with “Root_”), and then
click OK.
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8. Click theSave icon, and save the query as described in the following.
a. Enter a query name. For example, Cost CostCategory Ownership Relations

Push.

b. Select the Integration > Service Manager > Push folder.

c. Click OK.

The query is now created. You are ready to add this query to the push configuration file
(smPushConf.xml).

How to Map a Relationship Type Query to the

Service Manager Web Service Object
Once you have created a query for a relationship type, you need tomap the query to the Relationship
web service object in ServiceManager as described in the following steps.

1. Navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41 > Configuration Files.
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2. Click the smPushConf.xml file.

3. Add amapping entry by copying an existing one for relationship push. For example, add the
followingmapping entry.

<tql name="SM Layer2 Topology Relations Push 2.0"
resourceCollectionName="Relationships" resourceName="Relationship" />

4. Change the TQL query name to the name of the query you created for the relationship type. For
example, Cost CostCategory Ownership Relations Push.

<tql name="Cost CostCategory Ownership Relations Push"
resourceCollectionName="Relationships" resourceName="Relationship" />

5. Click Save to save the configuration file.

How to Create an XML Configuration File for a

Relationship Type
To create an XML configuration file for a relationship type:

1. Log in to UCMDB with an administrator account.

2. Navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41, and select the adapter.

3. Click theCreate New Resource icon .

4. Select New Configuration File.

5. Enter the full file name: <AdapterID>/mappings/push/<filename>. For example,
ServiceManagerEnhancedAdapter9.41/mappings/push/SM Cost CostCategory

Ownership.xml.

6. Click OK to save to the new file. The new file appears in the list of configuration files.

7. Open the new file in the XML Editor of the Visual Mapping interface.

8. Copy the content from an existingmapping file to overwrite the content of the new file in the XML
Editor pane, and update query name to the name of the query you created (Cost CostCategory

Ownership Relations Push).

<?xml version="1.0" encoding="UTF-8"?>
<integration xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="../mappings_schema.xsd">

<info>
<source name="UCMDB" version="10.20" vendor="HP"/>
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<target name="SM" version="9.40" vendor="HP"/>
</info>
<import>

<scriptFile path="mappings.scripts.SMPushFunctions"/>
</import>
<!--

Push Cost to Cost Category Relations.
-->
<target_entities>

<source_instance query-name="Cost CostCategory Ownership Relations
Push" root-element-name="Root">

<target_entity name="Relationship">
<target_mapping name="RelationshipType" datatype="STRING"

value="SMPushFunctions.getDisplayName(Root['element_type'],ClassModel)"/>
<target_mapping name="ParentCI" datatype="STRING"

value="SMPushFunctions.getEndId(OutputCI.getExternalId().getEnd1Id())"/>
<target_mapping name="ChildCIs" datatype="STRING_LIST"

value="[SMPushFunctions.getEndId(OutputCI.getExternalId().getEnd2Id())]"/>
</target_entity>

</source_instance>
</target_entities>

</integration>

9. Click theSave icon to save the new configuration file.

Now, you have added the new relationship type to the integration. Next, you need to add the new
relationship query to a data push job, as shown in the following figure. For detailed steps, see "How to
Add a Custom Query to an Integration Job" on page 208.

Caution: Before you run the relationship push job, make sure you have already added the relevant
CI types (Cost andCostCategory in this example) to the integration and pushed the relevant CIs
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to ServiceManager.

How to Add a CI Attribute to the Integration for

Data Push
You can use the following steps to add a CI attribute to the integration.

1. Does the CI attribute already exist in the UCMDB class model?
Yes. Go to Step 3.

No. Go to Step 2.

2. Add the CI attribute to the UCMDB class model.
See "How to Add the CI Attribute to the UCMDB Class Model" below.

3. Add the CI attribute to the query layout.
See "How to Add a CI Attribute to the Query Layout" on page 181.

4. Add a web service field for the ServiceManager CI type.
See "How to Add aWeb Service Field for the ServiceManager CI Type" on page 182.

5. Map the CI attribute to the ServiceManager web service field.

See "How toMap the CI Attribute to a ServiceManagerWeb Service Field" on page 191.

How to Add the CI Attribute to the UCMDB Class

Model
The integration only uses a subset of the CI attributes available from your UCMDB system. Out-of-the-
box, the integration consists of CI attributes that are typically managed from a ServiceManager
system such as host name and host DNS name. Before creating a new UCMDB CI attribute, you
should determine if there are any existing CI attributes in your UCMDB system that provide the data
you want. In most cases, there is an existing attribute tracking the data that you want to add to the
integration. For example, the Node CI type contains many attributes that you can add to the integration.
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The following steps illustrate how to add a new CI attribute to an existing CI type. This is not the
expected typical scenario. Typically, you would add an existing CI attribute to the integration, which
means you do not need to perform these steps.

Note: The integration does not require any special steps to add a CI attribute to the UCMDB class
model. You can use the standard CI attribute creation procedures to add a CI attribute. For more
information on CI attribute creation, see the UCMDB Help Center.

As an example, the following steps will add an attribute named comments to the Business Service CI
type.

To add a CI attribute to the UCMDB class model:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling > CI Type Manager.

3. Select the CI type to which you want to add a new CI attribute from the CI Types navigation tree.
For example, ConfigurationItem > BusinessElement > BusinessService.

4. Click theAttributes tab.

5. Click theAdd icon.
The Add Attribute window opens.

6. In Attribute Name, type the unique name you want to use for the new CI attribute. For example,
comments.

Caution: The name cannot include any of the following characters: ‘ / \ [ ] : | < >

+ = ; , ? *.
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7. In Display Name, type the name that you want UCMDB to display in the interface. For example,
Comments.

8. (Optional) In Description, type a description of the new CI attribute.

9. In Attribute Type, select Primitive orEnumeration/List depending on the data type of the
attribute. For example, select Primitive and select string.

10. In Value Size, type themaximum character length that the attribute can have. For example, 300.

11. Select theEnable default value option, and enter a default value. Or, do not select this option to
leave the default value blank.

12. Click OK to save the attribute.

13. Click theSave icon to save attribute changes to the CI type.

Now, the attribute has been added to the CI type. Next, you need to add the attribute to a query that
synchronizes the CI type. See "How to Add a CI Attribute to the Query Layout" below.

How to Add a CI Attribute to the Query Layout
To add an existing CI attribute to the integration, youmust add this attribute to the layout setting from
the query that synchronizes the CI type. Youmust know which CI type contains the CI attributes that
you want to add to the integration.

To add a CI attribute to the query layout:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. For Resource Type, select Queries.

4. From theQueries navigation tree, click Integration > Service Manager.

5. Select the query that manages the CI type whose attributes you want to add to the integration. For
example, Push > SM Computer Push 2.0. UCMDB displays the TQL layout of the query.

6. Select the node from the query layout that contains the CI attribute that you want to add to the
integration. For example, Root.

7. Right-click the node and select Query Node Properties. TheQuery Node Properties window
opens.

8. Select the CI type (Database in this example), and click theElement Layout tab.

9. Select the CI attribute that you that want to include in the integration from theAvailable
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Attributes list, and click theAdd icon to add it toSpecific Attributes list. For example,
Comments.

10. Click OK to save the node properties.

11. Click theSave icon to save the query.

Now, the CI attribute has been added to the relevant query layout. Next, you need to add a Service
Manager web service field that will bemapped to this UCMDB CI attribute.

How to Add a Web Service Field for the Service

Manager CI Type
The integration uses only a subset of the CI attributes available from your ServiceManager (SM)
system. CI attributes must bemapped between UCMDB and SM. Before creating a new SMCI
attribute that will bemapped to the UCMDB CI attribute you added previously, youmust determine if
there are any existing CI attributes in your ServiceManager system that provide the data you want. In
most cases, there is an existing attribute tracking the data that you want to add to the integration. For
example, the Computer CI type contains many attributes that you can add to the integration.
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If you decide to use an existing attribute instead of creating a new one, you can directly modify the web
service definition in ServiceManager to expose that attribute, and thenmap this SM attribute to the
UCMDB attribute by using the UCMDB Visual Mapping tool (see "How toMap the CI Attribute to a
ServiceManagerWeb Service Field" on page 191).

If you decide to add a new attribute, follow the steps below. The steps vary depending on the data type
of the attribute: simple (string, for example), or complex (array of structure or structure).

Add a Simple Attribute to the SM CI Type
As an example, the following steps illustrate how to add a simple attribute (comments) to an existing
CI type (Business Service).

1. Log in to UCMDB as a system administrator.

2. Click Data Flow Management > Adapter Management, and then select
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ServiceManagerEnhancedAdapter 9-x to open the corresponding XMLmapping file (SM
Business Service 2.0.xml in this example) with the Visual Mapping tool editor.

3. On the External Class Model pane, select the CI type (bizservice).

4. On the left-side Attributes pane (which displays the fields that are retrieved from the Service
Manager web service object for the Business Service CI type), click theAdd New Attribute to
Selected External Node icon.

5. Type a name and display label for the new attribute, and click OK.

Caution: If the you enter a name that duplicates or is part of an existing field name in the
attribute table of the ServiceManager CI type or in the device table, an error will occur
indicating the attribute could not be created.
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6. Click OK again to confirm the attribute creation.

The new attribute (mycomments) appears in the ServiceManager attribute list.

At the same time, UCMDB invokes the ServiceManagerWeb Service API to add the new
attribute, expose it in theWeb Service API and set it as amanaged field. You can open the web
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service object in ServiceManager to verify the new attribute (Tailoring >Web Services >Web
Service Configuration).

7. Save the configuration file.

Add an Array of Structure or Structure to the CI Type
ServiceManager uses an Array of Structure or Structure to store complex attributes, for example, the
ports of a Computer CI. You can also create such kind of complex attributes through the Visual
Mapping tool in UCMDB.

The following steps illustrate how to add an attribute named comport to the Computer CI type.

1. Log in to UCMDB as a system administrator.

2. Open the corresponding XMLmapping file (SM Computer Push 2.0.xml in this example), with
the Visual Mapping tool editor.

3. Select the CI type (computer), and click theAdd New CI Type to External Class Model icon.

4. In the child CI type creation dialog that appears, enter a name and description for the attribute,
selectMany to One forRelation with Parent if the attribute data type is array of structure or
select One to One if the data type is structure.
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5. Click OK. The attribute is created on the ServiceManager side.

6. Select the new attribute in the External Class Model pane, and click theAdd New Attribute to
Selected External Node icon.
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7. Add a field (httpPort) to the array of structure, and click OK. Click OK again to confirm the
attribute creation.
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8. Repeat the previous two steps to addmore fields to the array of structure as needed.
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The attribute is also automatically added to the corresponding web service object in Service
Manager.
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9. Save the configuration file.

Next, you need tomap this ServiceManager CI type attribute to the one you added previously in
UCMDB. 

How to Map the CI Attribute to a Service Manager

Web Service Field
The integration uses an adapter to transform UCMDB CI attributes to web services objects recognized
by ServiceManager. The adapter in turn specifies what XML transformation files the integration should
use to convert UCMDB queries into properly formatted ServiceManager web services messages.

Out-of-the-box, each integration query has a corresponding XML configuration file that maps to a
particular CI type in UCMDB. In addition, each attribute for which you enabled calculation requires its
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own entry in the XML configuration file. Without an XML transformation entry, ServiceManager cannot
receive any CI attribute updates from your UCMDB system.

If you want to add a new attribute to the integration, youmust edit the XML configuration file for the
parent CI type and add an entry for the CI attribute. For information about which CI types each query
manages, see "Queries for Push" on page 147.

The following steps illustrate how tomapUCMDB CI attributeComments (which you added
previously) to theMyCommentsServiceManager attribute (which you created in the previous step).

Tomap a UCMDB CI attribute to an SM CI attribute:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41 > Configuration Files.

3. Double-click the XML configuration file that manages the parent CI type of your CI attribute. For
example, openSM Business Service Push 2.0.xml to add an attribute to theSM Business
Service Push 2.0 query.

4. Select the relevant CI type in the External Class Model pane (bizservice in this example), and
drag and drop the attribute (mycomments) from the left-side Attributes pane into the Visual
Mapping pane.

5. Select the relevant Node in the Local Query panel (Root in this example), and drag and drop the
attribute (comments in this case) into themapping entry that you created in the previous step.
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6. Save the XML configuration file. TheComments attribute in UCMDB is now mapped to the
MyComments attribute in ServiceManager.

Note: When you create or edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a CI Type to the Integration for

Data Push
You can use the following steps to add a CI type to the integration.

1. Does the CI type already exist in the UCMDB class model?
Yes. Go to Step 3.

No. Go to Step 2.

2. Add the CI type to the UCMDB class model.
See "How to Add the CI Type to the UCMDB Class Model" on the next page.

3. Create a query to synchronize the CI type.
See "How to Create aQuery to Synchronize the CI Type" on page 196.
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4. Add the CI type’s attributes to the query layout.
See "How to Add the CI Type’s Attributes to the Query Layout" on page 200.

5. Add the CI type to ServiceManagerServiceManager.
See "How to Add the CI Type to ServiceManager" on page 202.

6. Map the CI type’s attributes to web service fields.
See "How toMap the CI Type’s Attributes toWeb Service Fields" on page 204.

7. Add custom queries to integration data push jobs.
See "How to Add a Custom Query to an Integration Job" on page 208.

How to Add the CI Type to the UCMDB Class

Model
Before creating a new UCMDB CI type, you should determine if there are any existing CI types in your
UCMDB system that provide the CI attributes you want. In most cases, you can create links to one or
more existing CI types to create a new logical CI type for use by the integration.

The following steps illustrate how to create a new CI type called SM RDBMS based on an existing CI
type called database.

Note: The integration does not require any special steps to add a CI type to the UCMDB class
model. You can use the standard CI type creation procedures to add a CI type. For more
information on CI type creation, see the UCMDB Help Center.

To add a CI type to the UCMDB class model:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling > CI Type Manager.

3. Select the base CI type you want to use for your new CI type from the CI Types navigation tree:
Managed Object > ConfigurationItem > Infrastructure Element > Running Software >
Database.

4. Click theNew icon .
The Create Configuration Item Type window opens.

5. In Name, type the unique name you want to use for the new CI type. For example, sm_rdbms.

Caution: The name cannot include any of the following characters: ‘ / \ [ ] : | < >

+ = ; , ? *.
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6. In Display Name, type the name you want UCMDB to display in the interface. For example, SM
RDBMS.

7. In Description, type a description of the new CI type. This is an optional field. For example, Hosts
running relational databases.

8. In Base CI Type, verify that the proper base CI type is selected. Your new CI type will inherit the
attributes of the base CI type you select here. For example, Database.

9. Click Next. The wizard displays a list of CI attributes from the base CI type.

10. Add, edit, or remove CI attributes as needed for the new CI type. For example, accept the default
attributes inherited from Database.

11. Click Next. The wizard displays a list of qualifiers from the base CI type.

12. Add or remove qualifiers as needed for the new CI type. For example, accept the default qualifiers.

13. Click Next. The wizard displays a list of icons associated with the CI type.

14. Select the icons associated with this CI type. For example, accept the default abstract class icon.

15. Click Next to add any menu item properties or label definitions as needed. For example, accept
the default settings from the base CI type.

16. Click Finish to create the CI type.
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17. Select your new CI type from the tree. For example, SM RDBMS.

18. Browse to an existing CI type you want to link to, and control-click it to add it to your selection. For
example, Node.

Note: Choose an existing CI type that has the attributes that you want to be part of your new
logical CI type.

19. Right-click one of the selected CI types, and click Add/Remove Relationship. The
Relationships window opens.

20. Create an SM Link relationship from the existing CI type to the new CI type. For example, from
Node toSM RDBMS.

Note: You need to create a new SM Link relationship if it does not exist.

21. Click OK to create the relationship.

22. Click theSave icon to save the CI type.

How to Create a Query to Synchronize the CI

Type
The integration uses queries to gather CI attribute values and pass them to your ServiceManager
system. Youmust create a query for any CI type you add to the integration. Any query you createmust
conform to the "Query Requirements" on page 152.
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The following steps illustrate how to create a new query named rdbmsData for theSM RDBMS CI
type described in previous sections.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. From theQueries navigation tree, click Integration > Service Manager.

4. Right-click Service Manager, and select theNew > Query.
TheQuery Definition window opens.

5. Find the CI type that will be the root node of your query from the CI Type Selector. This CI type is
typically the one that provides themost attributes for the CI. For example,Managed Object >
ConfigurationItem > InfrastructureElement > RunningSoftware > Database > SM RDBMS.

6. Drag the root CI type from the CI Type Selector and drop it into the empty Editing pane. UCMDB
displays the icon of the CI type.

7. Right-click the CI type icon, and select Query Node Properties. The Node Properties window
opens.

8. Change the Element Name toRoot.

9. Click OK to save the node properties.
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10. Find any additional CI types you want to add to the query from the CI Type Selector. These CI
types typically provide additional CI attributes. For example,Managed Object >
ConfigurationItem > Infrastructure Element > Node.

11. Drag the additional CI type from the CI Type Selector and drop it into the Query Definition pane.
UCMDB displays the icon of the additional CI type.
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12. Create relationships between the Root CI type and the additional CI types as needed. For
example, create an SM Link betweenRoot andNode.
a. Select Root and control-click the additional CI type. For example, Node.

b. Right-click one of the selected items, and click Add Relationship. The Add Relationship
window opens.

c. Type a Relationship Name. For example SM Link.

d. Select the relationship direction.
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e. Click OK to add the relationship.

13. Repeat step 10 to step 12 for each additional CI type you want to add to the query. For example,
SM RDBMS does not need any additional CI types.

14. Click theSave icon to save the query.
a. In Query Name, type the unique name you want to use for the new query. For example,

rdbmsData.

b. In the folder tree, select the folder in which you want to save the query. For example, Root >
Integration > Service Manager > Push.

c. Click OK. UCMDB adds your new query to the query list.

How to Add the CI Type’s Attributes to the Query

Layout
To add a CI attribute to the integration, youmust enable the calculation layout setting from the query
that synchronizes the CI type. Because youmust enable calculation for each attribute you want to add
to the integration, you should be familiar with the integration CI types and their attributes.
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The following steps illustrate how to enable calculation for attributes of theSM RDBMS CI type
described in previous sections.

To add a CI type’s attributes to the query layout:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. From theQueries navigation tree, click Integration > Service Manager.

4. Double-click the query that manages the CI type whose attributes you want to add to the
integration. For example, rdbmsData. UCMDB displays the TQL layout of the query.

5. Right-click theRoot node from the query layout, and then select Query Node Properties. The
Query Node Properties window opens.

Caution: Your integration query must contain a node calledRoot. See "Query
Requirements" on page 152 for more information.

6. Click theElement Layout tab, and select theSelect attributes for layout option.

7. Select Specific Attributes from theAttributes condition list, and from the Available Attributes
list select the attributes you want andmove them to the Specific Attributes list. For example, add
theProduct Name, Application Version Description, The Database Instance Name, and
Port attributes.

8. Click OK to save the query node properties.
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9. Select any additional node that contains the attributes you want to add to the integration. For
example, Node.

10. Repeat step 4 through step8 for each additional node.

11. Click OK to save the query node properties.

12. Repeat step 9 to step 13 for each additional node that contains the attributes you want to add to
the integration.

13. Click theSave icon to save the query .

How to Add the CI Type to Service Manager
Before creating a new ServiceManager CI type, you should determine if there are any existing CI types
in your ServiceManager system that provide the CI attributes you want. In most cases, you can reuse
the existing CI types for the integration.

You can add a new CI type to ServiceManager by using the Visual Mapping tool in UCMDB, which
means you do not have to log out of UCMDB and then log in to ServiceManager.

The following steps illustrate how to create a new CI type calledRDBMS.

Note: This example is provided only as an illustration of the steps. The best practice is to reuse
the existing ServiceManager CI typeRunningSoftware to map with UCMDB CI typeSM
RDBMS.

1. Log in to UCMDB as an administrator.

2. Open an existing XMLmapping file (SM Computer Push 2.0.xml, for example) with the Visual
Mapping tool editor.

3. Select the Root node in the External Class Model panel, and click theAdd New CI Type to
External Class Model icon.

4. Enter parameter values as follows.

Name: rdbms

Description: CI type for RDBMS

table: smrdbms

subtype: Oracle, SQL Server
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5. Click OK.

6. Click OK again to confirm the CI type creation. The CI type is automatically created in Service
Manager, as shown in the following figure.
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What happens on the Service Manager (SM) side?

All relevant SM objects (DBDICT, JoinDef, Web Service API, DEM Rule, and so on) for the new
CI type are automatically created on the SM side, except the format. The new CI type will use
configurationItem as the default format.

If you want to use custom formats in SM for the new CI type, you have to create themmanually.
You can create the formats in Forms Designer based on existing view forms and bulk update
forms. To access Forms Designer in ServiceManager, type fd in the command line or navigate to
Tailoring > Forms Designer. For more information about creating forms in ServiceManager, see
the ServiceManager online help and the Tailoring Best Practices.

How to Map the CI Type’s Attributes to Web

Service Fields
The integration uses the ServiceManager Adapter to transform UCMDB CI attributes to web services
objects recognized by ServiceManager. The ServiceManager Adapter uses XML configuration files to
convert UCMDB queries into a properly formatted ServiceManager web services messages. Out-of-
the-box, each integration query has a corresponding XML configuration file. In addition, each attribute
you enable for synchronization from advanced layout settings requires its own entry in the XML
configuration file.
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If you want to add a CI type to the integration, youmust create amatching XML configuration file that
defines how the ServiceManager Adapter transforms each CI type into a ServiceManager web service
object. See "Integration Queries" on page 146 for information about the CI types each query manages.

The following steps illustrate how to create an XML configuration file for the rdbmsData query
described in previous sections.

Tomap a CI type’s attributes to web service fields:

1. Log in to UCMDB with an administrator account.

2. Navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41, and select the adapter.

3. Click theCreate New Resource icon .

4. Select New Configuration File.

5. Enter the full file name: <AdapterID>/mappings/push/<filename>. For example,
ServiceManagerEnhancedAdapter9.41/mappings/push/SM RDBMS Push.xml.

6. Click OK. Themapping file is created.

7. Double-click the new mapping file to open it with the Visual Mapping tool editor.

8. In the Local Query pane, click theAdd TQL Queries icon to add the rdbmsData query.

ServiceManagerEnhancedAdapter9.41 User Guide
Integration Tailoring Options

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 205 of 241



9. Click OK.
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10. Drag and drop the node “Root” from the Local Query pane into themapping area.

11. Drag and drop the node “RDBMS” from the External Class Model pane into themapping area.

12. Drag and drop SM attributes you want into themapping area.

13. Drag and drop the relevant UCMDB attributes into themapping area.

14. Save the new mapping file.

Note: When you create or edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.
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Using Groovy scripts in XML Configuration Files

The ServiceManager EnhancedGeneric Adapter uses XML andGroovy mapping scripts for four field
mapping scenarios: One to One, One toMany, Many toMany, and Value Conversion. Groovy scripts
have to be used for complex scenarios. For more information, see "Task 7: Update the Configurations
for Custom CI Types in UCMDB" on page 50.

How to Add a Custom Query to an Integration

Job
In order for the integration to synchronize your custom CI types, attributes, and relationships between
your ServiceManager and UCMDB systems, youmust add your custom queries to a data push or
population job.

The following steps illustrate how to add an custom query named rdbmsData, which you created
previously (see "How to Create aQuery to Synchronize the CI Type" on page 196), to a data push job.
The steps for adding a population query to a population job are similar.

To add a custom query to a data push or population job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Click the name of your ServiceManager integration point. For example, sm_integration.

4. Click theData Push tab.

Note: To add a query to a population job, click thePopulation tab instead.

5. Click the name of the integration job. For example, SM Configuration Item Push job.

6. Click theEdit icon .

7. Click theAdd icon.

8. Click Integration > Service Manager > Push > rdbmsData.

Note: For population, navigate to Integration > Service Manager > Population, and click
the population query instead.

9. Click OK to add the custom query.
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10. Enable theAllow Deletion option for the query to allow the integration job to delete removed data.

11. Click OK to close the Update Job Definition window.

How to Add a CI Type, Attribute or

Relationship Type to the Integration for

Population
All out-of-the-box mapping files for Population can be found by navigating toData Flow Management
> Adapter Management > ServiceManagerEnhancedAdapter9.41 >
ServiceManagerEnhancedAdapter9.41/mappings/population/<Name of Mapping File>.

With the Visual Mapping tool, you can add a CI Type, CI attribute, or relationship to the integration for
Population by following similar steps to those for data push. Additionally, you also need to add your
population queries to a population job. Refer to the following steps for data push:

"How to Add a CI Attribute to the Integration for Data Push" on page 179

"How to Add a CI Type to the Integration for Data Push" on page 193

"How to Add a CI Relationship Type to the Integration for Data Push" on page 173

"How to Add a Custom Query to an Integration Job" on the previous page

How to Enable or Disable UCMDB ID

Pushback for a CI Type
When a new CI is created in UCMDB, a UCMDB ID value is assigned to the CI. When CIs are
synchronized from ServiceManager (SM) to UCMDB through population, the UCMDB ID Pushback
feature can push their UCMDB ID values back to SM. The UCMDB ID field is then used as a flag to
indicate if a CI has already been synchronized to UCMDB through population.

There are also cases when you do not want to enable the UCMDB ID pushback feature. For example,
the scheduled_downtime CI type in UCMDB does not physically exist in SM. Instead, the integration
retrieves Scheduled Downtime information from several entities in SM and then synchronizes the
information to scheduled_downtime CIs in UCMDB. For this reason, the UCMDB ID Pushback feature
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is disabled by default for scheduled_downtime CIs; otherwise a pushback error will occur during
population.

To enable UCMDB ID pushback for a CI type, follow these steps:

1. Add the following entries to your population configuration file for the CI type (for example,My
Business Service Population.xml).

<target_mapping name="sm_id" datatype="STRING" value="bizservice['CIName']"/>

<target_mapping name="global_id" datatype="STRING" value="bizservice
['UCMDBId']"/>

Note: In this example, bizservice is the CI Type display name defined in ServiceManager
and also the external class model name displayed in the UCMDB Visual Mapping interface,
as shown in the following figures.
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2. Save the XML configuration file.

3. Open the smPopConf.xml file, andmake sure that the UCMDB ID Pushback setting for the
CI type is either not present or is set to true:

<pushback>

<type name="business_service" enable="true"/>

</pushback>

Where: <type name> is the name of the CI type in UCMDB.

To disable UCMDB ID Pushback feature for a CI type, follow these steps:

1. Open the smPopConf.xml file.

2. In the <pushback> section, insert one line for the CI type:

<config>
<pushback>

<type name="scheduled_downtime" enable="false"/>
<type name="business_service" enable="false"/>

</pushback>
<mapping>

<tql name="SM Business Service Population 2.0">
...
</tql>
…

</mapping>
</config>
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How to Add an Attribute of a Supported CI

Type for Federation
Out-of-the-box, the integration supports federation for three external CI types in UCMDB: Incident,
Problem, and RequestForChange. For each of the supported CI types, there is a list of attributes in
UCMDB that you canmap to ServiceManager web service objects for federation. The following figure
shows the out-of-the-box UCMDB CI attributes available for the Incident CI type.

For example, to add an SM Incident attribute for federation, you need to expose the field in the SM
UcmdbIncident web service object and thenmap it to an appropriate UCMDB attribute (if one does not
already exist, you need to create it in UCMDB first).

The following figure shows the fields that are exposed in the UcmdbIncidentweb service object in
ServiceManager.
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You can exposemore fields so that more Incident attributes can be federated to UCMDB. As an
example, the following describes how to add the “action” field in the ServiceManager probsummary
(Incident) file for federation, by mapping it to a new UCMDB attribute named details.

Note: On the Incident form in ServiceManager, the “action” field is labeled “Description,” which is
used to describe the incident record in more detail. See the following figure.

To add an attribute of a supported CI type for federation:

1. Add the SM attribute to its web service object.
The following example describes how to expose the SM “action” field of Incident in
UCMDBIncident web service object.

a. Log in to ServiceManager as a system administrator.

b. Navigate to Tailoring >Web Services >Web Service Configuration.
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c. Enter the following field values, and then click Search.
l Service Name: ucmdbIntegration

l Name: probsummary

UCMDBIncident web service object is displayed.

d. On the Fields tab, add the following row:
l Field: action

l Caption: Description

e. Save the web service object.

2. Map the SM attribute to a UCMDB attribute.
The following example describes how tomap the SM “action” attribute to a new UCMDB attribute
named details.

a. Log in to UCMDB as an administrator.

b. Navigate toModeling > CI Type Manager.

c. Navigate to ItProcessRecord > Incident, and open its properties pane.

d. Click theAdd icon to add a new attribute named details to the Incident CI type.

l name: details

l Display Name: Details
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l Description: Incident details

l Attribute Type: select Primitive > String

l Value Size: 500

e. Save the Incident CI type record.

f. Navigate toData Flow Management > Adapter Management >
ServiceManagerEnhancedAdapter9.41 > Configuration Files.

g. Edit the relevant federationmapping file
(ServiceManagerEnhancedAdapter9.41/mappings/federation/SM Incident 2.0.xml) to
add amapping entry for the new attribute.

<target_entities>
<source_instance query-name="SM Incident 2.0" root-element-

name="ucmdbIncident">
<target_entity name="incident">

<target_mapping name="reference_number"
datatype="STRING" value="ucmdbIncident['IncidentID']"/>
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<target_mapping name="name"
datatype="STRING" value="ucmdbIncident['BriefDescription']"/>

<target_mapping name="priority"
datatype="STRING" value="SMFederationFunctions.getEnumValue
(ucmdbIncident['PriorityCode'],'Priority')"/>

<target_mapping name="incident_status"
datatype="STRING"
value="SMFederationFunctions.firstLetterToLowerAndReplaceSpaceWithUnders
core(ucmdbIncident['IMTicketStatus'])"/>

<target_mapping name="category"
datatype="STRING"
value="SMFederationFunctions.replaceSpaceWithUnderscore(ucmdbIncident
['Category'])"/>

<target_mapping name="closed_time"
datatype="DATE" value="SMFederationFunctions.convertDate
(ucmdbIncident['ClosedTime'])"/>

<target_mapping name="create_time"
datatype="DATE" value="SMFederationFunctions.convertDate
(ucmdbIncident['OpenTime'])"/>

<target_mapping name="last_modified_time"
datatype="DATE" value="SMFederationFunctions.convertDate
(ucmdbIncident['UpdatedTime'])"/>

<target_mapping name="impact_scope"
datatype="STRING" value="SMFederationFunctions.getEnumValue
(ucmdbIncident['ImpactScope'],'ImpactScope')"/>

<target_mapping name="urgency"
datatype="STRING" value="SMFederationFunctions.getEnumValue
(ucmdbIncident['Urgency'],'Urgency')"/>

<target_mapping name="details" datatype="STRING"
value="ucmdbIncident['Description']"/>

</target_entity>
</source_instance>

</target_entities>

h. Click Save to save the file.

Now the Description (field name: action) attribute of SM Incident has been added to the integration
for federation. You can run an Incident federation query in the UCMDB Modeling Studio to see if
the SM Description data is properly federated. For information about how to run a federation query,
see "Examples of Using Federation" on page 83.

The following figure shows an example where the Description of an SM incident record has been
federated to UCMDB as Details.
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How to Enable the Automatic Deletion of CI

Relationships from UCMDB
This task explains how to configure an SM-UCMDB integration so that CI relationships that are deleted
from ServiceManager are automatically removed from UCMDB after you next run a population job.
This functionality requires configuration of the ServiceManager Enhanced Adapter in UCMDB, and
also of ServiceManager if you are using ServiceManager 9.60 or an earlier version.

Configure the Service Manager Enhanced

Adapter
Note: Before you begin, we recommend that you back up your existing adapter. To do this, open
the Admin UI, go toAdministrator > Package Manager, right-click
ServiceManagerEnhancedAdapter9-41, and then select Export Package.

1. Stop the SM-UCMDB integration.

2. Turn on the switch that enables CI relationship deletion.
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a. In the Admin UI, go toData Flow Management > Adapter Management, expandService
Manager Enhanced Adapter 9-41, expandConfiguration Files, and then double-click
Service Manager Enhanced Adapter 9-41/sm.properties.

b. Change the value of the pop.only.use.full.pop.switch field to true (Default: false), and then
click Save.

3. Modify theSmPopConf.xml file.

a. Go toData Flow Management > Adapter Management, expandService Manager
Enhanced Adapter 9-41, expandConfiguration Files, and then double-click Service
Manager Enhanced Adapter 9-41/SmPopConf.xml.

b. Set the value of the fullQueryCondition field in every <tql></tql> section to "", with the
exception of the following two sections:

l "SM CLIP Down Time Population 2.0"

l "SM CI Connection Down TimeCI 2.0"

a. Click Save.

4. Restart the integration.
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Configure Service Manager
Important: Perform these steps only if you are using ServiceManager 9.60 or an earlier version.

1. In [[[Undefined variable UCMDB_help.SM_long]]], go to Tailoring >Web Services >Web
Service Configuration, and then search for "ucmdbIntegration" in theService Name field.

2. Select ucmdbBusinessService in theObject Name list.

3. In theExternal Access Definition pane, select the Fields tab, add a new field called "istatus",
set the new field's caption to "AssetStatus", and then click Save.

4. Select ucmdbRunningSoftware in theObject Name list.

5. In theExternal Access Definition pane, select the Fields tab, add a new field called "istatus",
set the new field's caption to "AssetStatus", and then click Save.

Troubleshooting
If CI relationships are not removed from UCMDB after you have configured UCMDB and Service
Manager, run the UCMDBPopulationHelper script check the consistency of the data in the
cirelationship1to1 table against the data in the CI device table.

The script checks the endpoint CIs of the relationship record from the cirelationship1to1 table, and will
remove the relationships if the endpoint CIs were already retired on a set date.

Important: The UCMDBPopulationHelper script is not included in ServiceManager 9.60 or in
earlier versions. If you are running one of these versions, youmust add it manually. to do this,
follow these steps:

1. Open the ServiceManager ScriptLibrary. To do this, type "sl" in the command box, and then
press Enter.

2. In theName field, type "UCMDBPopulationHelper".

3. In thePackage field, select Integrations.

4. Copy the following code into the input field:

function deleteRelation1to1ByDevice(startDate) {
var deviceSql = 'istatus="Retired/Consumed"';
if(startDate) {
deviceSql += ' and sysmodtime >=\''+startDate+'\'';
}
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lib.c.$('device', SCFILE_READONLY).setFields('logical.name').select
(deviceSql).
iterate(function(d){

var logicalName = lib.StringUtil.escapeAllStr(d.logical_name)
var sql = '(upstreamci.logical.name="' + logicalName + '" or

downstreamci.logical.name="'+logicalName+'") and status="In Used"';
lib.c.$('cirelationship1to1').select(sql).iterate(function(item){
item.doDelete();
});
});

}

deleteRelation1to1ByDevice('01/07/10 22:15:37');

Note: Replace the date in the last line of this script with the date for which you are
having issues.

5. Select Add.

To run the UCMDBPopulationHelper script, follow these steps:

1. Open the ServiceManager ScriptLibrary. To do this, type "sl" in the command box, and then press
Enter.

2. Type "UCMDBPopulationHelper" in theName field, and then press Enter.

3. Select Compile, and then select Execute.
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Chapter 7: Troubleshooting
When data push and population errors occur, you can check the error messages and the integration log
files to identify the root causes and fix the errors. This chapter describes the general troubleshooting
steps, as well as typical errors and solutions.

Troubleshooting Data Push Issues 221

Troubleshooting Population Issues 230

Troubleshooting Federation Issues 236

Troubleshooting Data Push Issues
When data push errors or problems occur, you can check the error messages and the log file to figure
out the root causes and then fix the errors.

This integration uses the following error codes for data push.

SM Error Code Description UCMDB Error Code

-1 Server Application Error from SM 900008

-4 401 Authorization error from SM 900001

3 Data Locked Error from SM 900003

9 Restful configuration not found 900009

51 Changed By Another Process Error from SM 900004

70 Invalid Action Error from SM 900005

71 Validation Check Failed error from SM 900002

881 Invalid Data Error from SM 900007

882 Cannot find CI in SM for relationship operation 900010

Failed to createmessage in SM 900013

Communication with SM Failed 900014

Other Error from SM 900099

When a data push job has failed, the job status becomes Failed. Troubleshoot the failed job as follows:
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l Check the error messages of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Push Job" below.

l Check the log file for more details.
See "How to Check the Push Log File" on page 224.

When a data push job was completed with failures of partial records, the job status becomes
Completed. Troubleshoot the failed records as follows:

l Check the error messages of failed CIs in the Universal CMDB studio.
See "How to Check the Error Messages of Failed CIs or Relationships in a Push Job" on page 224.

l Check the log file for more details.
See "How to Check the Push Log File" on page 224.

How to Check the Error Message of a Failed

Push Job
To check the error message of a failed job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration from Integration Point list.

4. Click theData Push tab.

5. Select the job from Integration Jobs.

6. Click the Job Errors sub-tab, and double-click the Severity of amessage from the list.
A popup window displays the detailed error message of this failed job. The following is an excerpt
of a sample error message indicating that nomapping configuration was found for the push TQL
query.

java.lang.RuntimeException: No mapping is found for TQL: "SM Business Service
Push 2.0", or Cannot retrieve the mapping from SM side by QueryNodeName
[bizservice", please configure in smPushConf.xml or SM configuration

at
com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.push.SmGenericPusher.pus
h(SmGenericPusher.java:119)

... 35 more
--- End of probe-side exception ---

at
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com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOpe
ration.convertThrowableToStringSafeException
(AdHocProbeRequestOperation.java:86)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOpe
ration.performAction(AdHocProbeRequestOperation.java:77)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskdispatcher.AdHocTaskDispatc
her.dispatchTask(AdHocTaskDispatcher.java:70)

at sun.reflect.GeneratedMethodAccessor59.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke

(DelegatingMethodAccessorImpl.java:43)
at java.lang.reflect.Method.invoke(Method.java:601)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:111)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:45)
at com.sun.jmx.mbeanserver.MBeanIntrospector.invokeM

(MBeanIntrospector.java:235)
at com.sun.jmx.mbeanserver.PerInterface.invoke(PerInterface.java:138)
at com.sun.jmx.mbeanserver.MBeanSupport.invoke(MBeanSupport.java:252)
at javax.management.StandardMBean.invoke(StandardMBean.java:405)
at com.sun.jmx.interceptor.DefaultMBeanServerInterceptor.invoke

(DefaultMBeanServerInterceptor.java:819)
at com.sun.jmx.mbeanserver.JmxMBeanServer.invoke(JmxMBeanServer.java:792)
at javax.management.MBeanServerInvocationHandler.invoke

(MBeanServerInvocationHandler.java:305)
at org.springframework.jmx.access.MBeanClientInterceptor.doInvoke

(MBeanClientInterceptor.java:405)
at org.springframework.jmx.access.MBeanClientInterceptor.invoke

(MBeanClientInterceptor.java:353)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed

(ReflectiveMethodInvocation.java:172)
at org.springframework.aop.framework.JdkDynamicAopProxy.invoke

(JdkDynamicAopProxy.java:202)
at com.sun.proxy.$Proxy57.dispatchTask(Unknown Source)
at

com.hp.ucmdb.discovery.probe.agents.probegw.managementtasks.adhoctasks.Adhoc
Thread.run(AdhocThread.java:54)

... 3 more
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How to Check the Error Messages of Failed

CIs or Relationships in a Push Job
When a data push job is completed with failures of partial records, in the Universal CMDB studio, you
can check the detail error message for each failed record.

To check the error messages of failed records in a data push job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration from Integration Point list.

4. Click theData Push tab.

5. Select the job from Integration Jobs.

6. Click theQuery Status sub-tab.

7. Double-click a query with failures. The Error Message and CI Count for each failed CI Type are
displayed.

8. Double-click an error message. A list of failed records is displayed.

9. Double-click a failed record.
The detailed error message of the record is displayed.

How to Check the Push Log File
You need to set the Development adapter log level to DEBUG or TRACE, so that you can check the
push result tree nodes of UCMDB, and then sendmessages to and receivemessages from Service
Manager. Alternatively, you can set the log level to TRACE so as to check the conversion period based
on amapping file.

Note: To troubleshoot push, population, and federation issues, you need to set the Development
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adapter log level to DEBUG or TRACE in the fcmdb.properties and fcmdb.push.properties
files, which are located in the \conf\log folder of your Data Flow Probe or Integration Service
installation. Additionally, you can view push, population and federation log information in the
fcmdb.push.all.log file, which is located in the \runtime\log folder of your Data Flow Probe or
Integration Service installation. Your Data Flow Probe or Integration Servicemay be installed on
the same host as your UCMDB Server or on a separate host.

To set the Development adapter log level to DEBUG or TRACE:

1. Log in as an administrator to the host on which your UCMDB Data Flow Probe or Integration
Service is installed.

2. Navigate to the <UCMDB installation folder>\DataFlowProbe\conf\log folder or the <UCMDB
installation folder\UCMDBServer\integrations\conf\log. For example:

C:\UCMDB\DataFlowProbe\conf\log\

Or C:\UCMDB\UCMDBServer\integrations\conf\log

3. Open the fcmdb.properties file in a text editor, and change the log level to DEBUG or TRACE. For
example:

#loglevel can be any of TRACE DEBUG INFO WARN ERROR FATAL
loglevel=DEBUG
def.file.max.size=5000KB
def.files.backup.count=10
msg.layout=%d %-5p [%t] - %m%n

4. Open the fcmdb.push.properties files in a text editor, and change the log4j log level to DEBUG or
TRACE. For example:

### UCMDB log4j Properties
log.file.path=log/${log.folder.path.output}
#loglevel can be any of TRACE DEBUG INFO WARN ERROR FATAL
loglevel=DEBUG
def.file.max.size=5000KB
def.files.backup.count=10
msg.layout=%d %-5p [%t] - %m%n

5. Save the files.

To check the push log file:

1. Log in as an administrator to the host on which your UCMDB Data Flow Probe or Integration
Service is installed.

2. Navigate to the <UCMDB installation folder>\DataFlowProbe\runtime\log folder or the <UCMDB
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installation folder\UCMDBServer\integrations\runtime\log folder.

3. Open the fcmdb.push.all.log file in a text editor.

Typical Push Errors and Solutions
This section describes typical error messages that may occur during data push, as well as their
solutions.

This section includes:

l "Query not Configured in smPushConf.xml" below

l "Mapping File not Well Formed" on page 228

Query not Configured in smPushConf.xml

Sample Configuration

The TQL queries used for pushing relationships must be configured in the smPushConf.xml file.

<config>
<mapping>

<!--
Wildcard is supported for TQL names while you configure the mapping now,
you can add the '*' at the end of the TQL name while configuring the

mapping.
We use the wildcard for mapping in OOTB, so each time you do save as to a

TQL,
you could still push it to SM without manual changing the mapping.
For e.g., if you have saved the <TQL_name> query to <TQL_name>_1, and <TQL_

name>_2,
the TQL name is specified as <TQL_name>* in this configuration file, and

the
integration will automatically use this mapping entry on all of the three

TQLs.
However, using the exact TQL name to configure the mapping is still

supported.
-->

<tql name="SM Business Service Relations Push 2.0"
resourceCollectionName="Relationships" resourceName="Relationship"/>

<tql name="SM CRG Relations Push 2.0"
resourceCollectionName="Relationships" resourceName="Relationship"/>

<tql name="SM Node Relations Push 2.0"
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resourceCollectionName="Relationships" resourceName="Relationship"/>
<tql name="SM Layer2 Topology Relations Push 2.0"

resourceCollectionName="Relationships" resourceName="Relationship"/>
</mapping>

</config>

Error Message

The push job fails with a “Failed” status. From both the log file and the detail error message of the failed
job in the Universal CMDB studio (see "How to Check the Error Message of a Failed Push Job" on
page 222), you receive an error like the following:

java.lang.RuntimeException: No mapping is found for TQL: "SM Business Service Push
2.0", or Cannot retrieve the mapping from SM side by QueryNodeName [bizservice",
please configure in smPushConf.xml or SM configuration

at
com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.push.SmGenericPusher.push
(SmGenericPusher.java:119)

... 35 more
--- End of probe-side exception ---

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOperati
on.convertThrowableToStringSafeException(AdHocProbeRequestOperation.java:86)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOperati
on.performAction(AdHocProbeRequestOperation.java:77)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskdispatcher.AdHocTaskDispatcher.
dispatchTask(AdHocTaskDispatcher.java:70)

at sun.reflect.GeneratedMethodAccessor59.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke

(DelegatingMethodAccessorImpl.java:43)
at java.lang.reflect.Method.invoke(Method.java:601)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:111)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:45)
at com.sun.jmx.mbeanserver.MBeanIntrospector.invokeM

(MBeanIntrospector.java:235)
at com.sun.jmx.mbeanserver.PerInterface.invoke(PerInterface.java:138)
at com.sun.jmx.mbeanserver.MBeanSupport.invoke(MBeanSupport.java:252)
at javax.management.StandardMBean.invoke(StandardMBean.java:405)
at com.sun.jmx.interceptor.DefaultMBeanServerInterceptor.invoke

(DefaultMBeanServerInterceptor.java:819)
at com.sun.jmx.mbeanserver.JmxMBeanServer.invoke(JmxMBeanServer.java:792)
at javax.management.MBeanServerInvocationHandler.invoke

(MBeanServerInvocationHandler.java:305)
at org.springframework.jmx.access.MBeanClientInterceptor.doInvoke
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(MBeanClientInterceptor.java:405)
at org.springframework.jmx.access.MBeanClientInterceptor.invoke

(MBeanClientInterceptor.java:353)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed

(ReflectiveMethodInvocation.java:172)
at org.springframework.aop.framework.JdkDynamicAopProxy.invoke

(JdkDynamicAopProxy.java:202)
at com.sun.proxy.$Proxy57.dispatchTask(Unknown Source)
at

com.hp.ucmdb.discovery.probe.agents.probegw.managementtasks.adhoctasks.AdhocThre
ad.run(AdhocThread.java:54)

... 3 more

Solution

Search for text string No mapping is found for TQL to find the name of the query that is not yet
configured, and then add amapping entry for the query in the smPushConf.xml file.

Mapping File not Well Formed

Sample Configuration

The "target_entity name" should be bizservice (which is the CI type display name defined in Service
Manager, and also the external class model name displayed in the UCMDB Visual Mapping tool
interface); however you have configured a wrong name businessservice.

<?xml version="1.0" encoding="UTF-8"?>
<integration xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="../mappings_schema.xsd">

<info>
<source name="UCMDB" version="10.20" vendor="HP"/>
<target name="SM" version="9.40" vendor="HP"/>

</info>
<import>

<scriptFile path="mappings.scripts.SMPushFunctions"/>
</import>
<!--

Push uCMDB CIT to SM Business Service.
-->
<target_entities>

<source_instance query-name="SM Business Service Push 2.0" root-element-
name="Root" >

<target_entity name="businessservice">
<target_mapping name="UCMDBId" datatype="STRING" value="Root

['global_id']"/>
<target_mapping name="CustomerId" datatype="STRING"
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value="SMPushFunctions.getCustomerId(CustomerInformation)"/>
<target_mapping name="Type" datatype="STRING"

value="'bizservice'"/>
<target_mapping name="Subtype" datatype="STRING"

value="SMPushFunctions.getSMSubType(Root['element_
type'],ClassModel,'BizService')"/>

<target_mapping name="ServiceProvider" datatype="STRING"
value="Root['provider']"/>

<target_mapping name="ServiceName" datatype="STRING" value="Root
['display_label']"/>

<target_mapping name="CIIdentifier" datatype="STRING"
value="Root['display_label']"/>

</target_entity>
</source_instance>

</target_entities>
</integration>

Error Message

The data push job fails with a “Failed” status. From both the log file and the detailed error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed Push
Job" on page 222), you receive an error like the following:

java.lang.RuntimeException: No mapping is found for TQL: "SM Business Service Push
2.0", or Cannot retrieve the mapping from SM side by QueryNodeName
[businessservice", please configure in smPushConf.xml or SM configuration

at
com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.push.SmGenericPusher.push
(SmGenericPusher.java:119)

... 35 more
--- End of probe-side exception ---

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOperati
on.convertThrowableToStringSafeException(AdHocProbeRequestOperation.java:86)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOperati
on.performAction(AdHocProbeRequestOperation.java:77)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskdispatcher.AdHocTaskDispatcher.
dispatchTask(AdHocTaskDispatcher.java:70)

at sun.reflect.GeneratedMethodAccessor59.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke

(DelegatingMethodAccessorImpl.java:43)
at java.lang.reflect.Method.invoke(Method.java:601)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:111)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:45)

ServiceManagerEnhancedAdapter9.41 User Guide
Troubleshooting Data Push Issues

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 229 of 241



at com.sun.jmx.mbeanserver.MBeanIntrospector.invokeM
(MBeanIntrospector.java:235)

at com.sun.jmx.mbeanserver.PerInterface.invoke(PerInterface.java:138)
at com.sun.jmx.mbeanserver.MBeanSupport.invoke(MBeanSupport.java:252)
at javax.management.StandardMBean.invoke(StandardMBean.java:405)
at com.sun.jmx.interceptor.DefaultMBeanServerInterceptor.invoke

(DefaultMBeanServerInterceptor.java:819)
at com.sun.jmx.mbeanserver.JmxMBeanServer.invoke(JmxMBeanServer.java:792)
at javax.management.MBeanServerInvocationHandler.invoke

(MBeanServerInvocationHandler.java:305)
at org.springframework.jmx.access.MBeanClientInterceptor.doInvoke

(MBeanClientInterceptor.java:405)
at org.springframework.jmx.access.MBeanClientInterceptor.invoke

(MBeanClientInterceptor.java:353)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed

(ReflectiveMethodInvocation.java:172)
at org.springframework.aop.framework.JdkDynamicAopProxy.invoke

(JdkDynamicAopProxy.java:202)
at com.sun.proxy.$Proxy57.dispatchTask(Unknown Source)
at

com.hp.ucmdb.discovery.probe.agents.probegw.managementtasks.adhoctasks.AdhocThre
ad.run(AdhocThread.java:54)

... 3 more

Solution

Search for the relevant CI type in ServiceManager to find the correct display name, and thenmodify
themapping file with the correct name.

Tip: You can easily fix such kind of validation issues by using the UCMDB Visual Mapping tool to
generate themapping file.

Troubleshooting Population Issues
When population errors or problems occur, you can check the error messages and the population log
file to identify the root causes and then solve the problems.

When a population job has failed, the job status becomes Failed. Troubleshoot the failed job as
follows:

l Check the error message of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Population Job" on the next page and "Typical
Population Error Messages and Solutions" on page 232.
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l Check the log file for more details.
See "How to Check the Population Log File" below.

How to Check the Error Message of a Failed

Population Job
While a population job fails, you can check the detailed error messages in the Universal CMDB studio.

To check the error message of a failed population job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration.

4. Click thePopulation tab.

5. Select the failed job from Integration Jobs, and click the Job Errors subtab.

6. Double-click an error message from the list.
A pop-up window opens to display the error details.

How to Check the Population Log File
You can set the Development adapter log level to DEBUG so that you can check the population result
tree nodes of UCMDB, and sendmessages to and receivemessages from ServiceManager.
Alternatively, you can set the log level to TRACE so as to check the conversion period based on a
mapping file.

Note: To troubleshoot push, population, and federation issues, you need to set the Development
adapter log level to DEBUG or TRACE in the fcmdb.properties and fcmdb.push.properties
files, which are located in the \conf\log folder of your Data Flow Probe or Integration Service
installation. Additionally, you can view push, population and federation log information in the
fcmdb.push.all.log file, which is located in the \runtime\log folder of your Data Flow Probe or
Integration Service installation. Your Data Flow Probe or Integration Servicemay be installed on
the same host as your UCMDB Server or on a separate host.

To set the Development adapter log level and view the population log file, follow the steps described in
"How to Check the Push Log File" on page 224.
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Typical Population Error Messages and

Solutions
The following describes typical error messages that may occur during population, and their solutions.

This section includes:

l "No TQLQuery Configured in smPopConf.xml " below

l "Nonexistent Mapping File NameDefined for a TQLQuery in smPopConf.xml" on page 235

No TQL Query Configured in smPopConf.xml

Error Message

If you have not yet added a TQL query to your job, you cannot select this query from the list while you
create or update your job.

If you have already added this TQL query to your job, but forgot to add the configuration for this query in
smPopConf.xml, you will get a “Failed” status while you run this population job. In addition, in the
Universal CMDB studio, you will get an error message like the following (see "How to Check the Error
Message of a Failed Population Job" on the previous page).

running population. Destination ID: sm, Failed during query: SM Business
Application Population 2.0, all queries: [SM Business Application Population
2.0, SM Business Service Population 2.0], finished queries: [].
ERROR: com.mercury.topaz.cmdb.shared.base.CmdbException: [ErrorCode [802]
General Integration Error{sm}]
appilog.framework.shared.manage.impl.MamResponseException: [ErrorCode [802]
General Integration Error{sm}]
CMDB Operation Internal Error: class
com.mercury.topaz.cmdb.shared.fcmdb.dataAccess.exception.AdapterAccessGeneralExc
eption : Unsupported Query [SM Business Application Population 2.0], only
population TQL is supported : operation Data Access Adapter Query: Retrieve
Changed Data

at
com.mercury.topaz.cmdb.shared.manage.operation.impl.AbstractCommonOperation.exec
ute(AbstractCommonOperation.java:160)

at
com.hp.ucmdb.dataAccess.manager.DataAccessAdapterManagerProbeImpl.executeOperati
on(DataAccessAdapterManagerProbeImpl.java:50)

at
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com.hp.ucmdb.discovery.probe.agents.probemgr.adapters.DataAccessAdaptersFacade.i
nvokeOperation(DataAccessAdaptersFacade.java:406)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runChangesOnPo
pulateChangesAdapter(AdapterService.java:1262)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runQueriesOnPo
pulateChangesAdapter(AdapterService.java:1102)

at com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runQueries
(AdapterService.java:354)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runDiscovery
(AdapterService.java:198)

at com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.discover
(AdapterService.java:149)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter.launchTask
(JobExecuter.java:1188)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.launch(JobExecuter.java:945)

In the fcmdb.push.all.log file, you can findmore details like the following:

2014-11-20 10:40:50,949 [JobExecuterWorker-0:DS_sm_SM BS pop] ERROR - sm >> Fail to
Create or Return PopulationConnectorOutput
com.hp.ucmdb.federationspi.exception.DataAccessGeneralException: Unsupported
Query [SM Business Application Population 2.0], only population TQL is supported

at com.hp.ucmdb.adapter.smpush.ServiceManagerGenericAdapter.populate
(ServiceManagerGenericAdapter.java:337)

at com.hp.ucmdb.adapters.GenericAdapter.getChanges(GenericAdapter.java:881)
at

com.hp.ucmdb.dataAccess.operations.DataAccessAdapterQueryRetrieveChanges.getChan
gesResult(DataAccessAdapterQueryRetrieveChanges.java:50)

at
com.hp.ucmdb.dataAccess.operations.DataAccessAdapterQueryRetrieveChanges.doDataA
ccessQueryExecute(DataAccessAdapterQueryRetrieveChanges.java:38)

at
com.hp.ucmdb.dataAccess.operations.AbstractDataAccessLifeCycleAdapterQuery.doLif
eCycleExecute(AbstractDataAccessLifeCycleAdapterQuery.java:34)

at
com.hp.ucmdb.dataAccess.operations.AbstractDataAccessLifeCycleAdapterOperation.d
oDataAccessExecute(AbstractDataAccessLifeCycleAdapterOperation.java:57)

at
com.hp.ucmdb.dataAccess.operations.AbstractDataAccessAdapterOperation.dataAccess
Execute(AbstractDataAccessAdapterOperation.java:59)

at
com.hp.ucmdb.dataAccess.operations.AbstractDataAccessAdapterOperation.doExecute
(AbstractDataAccessAdapterOperation.java:37)

at
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com.mercury.topaz.cmdb.shared.manage.operation.impl.AbstractFrameworkOperation.c
ommonExecute(AbstractFrameworkOperation.java:17)

at
com.mercury.topaz.cmdb.shared.manage.operation.impl.AbstractCommonOperation$Oper
ationExecuteFlowTrackingCommand.execute(AbstractCommonOperation.java:87)

at
com.mercury.topaz.cmdb.shared.manage.operation.impl.AbstractCommonOperation$Oper
ationExecuteFlowTrackingCommand.execute(AbstractCommonOperation.java:60)

at com.mercury.topaz.cmdb.shared.manage.flowmanagement.api.FlowManager.execute
(FlowManager.java:227)

at
com.mercury.topaz.cmdb.shared.manage.operation.flow.OperationInFlowDefaultExecut
or.execute(OperationInFlowDefaultExecutor.java:23)

at
com.mercury.topaz.cmdb.shared.manage.operation.impl.AbstractCommonOperation.exec
ute(AbstractCommonOperation.java:158)

at
com.hp.ucmdb.dataAccess.manager.DataAccessAdapterManagerProbeImpl.executeOperati
on(DataAccessAdapterManagerProbeImpl.java:50)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adapters.DataAccessAdaptersFacade.i
nvokeOperation(DataAccessAdaptersFacade.java:406)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runChangesOnPo
pulateChangesAdapter(AdapterService.java:1262)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runQueriesOnPo
pulateChangesAdapter(AdapterService.java:1102)

at com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runQueries
(AdapterService.java:354)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runDiscovery
(AdapterService.java:198)

at com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.discover
(AdapterService.java:149)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter.launchTask
(JobExecuter.java:1188)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.launch(JobExecuter.java:945)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.executeTask(JobExecuter.java:867)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.run(JobExecuter.java:728)

ServiceManagerEnhancedAdapter9.41 User Guide
Troubleshooting Population Issues

Micro Focus Service Manager (Service Manager 9.41 or later; UCMDB CP26 or later) Page 234 of 241



Solution

Search for text string “Unsupported Query by this adapter” to find out the TQL query name that has not
yet been configured, and then configure it in the smPopConf.xml file.

Nonexistent Mapping File Name Defined for a

TQL Query in smPopConf.xml

Error Message

Youwill get a “Failed” status while you run the population job. In addition, from the Universal CMDB
studio, you will get an error message like the following:

running population. Destination ID: sm, Failed during query: SM Business Service
Population 2.0, all queries: [SM Business Application Population 2.0, SM
Business Service Population 2.0], finished queries: [SM Business Application
Population 2.0].
ERROR: com.mercury.topaz.cmdb.shared.base.CmdbException: [ErrorCode [802]
General Integration Error{sm}]
appilog.framework.shared.manage.impl.MamResponseException: [ErrorCode [802]
General Integration Error{sm}]
CMDB Operation Internal Error: class
com.mercury.topaz.cmdb.shared.fcmdb.dataAccess.exception.AdapterAccessGeneralExc
eption : Query Definition [SM Business Service Population 2.0] has no matching
mapping. Make sure the mapping exist exists under folder 'mapping' and contains
the exact query name and root name. Available mappings:
[QueryRoot{queryName='SM Business Application Population 2.0',
rootName='bizservice'}] : operation Data Access Adapter Query: Retrieve Changed
Data

at
com.mercury.topaz.cmdb.shared.manage.operation.impl.AbstractCommonOperation.exec
ute(AbstractCommonOperation.java:160)

at
com.hp.ucmdb.dataAccess.manager.DataAccessAdapterManagerProbeImpl.executeOperati
on(DataAccessAdapterManagerProbeImpl.java:50)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adapters.DataAccessAdaptersFacade.i
nvokeOperation(DataAccessAdaptersFacade.java:406)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runChangesOnPo
pulateChangesAdapter(AdapterService.java:1262)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runQueriesOnPo
pulateChangesAdapter(AdapterService.java:1102)
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at com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runQueries
(AdapterService.java:354)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.runDiscovery
(AdapterService.java:198)

at com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService.discover
(AdapterService.java:149)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter.launchTask
(JobExecuter.java:1188)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.launch(JobExecuter.java:945)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.executeTask(JobExecuter.java:867)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.taskexecuter.JobExecuter$JobExecute
rWorker.run(JobExecuter.java:728)

Solution

Search for text “has nomatchingmapping” to find out the missingmapping file name, and then add the
mapping file to the adapter package.

Troubleshooting Federation Issues
When a federation error occurs, you can check the error message in the federation log file to identify the
root cause and then solve the problem.

For more information, see the following:

"How to Check the Error Message of a Failed Federation Request" below

"Typical Federation Error Messages and Solutions" on the next page

How to Check the Error Message of a Failed

Federation Request
When a federation query fails, a pop-up window similar to the following appears in the UCMDB studio.
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Note: To troubleshoot push, population, and federation issues, you need to set the Development
adapter log level to DEBUG or TRACE in the fcmdb.properties and fcmdb.push.properties
files, which are located in the \conf\log folder of your Data Flow Probe or Integration Service
installation. Additionally, you can view push, population and federation log information in the
fcmdb.push.all.log file, which is located in the \runtime\log folder of your Data Flow Probe or
Integration Service installation. Your Data Flow Probe or Integration Servicemay be installed on
the same host as your UCMDB Server or on a separate host.

To set the Development adapter log level and view the detailed error message of a failed federation
query, follow the steps described in "How to Check the Push Log File" on page 224.

Typical Federation Error Messages and

Solutions
The following error may occur during federation:

"Mapping File for the Federation TQLQuery Is not Well Formed" below

Mapping File for the Federation TQL Query Is not

Well Formed

Error Message

There are cases where themapping file for a federation TQL query is not well formed. For example,
target_mapping_name “priority” in the following example federationmapping file specifies a wrong
Groovy function name (SMFederationFunctions.getEnumValue1):

<?xml version="1.0" encoding="UTF-8"?>
<integration xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
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xsi:noNamespaceSchemaLocation="../mappings_schema.xsd">
<info>

<source name="SM" version="9.40" vendor="HP"/>
<target name="UCMDB" version="10.20" vendor="HP"/>

</info>
<import>

<scriptFile path="mappings.scripts.SMFederationFunctions"/>
</import>
<target_entities>

<source_instance query-name="SM Incident 2.0" root-element-
name="ucmdbIncident">

<target_entity name="incident">
<target_mapping name="reference_number" datatype="STRING"

value="ucmdbIncident['IncidentID']"/>
<target_mapping name="name" datatype="STRING"

value="ucmdbIncident['BriefDescription']"/>
<target_mapping name="priority" datatype="STRING"

value="SMFederationFunctions.getEnumValue1(ucmdbIncident
['PriorityCode'],'Priority')"/>

<target_mapping name="incident_status" datatype="STRING"
value="SMFederationFunctions.firstLetterToLowerAndReplaceSpaceWithUnderscore

(ucmdbIncident['IMTicketStatus'])"/>
<target_mapping name="category" datatype="STRING"

value="SMFederationFunctions.replaceSpaceWithUnderscore(ucmdbIncident
['Category'])"/>

<target_mapping name="closed_time" datatype="DATE"
value="SMFederationFunctions.convertDate(ucmdbIncident['ClosedTime'])"/>

<target_mapping name="create_time" datatype="DATE"
value="SMFederationFunctions.convertDate(ucmdbIncident['OpenTime'])"/>

<target_mapping name="last_modified_time" datatype="DATE"
value="SMFederationFunctions.convertDate(ucmdbIncident['UpdatedTime'])"/>

<target_mapping name="impact_scope" datatype="STRING"
value="SMFederationFunctions.getEnumValue(ucmdbIncident
['ImpactScope'],'ImpactScope')"/>

<target_mapping name="urgency" datatype="STRING"
value="SMFederationFunctions.getEnumValue(ucmdbIncident

['Urgency'],'Urgency')"/>
</target_entity>

</source_instance>
</target_entities>

</integration>

When you try to federate incidents, no records are retrieved from ServiceManager. If you check the
fcmdb.push.all.log file, you can find a detailed error message that resembles the following for the
federation query:

2014-11-20 14:09:58,670 [AdHoc:AD_HOC_TASK_PATTERN_ID-66-1416463796366] ERROR - >>
Failed executing value [SMFederationFunctions.getEnumValue1(ucmdbIncident
['PriorityCode'],'Priority')] of mapping <target_mapping name="priority">
<target_ci_type name="incident"> , Root cmdbId [null]
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groovy.lang.MissingMethodException: No signature of method: static
mappings.scripts.SMFederationFunctions.getEnumValue1() is applicable for
argument types: (java.lang.String, java.lang.String) values: [1, Priority]
Possible solutions: getEnumValue(java.lang.String, java.lang.String)

at groovy.lang.MetaClassImpl.invokeStaticMissingMethod(MetaClassImpl.java:1359)
at groovy.lang.MetaClassImpl.invokeStaticMethod(MetaClassImpl.java:1345)
at org.codehaus.groovy.runtime.callsite.StaticMetaClassSite.call

(StaticMetaClassSite.java:50)
at org.codehaus.groovy.runtime.callsite.CallSiteArray.defaultCall

(CallSiteArray.java:42)
at org.codehaus.groovy.runtime.callsite.AbstractCallSite.call

(AbstractCallSite.java:108)
at org.codehaus.groovy.runtime.callsite.AbstractCallSite.call

(AbstractCallSite.java:120)
at Mapping_4a8761e7adc009e8a7d268c2f1349ab4.run(Mapping_

4a8761e7adc009e8a7d268c2f1349ab4.groovy:1)
at

com.hp.ucmdb.adapters.instance.mapping.AbstractResultTreeNodeMapper.calculatePro
perties(AbstractResultTreeNodeMapper.java:231)

at
com.hp.ucmdb.adapters.instance.mapping.AbstractResultTreeNodeMapper.processTarge
tEntity(AbstractResultTreeNodeMapper.java:301)

at com.hp.ucmdb.adapters.instance.mapping.RtnToRtnMapper.processTargetEntities
(RtnToRtnMapper.java:214)

at
com.hp.ucmdb.adapters.instance.mapping.RtnToRtnMapper.processSourceInstanceWrapp
er(RtnToRtnMapper.java:101)

at com.hp.ucmdb.adapters.instance.mapping.RtnToRtnMapper.buildResultTreeNode
(RtnToRtnMapper.java:76)

at
com.hp.ucmdb.adapters.GenericAdapter$PopulationFederationChunkProcessor.invoke
(GenericAdapter.java:1213)

at com.hp.ucmdb.adapters.GenericAdapter.getDataResult(GenericAdapter.java:743)
at

com.hp.ucmdb.discovery.probe.processor.FederationTopologyGetDataResultProbeReque
stProcessor.processRequest
(FederationTopologyGetDataResultProbeRequestProcessor.java:40)

at
com.hp.ucmdb.discovery.probe.processor.FederationTopologyGetDataResultProbeReque
stProcessor.processRequest
(FederationTopologyGetDataResultProbeRequestProcessor.java:26)

at com.hp.ucmdb.discovery.probe.processor.AbstractProbeProcessor.process
(AbstractProbeProcessor.java:56)

at com.hp.ucmdb.discovery.probe.processor.AbstractProbeProcessor.process
(AbstractProbeProcessor.java:19)

at
com.hp.ucmdb.discovery.probe.agents.probemgr.adhoctasks.AdHocProbeRequestOperati
on.performAction(AdHocProbeRequestOperation.java:63)

at
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com.hp.ucmdb.discovery.probe.agents.probemgr.taskdispatcher.AdHocTaskDispatcher.
dispatchTask(AdHocTaskDispatcher.java:70)

at sun.reflect.GeneratedMethodAccessor75.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke

(DelegatingMethodAccessorImpl.java:43)
at java.lang.reflect.Method.invoke(Method.java:601)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:111)
at com.sun.jmx.mbeanserver.StandardMBeanIntrospector.invokeM2

(StandardMBeanIntrospector.java:45)
at com.sun.jmx.mbeanserver.MBeanIntrospector.invokeM

(MBeanIntrospector.java:235)
at com.sun.jmx.mbeanserver.PerInterface.invoke(PerInterface.java:138)
at com.sun.jmx.mbeanserver.MBeanSupport.invoke(MBeanSupport.java:252)
at javax.management.StandardMBean.invoke(StandardMBean.java:405)
at com.sun.jmx.interceptor.DefaultMBeanServerInterceptor.invoke

(DefaultMBeanServerInterceptor.java:819)
at com.sun.jmx.mbeanserver.JmxMBeanServer.invoke(JmxMBeanServer.java:792)
at javax.management.MBeanServerInvocationHandler.invoke

(MBeanServerInvocationHandler.java:305)
at org.springframework.jmx.access.MBeanClientInterceptor.doInvoke

(MBeanClientInterceptor.java:405)
at org.springframework.jmx.access.MBeanClientInterceptor.invoke

(MBeanClientInterceptor.java:353)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed

(ReflectiveMethodInvocation.java:172)
at org.springframework.aop.framework.JdkDynamicAopProxy.invoke

(JdkDynamicAopProxy.java:202)
at com.sun.proxy.$Proxy51.dispatchTask(Unknown Source)
at

com.hp.ucmdb.discovery.probe.agents.probegw.managementtasks.adhoctasks.AdhocThre
ad.run(AdhocThread.java:54)

at org.eclipse.jetty.util.thread.QueuedThreadPool.runJob
(QueuedThreadPool.java:599)

at org.eclipse.jetty.util.thread.QueuedThreadPool$3.run
(QueuedThreadPool.java:534)

at java.lang.Thread.run(Thread.java:722)

Solution

Search for word "Exception" in the fcmdb.push.all.log file to find the wrongmethod name, and then
correct it in the corresponding federationmapping file.
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on ServiceManagerEnhancedAdapter9.41 User Guide (Service Manager Service
Manager 9.41 or later; UCMDB CP26 or later)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to ovdoc-itsm@microfocus.com.

We appreciate your feedback!
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